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1 Introduction 

1.1 Integris VET Module 

In using Integris VET we believe that you have chosen the most flexible and easy to use package 
in its class.   
 
The VET module is designed to capture a range of student VET information and manage the 
placement of students on work experience and Structured Workplace Learning. 
 
Schools that are Registered Training Organisations (RTOs) can use the VET module to complete 
all their AVETMISS reporting obligations.  
 
This module will support both Windows and Macintosh operating environments. 
 

1.2 Key Features 

The following is a summary of the VET module’s key features.  
 

 It is fully integrated with other Integris modules. 

 There are a number of import utilities that will easily import bulk data.  These include 
qualifications, competencies and ANZSCO Field of Education data and industry codes. 

 Qualifications can be linked to competencies, thus ensuring students are enrolled in recognised 
competencies for a qualification. 

 Schools can easily filter out the large numbers of qualifications and competencies and place on 
offer just those qualifications and competencies offered by the school.  Competencies can be 
grouped together to further facilitate their management. 

 The ‘clone’ function will take any given year’s offerings (qualifications, competencies and 
competency groups) and clone these into a new academic year. 

 There are facilities to enter enrolments, results and placements individually, or in bulk.  

 The module maintains a complete history of a student’s work placement, including actual dates 
of attendance with each employer. 

 Keyword searching is available to facilitate the placement of students with a suitable employer. 

 There is the option to capture staff visits to the workplace with notes for each visit. 

 ‘Find’ tools allow the user to easily locate VET students, employers, competencies and 
qualifications. 

 A wide range of general VET reports that fully complement the system. 

 An external reporting interface that will allow the transfer of VET enrolment and results data 
from schools to the respective reporting bodies such as Department of Education, Employment 
and Workplace Relations, Curriculum Council (WA), Department of Education (WA), 
Department of Education and Training (NT) and SSABSA (SA). 

 Enables schools acting as Training Providers to enrol students from other schools and 
complete their AVETMISS reporting.  Thus, schools that are Training Providers can run the one 
system to track their student activity as well as on behalf of another school or other 
organisation. 

 VET qualifications and units of competency can be maintained by a central body and 
subsequently imported into the VET module for each school. 

 A flexible data export and letter mail merge facility where the user selects the fields required 
and simply presses a button to produce a data source which can be merged with a Word 
document. 
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1.3 Glossary 

Vocational Education and Training has undergone major changes in the past 10 years, and is 
continuing to evolve rapidly.  While certain aspects of VET are controlled nationally by 
organisations such as ANTA and AVETMISS, each state will implement VET in secondary schools 
in slightly different ways, varying the terminology used.  The terminology used in this Manual is 
described in the following glossary. 
 

Competency A unit of study that generally has a result associated with it.  They can be 
grouped together to complete the requirements for a subject or qualification.   

Qualification The packaging of competencies that will lead to accreditation – usually a 
certificate.  A qualification as referred to in this document is sometimes 
referred to as a course by some states and reporting bodies.   

RTO An RTO is a Registered Training Organisation.  The Department of 
Education, Employment and Workplace Relations requires all RTOs to 
report their activity on a regular basis.  The VET module is AVETMISS-
compliant in that it can store all the required data and report as per 
AVETMISS requirements.   

Training 
Provider 

A training provider educational facility that is an RTO.  The VET module has 
a specific window where the school registers as an RTO.  Having done this, 
the school will have access to all the AVETMISS reporting functionality.  A 
school that has an auspice agreement with an RTO is not considered a 
training provider by the VET module, because the AVETMISS reporting 
responsibility in this case will rest with the RTO and not the school.   

VET Student A subset of the school’s students declared by the user to be VET students.  
There is a specific function in the VET module to identify VET students from 
within the general school population.  In other words, the user must 
specifically declare who are the VET students – it is not assumed or derived 
from any data currently stored by Integris. 

Enrolment An association of a VET student with a qualification or a competency.  A 
student can have many qualification enrolments and many competency 
enrolments at the same time.  Each competency enrolment is usually linked 
to a qualification enrolment, this need not be the case, and the VET module 
will allow for a student to be enrolled in a competency that is not part of any 
qualification.  It should be noted that qualification and competency 
enrolments are VET entities and cannot be associated with non-VET 
students. 
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1.4 Hints and Tips 

The following hints and tips apply to use of the Integris software. 
 

1.4.1 Capturing Data from Screen Report 

This feature allows you to capture any area of a screen report and then paste it directly into 
Microsoft Excel. To use it: 
 

 Move the mouse pointer to the top left hand corner of the area you wish to capture. 

 Hold down the left mouse button and move the mouse to the bottom right-hand corner of the 
area you wish to capture and release the mouse button.  The selected area should now have a 
faint line around it.  

 Select Copy from the Edit menu. 

 Open Microsoft Excel and select the first cell in the worksheet (A1). 

 Select Paste from the Edit menu. 
 

1.4.2 Star Search 

This feature works on any list in the product.  It allows you to find a pattern of characters anywhere 
in the list, in any column.  To use it: 
 

 Click into the list you are using; 

 Type <*> followed by the string of characters you wish to find; 

 Use the <+> and <-> keys to search for next and previous occurrences. 
 

1.5 Additional Support 

RM Education offers professional customer support and training. 
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2 Getting Started 

2.1 Installing Integris  

The facilities available in the Administration Manager module are covered in this manual.  Each of 
the other Integris modules has its own manual to which you can refer for further information. 
 

2.2 Logging On and Exiting 

2.2.1 Logging On 

To log onto the system, either: 

 Double-click on the Integris icon on your desktop;  
OR 

 Click on the Windows Start button. 

 Select the Programs option. 

 Select the RM Management Solutions option. 

 Select the Integris option. 
 
Your system administrator will provide you with a user name and password to log onto the 
software.  If you have any difficulties please contact your support centre. 
 

 In the User Name field, enter your user name. 

 In the Password field, enter the password. 

 Click the Login button or press <Enter> on the keyboard.  You will now be able to access 
sections of the software as defined by your system administrator. 
 

2.2.2 Exiting Integris 

File > Exit 

When you have finished processing your data, use the following procedure to exit the system. 

 Click on the File menu in the top left hand corner of the window. 

 Click on the Exit option.  The system displays a message, as shown below 
 

 
 

 Click Yes. 
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2.3 Changing your Password 

File > Password 
You should change your password at regular intervals for security purposes.  To change your 
password: 

 Click on the File menu in the top left-hand corner of the window. 

 Click on the Password option.  The Change Password window is displayed, as shown  below; 
 

 
 

 Enter your current password. 

 <Tab> to the New Password box.  Enter the new password you want to use. 

 <Tab> to the Verification box and enter the same new password. 

 Click OK to accept the new password. 

Note: you are warned if the text you enter in the Verification field is not the same as the New 
Password you entered.  If you see the warning message, click OK and re-enter the new 
password in the New Password and Verification boxes. 

2.4 Changing User 

File > Change User 
If Integris is open and another member of staff wishes to use the software, ensure the second user 
logs on with their name and password.  This ensures any activities they undertake are recorded 
against their user name.  More importantly, it ensures the user only has access to the sections of 
the software to which they have access rights.  The new user should: 
 

 Select File > Change User. 
 

  
 

 Click on Change User. 

 Enter their User Name and Password. 

 Press <Enter> or click Login.  
 
See Section 12 on how to set up user access to the VET module. 
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2.5 VET Sidebar 

The following menu options appear on the VET module sidebar on the right of the screen. 
 

 

 

Students: gives user access to VET student data.  There is the option to open 
with the list of VET students or go straight to the Student Details window by 
setting the Open student/employer window option in System Preferences. 

Delivery Planning: takes you to a sub-window where you can view 
enrolments; set up external training organisations; define qualification and 
competencies offerings; register the school as a Training Provider, set up a 
Submitting Authority and maintain links between qualifications and 
competencies. 

Employers: opens the Employer List or Employer Details window (depending 
on preferences) that will allow you to add, edit and delete employers.  On 
selecting employer(s), you will then be able to view employer details and 
previous placement history. 

Placement: provides access to the Student Placement window where users 
can easily allocate students to prospective employers. 

 

Reports: provides access to the Reports submenu from which you can run 
general VET reports, Curriculum Council reports (WA) AVETMISS reports and 
SSABSA (NT) reports. 

 

Parameters:  information relating to reference data such as Industry areas, 
ANZSCO codes etc. can be maintained. 

 

Utilities: enables you to import ANZSCO Codes, Qualifications and Units of 
Competency, Industry, Field of Education data and Process VET Students 
Active Status. 

 

Control: defines system preferences for the VET module.   
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2.6 Look and Feel 

The following standard “look and feel” features have been incorporated in this module. 
 

 The following toolbar items are standard 
 

  Add (Employer, VET student etc) 
 

 Add (competencies, qualifications etc) 
   

   Edit 
  

   Delete 
 

  Drop-down list of academic years 
 

 Open Details window from a list box (employer, VET student details) 
 

 Print selected item(s) from a list 
 

 Print all items from a list 
 

 Inactive toolbar icons are greyed out. 
 

 List boxes can be sorted by clicking on any column heading within the list box. 
 

2.7 VET Configuration File 

VET Configuration file is read every time Integris starts. It is used to update enrolment cut-off date 
and provides customised error messages. 
 

2.7.1 Properties of VET Configuration File 

Title VET 

Extension ini 

Location ...\Keys\Integris\ 

Tags 
Available 

EnrolmentCutOffDate Contains date in ‘dd mmm yyyy’ format 

ImportQualCompError Simple text to be displayed as error message 

ImportRTOSchoolsError Simple text to be displayed as error message 

~ Begins new line 

<Path> 
Displays export directory path in Preferences 
window 
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2.8 RTO Schools INI File 

The ‘RTO Schools’ file contains list of School Codes which are RTOs. The configuration file will be 
used to set up RTO Arrangement. 
 

2.8.1 Properties of RTO Schools INI File 

Title RTOSchools 

Extension ini 

Location ...\Keys\Integris\VET Imports 

Tags 
Available 

LastUpdated Contains date in ‘dd mmm yyyy’ format 

List of RTO School 
Codes 

List of RTO School codes each separated by a 
comma 

 

 
 
If the ‘LastUpdated’ date is earlier than that the stored ‘LastUpdated’ date, then, the RTO Schools 
file is not read. However, if the ‘LastUpdated’ date is the same or after than the stored 
‘LastUpdated’, then the ‘RTO Schools’ file is read. 
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3 Parameters 

 

VET > Parameters 

 
 
Information relating to reference data such as Industry areas, ANZSCO codes, Employment 
Categories etc may be viewed, and in some instances, maintained from within Parameters.   
 
There are three types of VET parameters: 
 
1. Pre-populated parameters: Parameters that are automatically loaded into the system when it 

is first installed.  They typically include parameters that are the same across all schools (for 
example, a range of AVETMISS reporting parameters). In WA these parameters are controlled 
by DET via Paramanager and as such are unable to be edited by the user. 

2. Imported parameters: These parameters are empty when the system is first installed, but 
there are facilities to import them into the system.  They include parameters that will need to be 
updated on a regular basis (for example, qualifications and competencies) as well as high 
volume parameters (for example, ANZSCO data).  In WA these parameters are unable to be 
modified by the user. 

3. User-definable parameters: these parameters are not pre-populated, and there is no facility 
to import them.  They are entered as required, and will vary from school to school. 
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3.1 Parameters Toolbar  

VET > Parameters 
The screenshot below displays a typical parameter list. 
 

 
 
Most parameters are stored in a standard format with Code, Description, Active status and Locked 
status.  All parameters are locked and set to ‘Active’ by default. A selected parameter can be made 
a default value and that default value will flow through the rest of the VET module. 
 

 Prints the Parameter List 

  Allows the user to add and edit parameters (provided that they are unlocked) 

   Deletes the selected parameter(s) 

  Toggles the active/inactive status of the selected parameter(s) 

  Toggles the locked/unlocked status of selected parameter(s) 

  Makes the selected parameter the default entry 

  Resets Default to n/s 
 
Not all of the parameters in the VET module can be assigned a default value. In these cases the 

corresponding toolbar icons  and are disabled in the parameter window.  The Default entry 

text  does not display in these windows. 
 
The Only show active entries box is ticked by default.  This means that when a parameter window 
is first opened, only parameters with an Active status are displayed in the list. 
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Note: As a general rule, only user-definable parameters may be added, edited, deleted, 
made inactive or unlocked. 

3.1.1 Adding a Parameter 

VET > Parameters 

 Click the Modify parameter descriptions and add parameters.  An edit window will 
open, as shown below. 

 

 
 

 Enter the code and the description for the new parameter. 

 If you wish to enter another new parameter, <Tab> to create a new row. 

 Once all new parameters have been entered, click OK to save. 

 Lock the new parameters (see Section 0 below). 
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3.1.2 Locking and Unlocking Parameters 

VET > Parameters 

To lock a parameter 

 Highlight the parameter(s) you wish to lock, as shown below. 
 

 
 

 Click the Toggle lock status.  
 

 
 

 Click Yes. 
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To unlock a parameter 

 Highlight the parameter(s) you wish to unlock, as shown below. 
 

 
 

 Click the Toggle lock status icon.  
 

 
 

 Click Yes. 
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3.1.3 Editing Parameters 

VET > Parameters 

Unlock the parameters you wish to edit (see Section 0 above). 
Highlight the parameters you wish to edit. 

Click Modify parameter descriptions and add parameters.   An edit window will open, shown 
below. 
 

 
 

 Make the desired changes to the parameter codes and/or descriptions. 

 Click OK. 

 Lock the unlocked parameters (see Section 0 above). 
 

3.1.4 Deleting Parameters 

VET > Parameters 

 Unlock the parameters you wish to delete (see Section 0 above). 

 Highlight the parameters you wish to delete. 

 Click Delete.  
 
If a parameter is in use, a message similar to the one below will be displayed. 
 

 
 

 Click OK to acknowledge the message.  The parameter will not be deleted. 
 
If the parameter is not in use, it will be deleted. 
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3.1.5 Toggling the Active Property of Parameters 

VET > Parameters 

 
To make a parameter inactive: 

 Unlock the parameters you wish to make inactive (see Section 0 above). 

 Highlight the parameters you wish to make inactive.   

 Click Toggle active property.  A message like the one below will be displayed. 
 

 
 

 Click Yes.  The parameter is now inactive. 
 

To make a parameter active: 

 

 Unlock the parameters you wish to make active  (see Section 0 above) 

 Highlight the parameters you wish to make active.   

 Click Toggle active property.   A message like the one below will be displayed. 
 

 
 

 Click Yes.  The parameter is now active. 
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3.2 Pre-populated Parameters  

VET > Parameters 

Some parameters have been pre-populated with data, ready for use in schools.  These are 
required for AVETMISS reporting, and conform to the AVETMISS 6.0 standard (April 2006).   
Pre-populated Parameters include: 

 AVETMISS - Commencing Course Indicator: identifies whether the student is enrolling for the 
first time in a Training Package qualification or course within the training organisation. 

 AVETMISS - Delivery Type: identifies the type or mode of delivery for a unit of competency or 
module enrolment. 

 AVETMISS - Disability Type: identifies the type(s) of disability, impairment or long-term 
condition that a client indicates on the enrolment form.  

 AVETMISS - Funding Source - National: identifies the source of the funding for the delivery of a 
unit of competency or module enrolment. 

 AVETMISS - Funding Source - State Training Authority: identifies the internal funding source 
used to fund delivery of a unit of competency or module enrolment. 

 AVETMISS - Highest School Level Completed: identifies the highest level of school that a 
student has completed.  

 AVETMISS - Labour Force Status: describes a student’s employment status. 

 AVETMISS - Outcome Assessment: identifies the result or outcome of a student’s enrolment in 
a unit of competency or module.   

 AVETMISS - Prior Educational Achievement: identifies the type of prior educational 
achievement successfully completed by a student. 

 AVETMISS - Proficiency in Spoken English: used to assess the English-speaking ability of 
students who speak a language other than English.  

 AVETMISS - Qualification Category: identifies the category of the recognised qualification 
awarded to a student on successful completion of a qualification or course.  

 AVETMISS - RTO Type: identifies the type of training organisation. 

 AVETMISS – Qualification/Course Recognition Identifier distinguishes a qualification or course 
by its level of recognition within the VET sector. 

 AVETMISS - State: identifies the State or Territory of the physical location of a training 
organisation.   

 AVETMISS - Study Reason Identifier: identifies the student’s main reason for study. 
 
For WA only the following parameter lists are also pre-populated.  

 Student Traineeship: distinguishes student qualification enrolments by the traineeship type. 

 Delivery Site Type: identifies the type of organisation delivering a VET course. 

 Trade Training Centre Name: identifies the name of the training institution.   

 Trade Training Centre Site:  identifies the Site that is linked to the Trade Training Centre Name. 

 RTO Arrangement: identifies the arrangement the school has with the delivering RTO. 

 Vocation/Job Type: identifies the vocation a student might be working towards. 
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Note: for WA only all pre-populated parameter lists are locked for editing and controlled by 
the Department via Paramanager. Refer section 0 

 

3.3 RTO Arrangement Functionality 

When Integris opens, it reads the ‘RTO Schools.ini’ file and tries to find whether the school code 
matches any of those in the file.  The ‘RTO Schools.ini’ file is read if the ‘LastUpdated’ date is the 
same or later than the date stored by the system (when the ‘RTO Schools.ini’ file was previously 
read).  If the ‘LastUpdated’ date is earlier than date stored in the system then the ‘RTO Schools.ini’ 
file is not read and system does nothing. 
 
After the ‘RTO Schools.ini’ file is successfully read: 

 If there is a match, then the system will do nothing. 

 If there is no match, then, the system will check if the school is registered as a Training 
Organisation and is active. 

 If the school is an active RTO, then the ‘School as Registered Training Organisation’ parameter 
is marked Inactive and Locked 

 A log file is created containing information about all enrolments for whom the ‘School as 
Registered Training Organisation’ parameter is null. 

 

Note: For details on ‘RTO Schools.ini’ file please see on ‘RTO Schools INI File’ 

 

3.3.1 RTO Fail Log 

The RTO Fail Log contains enrolments of students (from all rolls) with an active VET status having 
their ‘Arrangements’ blank or null. 
 
The RTO Fail Log contains the following information: 
 

Order Field 

1 Student Legal Surname 

2 
Student Legal First 

Name 

3 Student No 

4 CC No. 

5 Competency Code 

6 Competency Name 

7 
Linked Qualification 

Code 

8 
Linked Qualification 

Name 

9 Competency Start Date 

10 Competency End Date 

 
An error message is displayed after the RTO Fail Log is generated: 
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Properties of RTO Fail Log: 
 

Title 

RTOSchoolFailLogxxxxddmmyyyy 

xxxx – School code 

ddmmyyyy – Date log file is generated 

Extension txt 

Location 
Export directory as selected in System 
Preferences 

 
 

Sample RTO Fail Log 
"Armstrong","Matt","257","15260188","AURC251179A","Write routine texts in the workplace and 
complete automotive documentation","AUR20705","Certificate II in Automotive Mechanical","4 FEB 
2008","19 JUN 2009" 
"Armstrong","Matt","257","15260188","AURC270103A","Apply safe working 
practices","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","AURC270789A","Communicate effectively in the 
workplace","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","3 AUG 2009" 
"Armstrong","Matt","257","15260188","AURE218670A","Service, maintain or replace 
batteries","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","3 AUG 2009" 
"Armstrong","Matt","257","15260188","AURE219331A","Install, test and repair low voltage wiring/lighting 
systems","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","AURT200108A","Carry out servicing 
operations","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","AURT201170A","Inspect and service 
engines","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","13 AUG 2009" 
"Armstrong","Matt","257","15260188","AURT202170A","Inspect and service cooling 
systems","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","19 JUN 2009" 
"Armstrong","Matt","257","15260188","AURT206670A","Inspect and service transmissions 
(manual)","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","AURT210170A","Inspect and service braking 
systems","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","AURT212670A","Service final drive 
assemblies","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","24 AUG 2009" 
"Armstrong","Matt","257","15260188","AURT215170A","Inspect and service steering 
systems","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","AURT225667A","Use and maintain measuring 
equipment","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008","16 DEC 2009" 
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Note: for WA only all pre-populated parameter lists are locked for editing and controlled by 
the Department via Paramanager. Refer section 0 

 

3.4 Imported Parameters 

VET > Parameters 

These parameters contain high volumes of data that may change from time to time.  The VET 
module import routines allow this data to be maintained by periodically importing the data into the 
VET module. The user selects the appropriate import function from the Utility sidebar option, and 
then selects the comma delimited file for import. 
 
The parameters that can be imported are: 

 AVETMISS - ANZSCO (Australian and New Zealand Standard Classification of Occupations): 
identifies the type of occupation that may be expected for those undertaking a program of 
study.  This information is used to profile VET delivery at state and national levels.  The 
ANZSCO (occupation type) Identifier is also used to derive the ANTA Level of Training and 
ANTA Training Area codes in State or Territory training profiles.  

 AVETMISS - Field of Education:  identifies what is taught in a unit of competency or module.  

 Industry Codes: the standard ANTA industry codes. 

Note: The three parameter lists above are only imported once unless otherwise directed. 

 Qualifications: the full set of qualifications available to the system.  The school will create a 
subset of this parameter list as the qualification offerings for any given year. 

 Competencies: all competencies available to the system.  Schools will create a subset of 
competencies on offer in any one year. 

 Links between Qualifications and Competencies: The VET module allows the user to link 
Qualifications and Competencies to ensure that students are only enrolled in recognised 
competencies for a qualification.  This feature is optional, and controlled by the ‘Check 
module/UOC exists for the qualification during enrolment’ option in System Preferences. 
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3.5 User-definable Parameters 

VET > Parameters 

The following parameters will be empty after installation and must be entered by the user:  
 

 Employer Correspondence Type 

 Employer Keywords 

 RTO Arrangement (For WA schools this list is pre-populated and locked) 

 Student Correspondence Type 

 Student Traineeship (For WA schools this list is pre-populated and locked) 

 Vocation/Job Type (For WA schools this list is pre-populated and locked) 

 Workplace Category 

 WorkSafe Certification 
 
It’s the responsibility of each school to populate these parameters as applicable to their school 
operation.   
 

Employer/Student Correspondence Type 

These parameters allow the user to classify correspondence according to type, for example 
Employer Placement Start Letter or Student Notification of Placement. 
 

Employer Keywords 

“Keywords” is a criteria option in the Employer Find tool. This parameter represents the possible 
list of keywords that can be assigned to an employer.  The user will choose up to six of the 
keywords from this list and assign them to an employer.  This will then permit the identification of 
the employers based on one or more of the keywords.  For example, if an employer is located next 
to a train station, the word ‘train’ can be entered as an Employer Keyword parameter, and then 
assigned as a keyword to a number of employers.  Conducting a search of employers with the 
keyword ‘train’ would then retrieve all employers located near a train station. 
 

RTO Arrangement 

This parameter is connected to the funding source of the student enrolment. Types of 
arrangements could include ‘Outsourced, ‘Auspiced’ or ‘Training Provider’. (Pre-populated and 
locked for WA only – Refer section 0) 
 

Student Traineeship 

This parameter distinguishes between School Based Traineeship, Aboriginal School Based 
Traineeship, School Based Apprenticeship and Pre-Apprenticeship in Schools. 
 

Vocation/Job Type 

The Vocation/Job Type is a description of the type of work.  Examples include ‘Retail Assistant’, 
‘Automotive Mechanic’, ‘Child Care’ and ‘Office Duties’.  Each employer can be linked to multiple 
job types representing the type of jobs available at that employer for work placement.  Students 
can be assigned up to two preferred job types, and the system will match employers and students 
based on these. 
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Workplace Category 

This parameter is a means of categorising work placements to assist in searching work placement 
types.  For example, an employer might only accept students on work experience.  Entering ‘Work 
Experience’ as Workplace Category, and assigning this category to the employer, will allow for 
easy identification of this employer as one that meets the criteria. 
 

WorkSafe Certificate 

Some work places require all workers to complete a prescribed WorkSafe Certificate before being 
allowed on site.  This parameter allows for the entry of all WorkSafe Certificates that can be 
attributed to students to make sure a student sent to a work place has the appropriate safety 
certification.  

Note: this parameter may not be applicable to all States and Territories. 

 

3.6 Locked VET Parameter Lists (WA only) 

Certain parameter lists are locked for user editing and are administered by the Department of 
Education through Paramanager. Where a parameter list is locked users still have access to the 
parameter window through VET > Parameters, if they have security rights to do so. However they 
will be unable to add to or edit any of the existing parameters. The Modify /Add Parameter and 
Delete icons will be disabled. 
 
An example of a locked parameter list is RTO Arrangement, as displayed below: 
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3.7 Qualification and Competency Parameter Windows 

VET > Parameters > Qualification and VET > Parameters > Competencies 

The Qualifications and Competencies parameter windows are the only non-standard parameter 
windows in the VET module.  Below is a detailed description of the Qualifications parameter 
window.  The Competencies window operates in the same manner although the fields contained 
within the window will be different. 
 

3.7.1 Qualifications 

 
 
At the top of the window is a set of icons: 

 Add a qualification. 

 Edit the selected qualification record. 

 Delete the selected parameter. A qualification can only be deleted if there are no student 
enrolments attached to that qualification. 

 Toggle the locked status for the selected parameter records.  

 Go to the VET offerings window. 

 Print the selected qualification records. 

 Print all the qualification records. 
 
The information shown within this window represents: 
 

 Qualification Code 

 Qualification Description 

 Supervised Hours 

 Vet Flag (Yes or No) 
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 Expiry Date 

 ANZSCO Code 

 Qualification/Course Recognition Identifier 

 Field Of Education Identifier 

 Recognition Status 

 Industry Area 

 Locked Indicator  (Yes or No) 
 

3.7.2 Adding Qualification Parameter Details 

VET > Parameters > Qualifications 

New qualifications can be added by importing them from the Utilities menu (see section 4.4: Import 
Qualification and Competency Data), or by adding them manually (NT only): 
 

To manually add a Qualification parameter (Northern Territory only): 

 Click Add  on the VET - Qualifications parameter window. The window below will be 
displayed. 

 

 
 

 Enter data in the fields.  The code entered in the Code field must be unique (not the same as 
any existing Qualification code).  The Qualification Category, ANZSCO, Field of Education and 
Industry values will only be available if the respective parameters have been entered onto the 
system. 
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3.7.3 Modifying Qualification Parameter Details 

VET > Parameters >Qualifications 

To modify a Qualification parameter’s details: 

 Double click on the Qualifications parameter in the VET – Parameters window; as shown.  
 

 
 

 Click on the parameter record to be edited.  

 Click Edit.   This will open a window where all parameter details can be edited, except the 
code. 

 

 
 

 Click OK to save the details and return to the parameter window.  

 Click Cancel to close the window without saving any changes. 
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3.7.4 Deleting a Qualification 

Note: A qualification can only be deleted if there are no student enrolments attached to that 
qualification and there are no links to competencies. 

VET > Parameters > Qualifications 

To delete a qualification (Northern Territory only): 

 

 Double click on Qualifications in the VET – Parameters window. 
 

 
 

 Click on the qualification to be deleted.  

 Click Delete.    

 Click Close to close the Qualifications window.  
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3.7.5 VET Offerings 

VET > Parameters > Qualifications 

The Qualification parameter window has an additional button  in the toolbar that takes the user 
to the VET Offerings window.  This window enables the user to define the VET offerings 
(qualifications, competencies and competency groups) for an academic year. Please see Section 
6.5 for details on how to use this option. 
 

3.7.6 Printing Qualification Parameters 

VET > Parameters > Qualifications 

Users have the options to print all or some of the qualifications. 
 
To print all the qualifications: 

 Click on Print All.  

 Click Yes. 

 Select a report destination. 

 Click OK. 

 Enter a report header or leave the default header in the 
Report Header window.  

 Click OK. 
 

 

To print selected qualifications 

 Highlight the qualifications to be printed.  Hold down <Ctrl> key and click to select multiple 
records, and/or drag the cursor down a list of records to select them. 

 Click on Print Selected.   

 Click Yes. 

 Select a report destination. 

 Click OK. 

 Enter a report header or leave the default header in the Report Header window. 

 Click OK. 
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3.7.7 Competencies 

VET > Parameters > Competencies 

 
 
The VET - Competencies parameter window operates like the Qualifications window. The major 
difference is that the Competencies window has the Toggle Active Status functionality and the VET 
- Qualifications window does not.   
 

Clicking this icon  will reverse the active status for all selected competencies (that is, active 
competencies will be made inactive, and vice versa).  
 

Add/modify competency parameter details 

This functionality only applies to the Northern Territory and is done the same way as adding or 
modifying Qualification parameters, described in section 3.7.2 and 3.7.3 respectively.  
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4 Utilities 

 

VET > Parameters > Utilities 

The utility functions below are provided by the system: 
 

 
 
All but one of the utilities provides an import function.  Import files must be in either .txt (the 
majority) or .csv format.  Where a field contains a comma, the text must be enclosed in quotes for 
all records and all fields in the file.  
 
The import process will attempt to match the unique code for each record against a record in the 
database.  If there is a match, the existing record will be updated from the import file.  If there is no 
match, the import file record will be added to the database. 
 
Where the import requires just one file, the user is prompted to select that file using a standard 
dialogue box.  You can name the file as desired, but it must contain a ‘keyword’ in the first column 
of the first record to signify the type of data contained in the file.  This keyword is matched to the 
import function, and the import process cancelled if there is no match.  For example, the ANZSCO 
import process will check to make sure the ‘ANZSCO’ keyword appears as the first entry in the file.  
If it doesn’t, the message below will be shown and the import cancelled. 
 

 
 
This ensures that the user does not select the wrong import file, and import inappropriate data (e.g. 
import Industry codes into the ANZSCO parameters area). 
 
Where the import process requires more than one file (as with the import of qualification and 
competency data), you will be asked to select the folder containing the import files.  This folder 
must contain all the required files with a specified name, which don’t need a keyword. 
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4.1 Import AVETMISS - ANZSCO Data 

VET > Parameters > Utilities > Import AVETMISS-ANZSCO Data 

To import ANZSCO data: 

 Double click on the Import AVETMISS - ANZSCO Data menu item in the Utilities window.   
 
The following warning is displayed:  
 

 
 

 Clicking No will cancel the import process. 

 Click Yes to continue.  The ‘Select import file’ dialogue box is displayed, as shown below.   
 

Note: For WA users this will default to the Import Directory Path as indicated in the 
Preferences window. See section 5.9 

If a different location is required, In the Look in field, navigate to the folder in which the file is stored 
and select it. 
 

 
 

 Select the ANZSCO import file.   

 Click the OK button to begin importing data.  Clicking the Cancel button will abort the import 
process and return you to the Utilities window.  

 
The import process begins by checking the keyword in column 1, line 1 of the import file. If it 
contains ‘ANZSCO’, the import will begin. If not, the error message will be displayed and the import 
cancelled. 
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If the keyword validation is successful, a progress bar will be displayed. 
 
The following message will be displayed on completion of the import, and the user returned to the 
Utilities window. 
 

 
 

 Click OK. 
 

ANZSCO data Import Process 

Upon importing AVETMISS – ANZSCO data via ‘VET – Utilities’ window: 

 Pre-existing records are made inactive and locked, and 

 New records are made active and locked. 
 
If a duplicate record is encountered i.e. having both Code and Description same as that in the 
import file, then the pre-existing record version of the record is made active and locked. 
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4.2 Import AVETMISS - Field of Education  

VET > Parameters > Utilities > Import AVETMISS-Field of Education 

To import AVETMISS - Field of Education: 

 Double click on Import AVETMISS – Field of Education in the Utilities window. 

 Click Yes to overwrite existing data. 

Note: For WA users the Select Import File window will default to the Import Directory Path 
as indicated in the Preferences window. See section 5.9 

 If a different location is required, in the Look in field, navigate to the folder in which the file is 
stored and select it. 

 Select the foe.csv file.  

 Click OK. 
 



 
Integris VET Manual.docx  17-Jul-13 

Page 4-6 

© 2013 Civica Pty Ltd 
 

 
 
All other validation and confirmation windows are the same as specified in section 4.1. 
 

AVETMISS – Field of Education data Import Process 

Upon importing AVETMISS – Field of Education data via ‘VET – Utilities’ window: 

 Pre-existing records are made inactive and locked, and 

 New records are made active and locked. 
 
If a duplicate record is encountered i.e. having both Code and Description same as that in the 
import file, then the pre-existing record version of the record is made active and locked. 
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4.3 Import Industry Codes 

VET > Parameters > Utilities > Import Industry Codes 

To import Industry Codes: 

 Double click on Import Industry Codes in the Utilities window. 

 Click Yes to overwrite existing data. 

Note: For WA users the Select Import File window will default to the Import Directory Path 
as indicated in the Preferences window. See section 5.9 

If a different location is required, in the Look in field, navigate to the folder in which the file is stored 
and select it. 
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 Select the file containing industry data. 

 Click OK. 
 
All other validation and confirmation windows are the same as specified in Section 4.1 
 

4.4 Import Qualification and Competency Data 

VET > Parameters > Utilities > Qualification and Competency Data 

This option will import qualification and competency information together with the links between the 
two.  Qualifications, competencies and their links can be imported at the same time or individually.  
However, importing the link data without all the appropriate qualification and competency data will 
result in a large number of errors written to the error log.  
 
Qualification records link to a number of other parameters (for example Qualification Category and 
ANZSCO).  The import takes the value in the import file and attempts to find a matching parameter 
record in the database.  If there is no match found, an error will be written to the log file and the 
qualification data imported without this link. 
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4.4.1 Initiating the Import of Qualifications and Competencies 

VET > Parameters > Utilities > Qualification and Competency Data 

 
The following window will be displayed when the user double clicks the Import Qualification and 
Competency option in the Utilities window: 
 

 
 
The check boxes indicate those items to be imported, and are selected by default.  The Import 
button is only active when one or more of the options are selected. 

Note: the import of qualification to competency links will add links, but never delete them. 

 Click Import  

Note: For WA users this window defaults to the Import Directory Path as indicated in the 
Preferences window. See section 5.9 

 If a different location is required, navigate to the folder in which the file is stored and select it. 

 Click Cancel to stop the import and return to the VET - Qualification & Competency Import 
window.   

 Locate and select the folder containing the import files ‘qualn.csv’, ‘competency.csv’ and 
‘links.csv, shown below.  

 

 
 

 Click the Select button to begin the import.  The processing order is qualifications, then 
competencies, and then the link between the two. 

 
When importing qualifications, the import process looks for the qualn.csv file in the selected folder.  
If the file is found, the import starts and the following progress bar will appear. 
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If the file isn’t found the message below is shown and importing cancelled. The following message 
will appear if the file is not found, and importing will be aborted. 
 

 
 
Following the import of qualifications, the system looks for the competency.csv file in the selected 
folder.  If the file is found, the competency import begins and the following progress bar will appear.  
 

 
 
If the file is not found, an error message will be displayed, and the import aborted.   
 
After the competencies import, the system checks for the links.csv file in the selected folder.  If the 
file is found, the links import begins and the following progress bar will appear. 
 

 
 
If the file is not found, an error message is displayed, and the import cancelled 
If there haven’t been any errors, the message below will display. 
 

 
 
The following message will be displayed at the end of the import process if there were any errors. 
 

 
 

 Click Yes to view the error log.  See section 4.4.2: Error Processing. 
 
Hint: the import of qualifications and competencies depends on a large range of other parameters.  
Without these parameters loaded onto your system, you may get a large number of errors.  Only 
import qualifications and competencies after importing all other parameters. 
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4.4.2 Error Processing 

VET > Parameters > Utilities > Qualification and Competency Data 

All errors detected as part of the import process are written to an error log titled ‘AVETMISS Fail 
Log’. After the AVETMISS Fail Log is saved, an error message is displayed.  
 

 

Note: Error message can be customised via the ‘ImportQualCompError’ tag in VET.ini file 

Properties of AVETMISS Fail Log 

 

Title 

AVETMISSFailLogxxxddmmyyyy 

xxxx – School code 

ddmmyyyy – Date log file is generated 

Extension txt 

Location 
Export directory as selected in System 
Preferences 

 
 

Sample AVETMISS Fail Log 
"Qualification","Invalid ANZSCO","3124-1","UEE22007" 
"Qualification","Invalid ANZSCO","6395-1","WRB20104" 
"Qualification","Invalid ANZSCO","6395-1","WRB20204" 
"Qualification","Invalid ANZSCO","8211-1","WRB20304" 
"Qualification","Invalid ANZSCO","6395-1","WRB30104" 
"Qualification","Invalid ANZSCO","6395-1","WRB40105" 
"Qualification","Invalid ANZSCO","4984-1","WRF20104" 
"Qualification","Invalid ANZSCO","4984-1","WRF30104" 
"Qualification","Invalid ANZSCO","4931-1","WRH30106" 
"Qualification","Invalid ANZSCO","6211","WRR20102" 
"Competencies","Invalid Field of Education",NULL,"10335" 
"Competencies","Invalid Field of Education",NULL,"10336" 
"Competencies","Invalid Field of Education",NULL,"10338" 
"Competencies","Invalid Field of Education",NULL,"10339" 
"Competencies","Invalid Field of Education",NULL,"10340" 
"Competencies","Invalid Field of Education",NULL,"10341" 
"Competencies","Invalid Field of Education",NULL,"10349" 
"Competencies","Invalid Field of Education",NULL,"10357" 
"Competencies","Invalid Field of Education",NULL,"10374" 
"Competencies","Invalid Field of Education",NULL,"Y0314" 
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4.4.3 Import Process for Qualifications  

When Qualification records are imported via VET Utilities, the qualification records under the 
following conditions are marked active: 

 New qualification records imported from CSV file 

 There is a match between pre-existing qualifications records present in the datafile and those 
present in the CSV file 

 Pre-existing qualification records, not matching any in CSV file, to which one or more 
student(s) with an active VET status, from Current, Admissions Former and External Rolls, are 
enrolled. 

 
Qualifications not meeting the above criteria are marked inactive and removed from offer. 
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Qualification Inactive Fail Log 

An error file is generated for pre-existing qualification records to which Student(s) with an active 
VET status, from Current, Admissions, Former and External rolls, are enrolled. It contains the 
following information in the specified order (log sorted alphanumerically by ‘Student Legal 
Surname’, then ‘Student Legal First Name’): 
 

Order Field 

1 Student Legal Surname 

2 Student Legal First Name 

3 Student No 

4 CC No 

5 Qualification Code 

6 Qualification Name 

7 Qualification Start Date 

 

Properties of Qualification Inactive Fail Log 

 

Title 

QualInactiveFailLogxxxxddmmyyyy.txt 

xxxx – School code 

ddmmyyyy – Date log file is generated 

Extension txt 

Location 
Export directory as selected in System 
Preferences 

 
Error message is displayed after Qualification Inactive Fail Log has been generated. 
 

 

Note: Error message can be customised via the ‘ImportQualCompError’ tag in VET.ini file 

Sample Qualification Inactive Fail Log 
"Armstrong","Matt","257","15260188","RTE20503","Certificate II in Crutching","4 FEB 2008" 
"Armstrong","Matt","257","15260188","MEM10105","Certificate I in Engineering","4 FEB 2008" 
"Armstrong","Matt","257","15260188","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008" 
"Armstrong","Matt","257","15260188","RTE20403","Certificate II in Shearing","4 FEB 2008" 
"Armstrong","Matt","257","15260188","RTE20303","Certificate II in Wool Handling","4 FEB 2008" 
"Armstrong","Matt","257","15260188","RTE20103","Certificate II in Agriculture","4 FEB 2008" 
"Berwick","Aaron","298","15136125","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008" 
"Berwick","Aaron","298","15136125","MEM10105","Certificate I in Engineering","4 FEB 2008" 
"Berwick","Aaron","298","15136125","RTE20403","Certificate II in Shearing","4 FEB 2008" 
"Berwick","Aaron","298","15136125","RTE20303","Certificate II in Wool Handling","4 FEB 2008" 
"Berwick","Aaron","298","15136125","RTE20103","Certificate II in Agriculture","4 FEB 2008" 
"Berwick","Aaron","298","15136125","RTE20503","Certificate II in Crutching","4 FEB 2008" 
"Woodcock","Lauren","297","15267619","AUR20705","Certificate II in Automotive Mechanical","4 FEB 2008" 
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4.4.4 Import Process for Competencies 

When Competencies records are imported via VET Utilities, the competency records under the 
following conditions are marked active: 

 New competency records imported from CSV file 

 There is a match between pre-existing competency records present in the datafile and those 
present in the CSV file 

 Pre-existing competency records, not matching any in CSV file, to which one or more 
student(s) with an active VET status, from Current, Admissions Former and External Rolls, are 
enrolled. 

 
Competencies not meeting the above criteria are marked inactive and removed from offer. 
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Unit of Competency Inactive Fail Log 

An error file is generated for pre-existing qualification records to which Student(s) with an active 
VET status, from Current, Admissions, Former and External rolls, are enrolled. It contains the 
following information in the specified order (log file sorted alphanumerically by ‘Student Legal 
Surname’, then ‘Student Legal First Name’): 
 

Order Field 

1 Student Legal Surname 

2 Student Legal First Name 

3 Student No 

4 CC No. 

5 Competency Code 

6 Competency Name 

7 Linked Qualification Code 

8 Linked Qualification Name 

9 Competency Start Date 

10 Competency End Date 

 

Properties of Unit of Competency Inactive Fail Log: 

 

Title 

UoCInactiveFailLogxxxxddmmyyyy 

xxxx – School code 

ddmmyyyy – Date log file is generated 

Extension txt 

Location 
Export directory as selected in System 
Preferences 

 
Error message is displayed after UoC Inactive Fail Log has been generated. 
 

 

Note: Error message can be customised via the ‘ImportQualCompError’ tag in VET.ini file 

  



 
Integris VET Manual.docx  17-Jul-13 

Page 4-18 

© 2013 Civica Pty Ltd 
 

 

Sample Unit of Competency Inactive Fail Log 
"Armstrong","Matt","257","15260188","RTC2704A","Provide basic first aid","RTE20603","Certificate II in 
Production Horticulture","2 FEB 2009","30 JUL 2009" 
"Armstrong","Matt","257","15260188","RTC2301A","Undertake operational maintenance of 
machinery","RTE20103","Certificate II in Agriculture","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","RTE2134A","Assist with feeding in an intensive production 
system","RTE20103","Certificate II in Agriculture","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","RTE2302A","Grind combs and cutters for machine 
shearing","RTE20103","Certificate II in Agriculture","4 FEB 2008","16 DEC 2009" 
"Armstrong","Matt","257","15260188","RTE2117A","Pen sheep","RTE20103","Certificate II in Agriculture","4 
FEB 2008","17 JUL 2009" 

 

4.5 Process VET Students’ Active Status  

VET > Parameters > Utilities > Process VET Students Active Status 

This process updates students’ Active / Inactive status. 
 
The system will check every student record to determine if they have a current enrolment.  If they 
do, a check is made to ensure that their VET status is correctly marked as Active.  If not, the 
system will set it to Active.  If they do not have a current enrolment, then a check will be made to 
ensure that their VET status is correctly marked as Inactive.  If not, the system will set it to 
Inactive. 
 
A student has a current enrolment if they: 

 Have a competency start date year that matches the year of the current system date; or 

 Have a competency enrolment that has no competency end date; or 

 Have a competency enrolment that has an end date greater than or equal to the year of the 
current system date.  

 

To run the utility: 

 Double click on ‘Process VET Students Active Status’ in the VET - Utilities window. 

 Read the prompt. 
 

 
 

 Click Yes to proceed (or No to cancel). 
 
A message is displayed, advising how many students’ records have been updated: 
 

 
 

 Click OK. 
 



 
 
 

  

Control 

5 
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5 Control 

 

VET > Control 

Clicking the Control sidebar icon opens the standard Integris menu window with one option - 
System Preferences, as shown below.  This function enables the System Administrator to change 
the default system preferences for all VET module users.   
 

 
 
The System Preferences are a mechanism for tailoring the system’s functionality to suit a range of 
business requirements.  Below is the VET - Preferences window, with an explanation of each 
preference: 
 

NT users 
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WA users 

  

Note:  The Allow temporary competency enrolments tick box is always disabled for WA 
users only. 

 

5.1 Display VET Students with an Inactive Status 

VET > Control > System Preferences 

This VET system preference will be set to unchecked by default; this option sets every area within 
the VET module to show VET students with an ‘active’ status. 
 

 
 
For example: The above option would set roll filters to display only ‘active’ VET students:  
 

 
 
Ticking the checkbox sets every area within VET to display active and inactive VET students. 
 

 
 
Roll filters would display as follows: 
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5.2 Auto Enrol Students in Competencies Linked to a Qualification 

VET > Control > System Preferences 

The VET module stores the links between a qualification and its competencies.  When enrolling 
students into a qualification, it is possible to ‘auto enrol’ the students into all the ‘linked’ 
competencies for that qualification.  Checking this option enables this functionality.  Not checking 
the option will require the user to individually enrol the student into each competency for the 
qualification. .  It is recommended that this option is not checked and that competency 
groups are used instead. 
 
 
A qualification can have many competencies linked to it, and it is not a requirement for a student to 
complete all competencies linked to a qualification.  Auto enrolling into all the linked competencies 
would be excessive.  This feature simply auto enrols students in the linked competencies as 
specified in Delivery Planning>Qualification to Competency Links Maintenance. 
 
It should also be noted that this preference is a default only.  There is the option within the 
qualification enrolment window to auto enrol linked competencies even when the system 
preference is switched off.  This permits the user to switch the option on and off for each individual 
enrolment, without affecting the system preference setting. 
 
This option has no effect when bulk enrolling multiple students.  
 
 

5.3 Check Module/UOC Exists for the Selected Qualification during 
Enrolment 

VET > Control > System Preferences 

If the “Check Module/UOC Exists for the Selected Qualification during Enrolment” checkbox is 
checked, a warning message will appear if the user elects to enrol a student into a unit of 
competency not linked to the qualification.  In the Northern Territory this is only a warning and the 
user can ignore the message and continue with the enrolment regardless.  In Western Australia it 
is not possible to enrol a student into a unit of competency not linked to the qualification once this 
option is selected. 
 

5.4 Enrolment Cut-off Date Active 

VET > Control > System Preferences 

Enabling the Enrolment cut-off date feature will prevents new enrolments from being entered and 
existing enrolments from being deleted after a specified cut-off date.   
 
In WA, there are two cut-off dates, one for Year 12 students and one for all other years.   
 
In WA, it is not possible for any school user to toggle the Enrolment cut-off date active check 
box. In the Northern Territory only the System Administrator has the permission to toggle the 
Enrolment cut-off date active check box. 
 
The enrolment cut-off date in ‘VET Preferences’ window is updated via the ‘EnrolmentCutoffDate’ 
tag in ‘VET.ini’ file. 
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WA View 

 
 

NT View 

 
 
The VET.ini file is read every time Integris starts. Upon reading the system checks if the ‘Enrolment 
Cut-off Date active’ checkbox is ticked: 

 If un-ticked, then it is ticked cut-off date is updated from VET.ini 

 If ticked, then update ‘Cut-Off Date’ value from VET.ini 
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Note: In WA, the ‘Enrolment cut-off date active’ checkbox and ‘Cut-off Date’ selector is 
enabled if user is logged in via the EDWA account. The ‘Enrolment cut-off date active’ 
checkbox and ‘Cut-off Date’ selector is disabled if user is logged in as any other account 
other than the EDWA account. 

If the system is unable to read a valid value from ‘EnrolmentCutOffDate’ tag, then it will not 
try to update. 

If the “Enrolment cut-off date active” preference is selected then a cut-off date must be specified.  
The date held here is checked during the competency enrolment process and the system will not 
allow a student to enrol in a competency if this date has passed.  This date needs to be changed 
for each academic year. 
 
If the “Enrolment cut-off date active” preference is ticked, the Preferences window displays the Cut-
Off Date icon. 
 

 
 
To enter a date: 

 Click on the Cut-Off Date button.  A calendar pop-up window is displayed. 
 

 
 

 Use the single red arrows to navigate to a different month, or the double red arrows to navigate 
to another year. 

 Click OK.  The selected enrolment cut-off date is displayed in the Preferences window.  
 

 
 
If the “Enrolment cut-off date active” preference is un-ticked, the Preferences window disables the 
Cut-off Date icon but still displays the last saved date. 
 

 
 
The enrolment cut-off date restrictions only apply to enrolments in the cut-off date year or previous 
years.  It does not affect enrolment changes in a future year.  For example, if the cut-off date is Feb 
28, 2005, it will only affect enrolment changes for the year 2005 and previous years. 
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5.5 Allow Concurrent Enrolment in a Competency at Different RTOs 

VET > Control > System Preferences 

A student will normally undertake study in a competency at just one RTO, and the system will 
prevent you from enrolling a student in the same competency across two different RTOs.  
However, there might be cases where a student is legitimately studying with two RTOs for the 
same competency.  Enabling the Allow concurrent enrolment in a competency at different 
RTOs, option will allow enrolment in the second RTO to proceed.  The default is to have this option 
switched off, which prevents accidental enrolment of a student across two RTOs. 
 

5.6 Auto Offer all Linked Competencies for a Qualification 

VET > Control > System Preferences 

Setting up qualification and competency offerings is normally a two-stage process.  Set up all the 
qualification offerings, and then set up all the competency offerings.  However, if competencies are 
linked to a qualification, it is possible to automatically offer all competencies linked to that 
qualification at the time you offer the qualification.  See Section 6.5 for a detailed account on 
defining school VET offerings. 
 
The value specified in system preferences is a default only.  There is the option within the School 
VET Offerings window to override the system preference setting.  The window option will initially 
take on the value of the option in the System Preferences.  If a change is made to the system 
preference in the VET Offerings window it does not change the value in the system preferences.  
 

5.7 Allow Temporary Competency Enrolments (NT only) 

VET > Control > System Preferences 

If a school wishes to offer a unit of competency that is not currently in Parameters>Competencies, 
the school needs to request approval to offer the new competency.  In the interim, if this function is 
enabled, a temporary competency enrolment may be recorded pending approval. 

Note: Allow temporary competency enrolments cannot be enabled in WA. 

  



 
Integris VET Manual.docx  17-Jul-13 

Page 5-8 

© 2013 Civica Pty Ltd 
 

 

5.8 Open Student/Employer Windows in Detail Mode Rather than a List 

VET > Control > System Preferences 

Clicking the Student or Employer button on the sidebar opens the Student and Employer list 
window by default.  A specific student or employer’s details can then be viewed by double clicking 
on a record in the list.  Enabling the ‘Open student/employer windows in detail mode rather than 
list’ will bypass the list window and open the details window instead. 
 
This option affects all users.  It cannot be set on a user-by-user basis. 
 
 

5.9 Import Directory (WA Users only) 

VET > Control > System Preferences 

This field displays the current Import Directory path, which defaults to “k:\keys\integris\vet imports”. 
 
The Import Directly text field and magnifying glass icon are enabled if the currently logged on user 
is “EDWA”. The text field and icon are disabled for all other users.  EDWA users can change the 
Import Directory by editing the path in the text field, or clicking on the magnifying glass icon.  
Moving the mouse over the magnifying glass icon displays the hover text: “Select Folder”. 
 
Upon clicking the magnifying glass icon (if enabled), the system displays the Select Folder window, 
as illustrated below.  The window points to the path specified in the Import Directory field.  The 
user can change the path as required.  
 

 
 

To change the specified path: 

 Click the magnifying glass icon to Select Folder: 

 Choose the required Drive in the lower window and navigate to the required Folder in the upper 
window. 

 Click the Select button. The system saves the folder and updates the Preferences window 
Import Directory field text. 
or 

 Click the Cancel button. The system returns to the Preferences window without having saved 
any changes to the Import Directory field. 

 Upon clicking the Preferences window OK button, the system validates the Import Directory to 
ensure that it exists.  If it does not, the system displays an error message as illustrated below:  
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Note:  The validation is not case sensitive.  

Upon clicking the error message OK button, the system closes the error message box and returns 
the user to the Preferences window. 

Note: The 4 import functions in VET>Utilities (ANZSCO Data, Field of Education, Industry 
Codes and Qualification and Competency Data will default to the import Directory path as 
set in the preferences window. (See section 4 for further detail.) 
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6 Delivery Planning 

 

VET > Delivery Planning 

Delivery planning is the area where the qualification and competency offerings are defined for the 
selected academic year, Registered Training Organisations (RTOs) are defined and enrolments 
monitored. 
 

 Click on the Delivery Planning icon on the sidebar to open the Delivery Planning options 
window: 

NT Users 

 
 

WA Users 
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6.1 Qualification to Competency Links Maintenance (NT only) 

VET > Delivery Planning > Qualification to Competency Links Maintenance 

The links between a Qualification and a Competency can be imported using the Import functions 
within the Utilities area, or they can be maintained using the VET Qualification to Competency 
Links window. 
 

 
 
The window contains two lists: one for Qualifications and the other for the Competencies linked to 
the selected Qualification.  
 

 Click on a Qualification to show all the linked competencies in the bottom list.  The Add 

Competency button  will be enabled.  

 Click on one or more of the Competencies in the lower list to enable the Delete Competency 

button.  
 

Finding Qualifications on Offer 

 Click Find all Qualifications on Offer.   You can now select from the list of Qualifications on 
offer for a particular Year, as shown below.   
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 Enter other search parameters if required. 

 Click Show All Qualifications  to display all Qualifications again. 
 

Filtering Qualifications 

 Click Filter Qualifications  

 Enter part of the code or name of the qualification(s) you wish to view. 
 

 
 

 Click Apply Filter.  Only the qualifications matching the filtering criteria will be displayed. 

 Click Show All Qualifications  to display all Qualifications again. 
 

Adding a Competency to a Qualification 

 Click on the target Qualification. 

 Click Add Competency.  This opens the Competency Find window where you can select 
from the list of Competencies on offer in a particular year.  
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 Use the available fields to set criteria for the search, as shown above. 

 Click Find.   
 
The Competencies selected in the Find tool will be added to the list of competencies for the 
selected Qualification. 
 

Deleting a Competency from a Qualification 

 Highlight one or more competencies in the list, as shown below. 
 

 
 

 Click Delete Competency.    
 
This will delete the selected competencies for the qualification. 
 
 

6.2 Register School as a Training Provider 

VET > Delivery Planning > Register the School as a Training Provider 

Schools that are Registered Training Organisations (RTOs) must register their RTO details on the 
system.  This is done by selecting the ‘Register School as a Training Provider’ option listed in the 
Delivery Planning window.  The information entered in the registration process is used for 
AVETMISS reporting purposes.  AVETMISS reports can only be produced if the school has 
registered as a training provider. 
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6.2.1 Register School as a Training Provider Toolbar 

The following buttons are available on the toolbar: 
 

 Register the school as a training provider. There can be only one Training Provider defined 
within the system. 

 Edit school details. 

 De-register the school as a Training Provider. 

 Print details for the training provider, including location information. 
 
The process of adding locations to the Training Provider works in a similar manner to that specified 
when defining external Registered Training Organisations (RTOs).   
 

 Click Edit    
 

 
 
The background colour of each field changes from grey to white to indicate the field can be edited.  
The Add and Delete buttons are now active, allowing you to enter Location information. 
 

6.2.2 Functionality available to EDWA and non-EDWA accounts (WA only) 

In ‘VET – Register School as a Training Organisation’, the following section has been disabled for 
all user accounts other than ‘EDWA’ account: 

 ‘Locations’ section 

 ‘ID’ column 

 ‘Location’ Name’ 

 ‘Suburb’ column 

 ‘Postcode’ column 

 ‘State’ column 

 ‘Statistical Area’ column 

 ‘Add Location’ button 

 ‘Edit Location’ button 

 ‘Delete Location’ button 
 



 
Integris VET Manual.docx  17-Jul-13 

Page 6-7 

© 2013 Civica Pty Ltd 
 

As a result, when the user is logged in via an account other than EDWA, they will not be asked to 
add a new RTO Location when external RTOs are being added or when the school is being 
registered as an RTO. 
 
 

6.2.3 To register a school as an RTO 

VET > Delivery Planning > Register School as a Training Provider 

 Double click the Register School as a Training Provider option in the Delivery Planning menu, 
to bring up the window below. 

 

 
 

 Click the Register button  at the top left of the window.   
 
The window opens in edit mode so that the user can enter the school’s registration details.  A 
school can only register once but, in the Northern Territory only, can record multiple locations 
against that registration.  The address details default to the school’s address, but can be changed. 
 

 Enter the registration details, as shown below. 
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Note:  Location details are not required in WA. 

 Click OK.  
 
In the Northern Territory only: 
 

 Click Yes when prompted to enter location details. 

 Enter Location details, in the window below  
 

 
 

 Click OK to save the location details and return to the register window. 

 Click OK to save the registration. 

 Click Close. 
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6.2.4 Adding a Location (Only for EDWA or the Northern Territory) 

VET > Delivery Planning > Register the School as a Training Provider 

Click Add  to the right of the location pane.   
 

 
 

 After entering the appropriate details, click OK to save the location changes.   
 

6.2.5 Editing a Location (Only for EDWA or the Northern Territory) 

VET > Delivery Planning > Register the School as a Training Provider 

 Select the location you wish to edit. 

 Click Edit  to the right of the location pane 

 Make your changes. 

 Click OK to save the modified data or click Cancel to discard any changes made.   
 
You will be returned to the VET Training Provider window. 
 

6.2.6 Deleting a Location (Only for EDWA or the Northern Territory) 

VET > Delivery Planning > Register the School as a Training Provider 

 Select the location to be deleted and click Delete.  

 Click Yes to confirm the deletion, or No to cancel. 

Note: a location cannot be removed if a student has been enrolled in a competency at that 
location. 
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6.3 Set up External RTOs 

VET > Delivery Planning > Set up External RTOs 

An external RTO is any external organisation with RTO status that delivers VET training to the 
school’s students or audits the schools training in an auspice arrangement.  An external training 
organisation can be an independent commercial body, a TAFE college or another school.   
 
The VET External RTO window is accessed from the Setup External RTOs menu item in the 
Delivery Planning window. 
 

 

Note: schools that are Registered Training Organisations must not enter their RTO details 
in this window.  They must register their RTO status by selecting the ‘Register as a Training 
Provider’ option in the Delivery Planning menu.  If they don’t, they won’t be able to produce 
AVETMISS statistics. 
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6.3.1 Set up External RTOs Toolbar 

VET > Delivery Planning > Set up External RTOs 

    
 
The toolbar contains a dropdown list of all external RTOs.  Selecting an RTO in the list will 
populate the window with the selected RTO’s details.  The dropdown list displays all existing 
training organisations sorted by organisation code within status.  That is, at the top of the list are all 
the active organisations sorted by name, and at the bottom of the list are all the inactive 
organisations sorted by name. The inactive organisations have their name prefixed with an asterisk 
(*). 
 

 Add a new RTO 

 Edit the displayed RTO 

 Delete the displayed RTO 

 Prints the details for the displayed RTO, including location information 
 
 

6.3.2 Training Organisation Details 

VET > Delivery Planning > Set up External RTOs 

The Setup External RTO window displays the training organisation details together with the 
locations for each RTO. 

Note:  Location details are not required in WA. 

There is the facility to mark the RTO as active/inactive.  Inactive RTOs are not available for 
selection when enrolling students into competencies. 
 

6.3.3 Functionality available for EDWA and non-EDWA users (WA only) 

 In ‘VET – Register School as a Training Organisation’, the following section has been disabled 
all user accounts other than ‘EDWA’ account: 

 ‘Locations’ section 

 ‘ID’ column 

 ‘Location’ Name’ 

 ‘Suburb’ column 

 ‘Postcode’ column 

 ‘State’ column 

 ‘Statistical Area’ column 

 ‘Add Location’ button 

 ‘Edit Location’ button 

 ‘Delete Location’ button 
 
As a result, when the user is logged in via an account other than EDWA, they will not be asked to 
add a new RTO Location when external RTOs are being added or when the school is being 
registered as an RTO. 
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6.3.4 Adding a new RTO 

VET > Delivery Planning > Set up External RTOs 

 Click the Add button in the toolbar.  This will enable data entry to the fields in the Registered 
Training Organisation details area, and grey out the locations menu.   

 

 
 
Complete the data entry to this portion of the window, as shown below. By default, the RTO is 
marked as ‘Active’. 
 

 
 

 Click the OK button to save the data.   
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In the Northern Territory only: 

 Click Yes when prompted to enter location details. 

 Enter location details, as shown below.  
 

 
 

 Click OK.  
 
Having saved the RTO details, the location list and buttons will be activated.   
 

 Add a new location.  

 Edit an existing location. Highlight the location first. 

 Delete an existing location. Highlight the location first. 
 
See Section 6.2.4 for further information on Locations. 
 

 Click OK to save the External RTO details and location information. 
 

6.3.5 Marking an RTO as Inactive 

VET > Delivery Planning > Set up External RTOs 

An RTO cannot be deleted if it has student competency enrolments attached to it, but it can be 
made inactive.  Inactive RTOs cannot have any new competency enrolments attached to them.  
 
 

 Select the RTO from the drop-down list at the top left of the Setup External RTOs window. 

 Click Edit.  

 Remove the Active tick by clicking on it.  

 Click OK. 
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6.3.6 Deleting an external RTO 

VET > Delivery Planning > Set up External RTOs 

An external RTO can only be deleted if there are no student competency enrolments linked to it or 
any of its location for that RTO.   
 

To delete an RTO 

Select the RTO from the drop-down list at the top left of the Setup External RTOs window. 

 Click Delete.   

 Click Yes to the prompt. 
 

 
 
The RTO will be deleted from the system and the window will display a different RTO record. 
 

6.3.7 Locations (For EDWA or the Northern Territory only) 

VET > Delivery Planning > Set up External RTOs 

The locations area of the window is enabled when there is an RTO displayed in the window, and 
the user is editing the organisation’s details.   
 

To add a new location: 

The Add/Edit Location dialogue window displays the current organisation code and organisation 
name.  These fields cannot be edited within this window.  All fields except the statistical local area 
are mandatory. 

 Click Add  alongside the location list.   

 Enter the required information 
 

 
 

 Click OK or Cancel as appropriate 
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To edit locations: 

 Click Edit  alongside the Location pane.   

 Make the required changes 

 Click OK or Cancel as appropriate 
 

To delete locations:  

 Highlight the location and click Delete  alongside the Location pane.   
 
Only one location can be deleted at a time, and it can only be deleted if there are no student 
competency enrolments linked to it 
 
 

6.4 Set Up Submitting Authority 

VET > Delivery Planning > Set up Submitting Authority 

This information is used to identify an organisation that the State Training Authority has arranged 
to act as an internal collection agency. 
 
Examples are:  

 Schools that report data for contracted RTOs to the Curriculum Council.  

 The Curriculum Council reporting on behalf of all schools.  

 Aboriginal Services Bureau reporting on behalf of Aboriginal Community RTOs  

 The Department’s Training Group, reporting on behalf of Private Providers delivering tendered 
training. 

 

6.4.1 Set Up a Submitting Authority Toolbar 

VET > Delivery Planning > Set up Submitting Authority 

The following buttons are available on the toolbar: 
 

 Register the school as a Submitting Authority. 

 Edit school details. 

 De-register the school as a Submitting Authority. 

 Print the details for the submitting authority, including location information. 
 

 Clicking on the Register button  will open the following screen. 
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 Enter the code provided to your school.  If the school is not an RTO, this will be the school 
code. 

 
 

6.5 School VET Offerings 

VET > Delivery Planning > School VET Offerings 

There are thousands of VET qualifications and competencies.  A school typically offers a small 
subset of these.  Each year they select the qualifications and competencies they offer to students, 
and ignore the rest.  The VET module presents all the qualifications and competencies on the 
system, and asks the user to select which of these are on offer in any specific year. 
 

NT users 

  
 

WA users 
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 Double click on School VET Offerings in the Delivery Planning window.  The Offerings window 
provides the facility to select those qualifications and competencies on offer for a specific 
school year.  The following example outlines how to define Qualifications on offer.  The same 
mechanism applies to defining competencies on offer. 

 
 

6.5.1 School VET Offerings Toolbar 

VET > Delivery Planning > School VET Offerings 

 The current school year 

 Edit offerings. 

 Clone offerings 

Note: The Clone Offerings button has been disabled for WA users only.  

 View a list of qualifications and qualification offerings. 

 View a list of competencies and competency offerings. 

 Maintain the list of competency groups for an academic year. 

 Match previously created temporary competencies to competencies available on the 
system 

Note: The Match temporary competencies button has been disabled for WA users only.  

 

 Print the selected items to a standard report. 

 Print all the records in the list to a standard report. 
 

6.5.2 Qualification Offerings 

VET > Delivery Planning > School VET Offerings > Qualification Offerings 

The window defaults to the current school year and displays two lists: 

 Qualifications NOT offered, which contains all qualifications in the Qualifications parameter 
window. 

 Qualifications ON offer, which will initially be empty. 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 6-18 

© 2013 Civica Pty Ltd 
 

 

WA Display 

 
 

NT Display 

 
 

To Offer Qualifications: 

 Click Edit   

 Select one or more qualifications in the left hand list and click Move Right.   
 
The qualification will be removed from the Qualifications NOT offered list and will appear in the 
Qualifications ON Offer list.  

Note: only Qualifications on the Qualification ON Offer list can have student enrolments 
attached.  
  Qualifications must be offered for each calendar year. 

 The qualification can be moved back to the ‘Qualifications NOT Offered’ list by highlighting it 

and clicking Move Left.   
 

 Click OK to save changes. 
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Note: if the ‘Auto offer Competencies linked to Qualifications’ option is switched on in 
System Preferences, clicking OK will save the qualification offerings and automatically offer 
all competencies linked to the qualifications on offer.  

Linked Competencies 

In the Qualification Offerings window, it is possible to quickly see the competencies which are 
linked to a selected qualification. 
 
In either the Qualifications NOT offered list, or the Qualifications ON offer list, double click on the 
required qualification.  The VET – Linked Competencies window will be displayed: 
 

WA Users 

 

Note: For WA users, the linked competencies can be viewed only.  Both the Add 
Competency and Delete Competency buttons on the VET – Linked Competencies window 
are always disabled.  
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NT Users 

 
 

6.5.3 Competency Offerings 

VET > Delivery Planning > School VET Offerings > Competency Offerings 

 Click the Competencies button  in the toolbar to switch to the competencies view, shown 
below:  

 

WA Display 
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NT Display 

 
 
The operation of this view is identical to that for the Qualifications view.  All columns in every list 
can be resized and you can scroll left and right across the list to see additional fields. Click on any 
column heading to sort. 

Note: Only competencies on the ‘Competencies ON Offer’ list can have student enrolments 
attached. 

 

6.5.4 Printing Competencies/Qualifications on Offer 

VET > Delivery Planning > School VET Offerings 

 Highlight the competencies/qualifications on offer on the right side of the School Offerings 
window. 

 Click on the Print Selected  or Print All  icon on the toolbar. 

 Select the report destination, e.g. Screen or Printer and click OK. 

 Enter the required Report Header or use the default header, as shown below. 
 

 
 

 Click OK.  
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6.5.5 Adding Temporary Units of Competency (NT only) 

VET > Delivery Planning > School VET Offerings > Competencies 

There may be instances when a school wishes to offer a unit of competency that is not currently on 
the master competency file.  While approval to offer this competency is being sought, a temporary 
competency offering may be entered if this option has been selected in Control>System 
Preferences. See the screenshot below. 
 

NT users 

 
 

Note:  The Allow temporary competency enrolments tick box is always disabled for WA 
users only. 

Temporary units of competency may be added to VET School Offerings when enrolling a single 
student in a temporary unit of competency or when enrolling a group of students in a temporary 
unit of competency in Bulk Enrolment. 
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To add a temporary unit of competency 

 Open Delivery Planning on the VET sidebar 

 Select VET School Offerings 

 Click on Competencies  

 Click Edit  

 Click Add Temporary Competency  

 Enter a code and a name for the temporary competency in the window, as shown in the 
example below. 

 

 
 

 Click OK.  The temporary competency will now appear in the Competencies on Offer list. 
 

 
 
 

6.5.6 Updating a Temporary Competency 

VET > Delivery Planning > School VET Offerings > Match Temporary Codes 

Once a new Master Competency file has been imported the temporary competency can be 
updated. 
 

 Choose Delivery Planning from the VET sidebar. 

 Double click on School VET Offerings. 

 Click on Match Temporary Codes . 

 Click Filter . 

 Enter part of the code or name for the competency you wish to match to your temporary 
competency, as shown below. 

 

 
 

 Click Apply Filter 

 Highlight the temporary competency you wish to update and the competency you wish to 
match it to. 
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 Click Match Competencies  

 Click Yes and OK when prompted.   
 
The temporary unit of competency will then be replaced by the accredited competency. 
 

6.5.7 Competency Groups 

VET > Delivery Planning > School VET Offerings > Competency Groups 

The School VET Offerings window also allows for the creation of competency groups. 

Switch to the Competency Groups view by selecting the Competency Groups icon.   
 

WA Display 

 
 

NT Display 
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Note: if competencies have not been set up for the selected year, the following warning is 
displayed: 

 

 
 
If this occurs, return to School VET Offerings > Competencies and set up competencies on offer. 
 
A competency group is linked to an academic year, and can contain any number of competencies 
from the list of competencies on offer for that year.  
 
A new competency group is defined by first adding a competency group name to the competency 
group list, and then adding competencies to the newly created group.  
 

To add a new competency group: 

VET > Delivery Planning > School VET Offerings > Competency Groups 

 Click on Competency Groups.  

 Click Add  alongside the Competency Group list on the left.  This opens the VET - Add/Edit 
Group dialogue box: 

 

 
 

 Click on the Qualification Find button   

Note: For NT users the facility to attach qualifications to competency groups is also 
available, however this is an optional feature. 

The VET - Qualification Find window will be displayed: 
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 Enter search criteria in the Qualification Find window and click Find  
OR  

 Click on Find and all Qualifications on Offer for the year will be displayed. 
 

 
 

 Select the Qualification required and click Select. 

 Enter a description for the group, as shown below.  
 

 
 

 Click OK to return to the Delivery Planning window.   
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The new group will now appear in the Competency Group list. 

 Use Edit  or Delete  to rename or delete a selected competency group. 
 
 

To add competencies to a group: 

VET > Delivery Planning > School VET Offerings > Competency Groups 

Select a competency group in the list and click the Add Competencies  button on the far right 
of the window.  The VET - Competency Find window will open. 
 

 
 

 Enter the search criteria.  

Note: If a qualification has been attached to the selected competency group, the 
Qualification field will be automatically populated with the qualification, and the 
Qualification Find button will be disabled.  Only competencies linked to that qualification 
can be added.  

 Click Find.   
 
A list of items matching the criteria is displayed.  
 

 Highlight the required items. 

 Click Select.  
 
The list of selected competencies is added to the Delivery Planning Competencies window.  Any 
duplicate entries are automatically removed.  Increase the list of competencies in a group as 
required by repeatedly using Add Competency function. 
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To remove competencies from a group: 

 

VET > Delivery Planning > School VET Offerings > Competency Groups 

 Select the units of competency you wish to remove (hold down the <Ctrl> key to select more 
than one item in the list). 

 Click Delete Competency.    
 

 
 

 Click Yes to delete the competencies, or click No if you do not wish to continue. 
 

To delete a Competency Group 

 

VET > Delivery Planning > School VET Offerings > Competency Groups 

 Select the target group. 

 Click Delete Group.    

 Confirm or cancel the deletion.  

Note: Competency Groups can only contain competencies that are on offer.  Consequently, 
removing a competency offering that is linked to a group will remove that offering from the 
group. 
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6.5.8 Clone Offerings (NT only) 

VET > Delivery Planning > School VET Offerings > Clone Offerings 

The VET module enables schools to create their qualification offerings, competency offerings and 
competency groups for one year, and then clone those offerings and groups in a subsequent year. 

Note: For DET WA users the Clone Offerings has been disabled as shown below: 

Select the clone ‘To’ year from the year dropdown list.  The ‘To’ year is the school year that you 
wish to clone offerings to. 

 Click Clone Offerings  on the toolbar in the School Offerings window. The following 
window is displayed: 

 

 
 
The window will have the ‘Into’ year set to the Year selected in the previous window. 
 

 Select the Clone From year from the drop-down list. 

 Check the items you wish to clone - Qualifications, Competencies and Competency Groups.   

 Click OK. 

 Click Yes to continue or No to abort the cloning. 
 

 
 
Items already existing in the current year will be ignored.  For example, if a qualification offering 
already exists, this qualification will be ignored and no error message produced.  When cloning 
competency groups, any competencies within a group that are not offered will be ignored.  It is 
therefore important that you have a complete list of Competency offerings before cloning 
competency groups. 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 6-30 

© 2013 Civica Pty Ltd 
 

 

6.6 School VET Enrolments 

VET > Delivery Planning > School VET Enrolments 

The enrolments window displays qualification and competency enrolments for all offerings in a 
particular school year.  The window will initially display the qualification enrolments, but can be 

switched to show competency enrolments by clicking Competencies  in the toolbar.   
 

 
 

6.6.1 School VET Enrolments Toolbar 

VET > Delivery Planning > School VET Enrolments 

 The current school year 

 View a list of qualifications and the number of enrolments in each qualification. 

 View a list of competencies and the number of enrolments in each competency. 

 Print the selected items to a standard report. 

 Print all the records in the list to a standard report. 
 
Clicking a list column header will sort the list by that column.  Clicking the same column header a 
second time will sort the list by that column in descending order. 
 
The window provides the facility in both the qualification and competencies views to show all 
qualifications/competencies on offer, or to show just those qualifications/competencies with 
enrolments.  This is done by selecting one of the following ‘Show’ options: 
 

 
 
Selecting a school year from the drop-down list will display the enrolments for that year, taking into 
account any filtering options set. 
 
The Enrolment count displayed within the list is a count of the enrolments for that qualification or 
competency within the currently selected academic year. 
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Double clicking a qualification or competency entry in the list opens a Student window displaying 
all the students enrolled in that qualification or competency. 
 

 
 

This window has Print Selected  and Print All  icons.   
 
Double clicking a student in the list will open the VET Student Details window where the student 
information can be edited. 
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7 Student Management  

 

VET > Students 

7.1 VET Student List 

This window defines those students to be regarded as VET students and provides the following 
functionality: 

 Identify which students are your VET students.   
 
There are two classes of VET student – “Enrolling” and “Non-Enrolling”.  “Enrolling” VET students 
can be enrolled in qualifications and competencies, and put on work placement.  “Non-Enrolling” 
students can be put on work experience, but cannot be enrolled in qualifications or competencies. 
 

 Enrol student(s) in a particular qualification/certificate or module/unit of competency. 

 Bulk enrolment of selected students into selected competencies. 

 Bulk entry of student results and other enrolment details. 

 View work placement history for each student. 

 View details of module/unit of competencies such as mode of delivery, the designated RTO, 
the location and the result. 

 
Clicking the Students icon on the VET sidebar opens the VET Student List window.  The window 
displays VET students on the current roll.  VET students on the Former, Admissions and External 
rolls can be viewed by selecting the appropriate roll status from the drop-down list at the top left of 
the toolbar.  
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The roll filter field, by default, displays only active VET students on the Current, Admissions, 
Former and External rolls, as shown in the following example. 
 

 
 
This setting can be changed, in VET > Control >System Preferences, to also display inactive 
VET students on selected rolls. The roll filter would change to indicate that active and inactive VET 
students will be displayed: 
 

 
 
The VET student information provided in the VET – Student List window includes 

 Surname 

 First Name 

 Year – the year/grade (e.g. 8, 9, 10, 11, 12) 

 Form – the form group, sometimes referred to as the class group or home group 

 Active – whether the student is an active VET student.  This is used to identify students on the 
Current, Admissions, Former and External rolls who have current enrolment.   

 Enrolling - whether the student is an Enrolling student (YES) or Non-enrolling student (NO).  
Enrolling students can be enrolled into qualifications and competencies, and put on work 
placement.  Non-enrolling students can be put on work placement, but cannot be enrolled into 
qualifications or competencies.  This classification only has effect at the time you attempt to 
enrol the student into a qualification or competency, and can be changed later. 

 School – used to identify whether a student has come from another school (RTO arrangement).  
Students originating from the local school will have the local school code appearing here.  
Students from other schools will have that school’s code, or the generic ‘Other’ code to signify 
they have come from any other school. 

 FTE (Full Time Equivalence) 

 No of Competencies - represents the total number of competencies in which a particular 
student has been enrolled. 
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7.1.1 VET Student List Toolbar 

VE > Students 

 

 Indicates that we are looking at the current role.  The user 
can select from the dropdown list to view the students linked to other rolls.   
 

 
If the user clicks the VET Student Find tool and selects a subset of students to view, this will 

show a statement similar to the following:  
 
The dropdown list will also contain any saved VET Student Find Tool queries.  Selecting a query 
from the list will run that query and populate the list with the students returned by the query.  
 

 Open the Student Details window for the selected student(s).  If one student is selected, 
then that student’s details are displayed.  If more than one student is selected, the first student’s 
details are displayed and the selected students become the browse set for the Student Details 
window. 

 Open the main Integris Student Details window for a selected student.  This window 
remains open so that the user can select another student in the list and the window will update with 
that student’s details. 

 Open the VET Student Find tool.  This Find tool is used to select a specific group of VET 
students to be displayed in the list. 

 Open a second window where the user can maintain the list of VET students. This window 
will allow the user to add and remove students from the list of VET Students. 

 Open a Student Groups window, where the user can set up student groups. 

 Open a window in which the user can speed edit a range of VET student data for a group of 
students simultaneously, including Active Status, Enrolling/Non-Enrolling status, School and FTE. 

 Opens the Student - Bulk qualification and Competency Enrolment window.  This enables 
the enrolment of multiple students into qualifications and multiple competencies at the same time. 

 Open the Vet Competency Enrolment Speed Edit window.  This enables single or multiple 
entries of results for a competency for a group of students simultaneously. 

 Print a list of the students selected from the displayed VET Student list. 

 Print the VET Student list as displayed. 
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7.1.2 Adding and Removing VET Students 

VET > Students > Add/Remove VET students 

Students are added to the list by clicking the Add/Remove VET students button  on the 
toolbar.  This opens a window in which the user can add or remove VET students.  
 

 
 

Originating School 

The set of VET Students at a particular school can consist of students from a number of schools.  
For example, a school that is an RTO will train its own students as well as students from other 
schools that are not RTOs.  It is important to distinguish between those VET students who come 
from this school and those who come from another school.  The VET module does this by tagging 
a student with a school code.  If the student originates from the local school, the student is tagged 
with the local school code.  If the student originates from another school, the user can enter the 
code for that school, or a ‘catch all’ code to signify they are from another school. 
 
The above window assists in the designation of the school code by the use of two radio buttons: 
‘This School’ and ‘Another School’.  Clicking on the ‘This School’ button will automatically enter the 
local school code in the Code field and display the local school name.  This data comes from the 
‘School Details’ area of Integris.  The Code field will be greyed and cannot be changed.   
 

 
 
If the user clicks the ‘Another School’ button, the Code field will be enabled and the user can enter 
an alternative school code.  Tabbing out of the Code field will perform a match of the code entered 
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against the list of codes in the Previous/Destination School parameter.  If there is a match, the 
school name appears below the code.   
 

 
 
If not, the following prompt is displayed, and the words ‘** Unknown School Code Entered **’ will 
appear.  
 

 
 
If the field is left blank, the code changes to ‘Other’ and the text below the code becomes ‘Other 
School’.  This is the ‘catch all’ code used to group together all students from some other school. 
 

 
 
Every VET Student therefore has one of three school codes attached to them: the local school 
code; another school code (recognised or not) or the catch all ‘Other’ code. 
 

Enrolling/Non-Enrolling Student 

A student can be classed as either Enrolling or Non-Enrolling.  A ‘Yes’ indicates the student is an 
Enrolling student who has no limitations.  He/she can be enrolled into qualifications and 
competencies, and can be linked to a work placement.  A ‘No’ indicates the student is a Non-
Enrolling student who can be put on work experience, but cannot be enrolled in qualifications or 
competencies.  
 

Note: a student can be changed from one context (Enrolling/Non Enrolling) to another at 

any time.  This is done using Speed Edit   within the Student List window. 

Add Students Functionality 

When the VET – Add Students window is first opened, the Originating School defaults to ‘This 
School’, and Enrolling Student defaults to ‘Yes – can be enrolled’.  The window shows all non-VET 
and all VET students on the selected roll. 
 

 
 
It is possible to sort the contents of both lists by clicking on the column headings for each list. 
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Adding VET Students 

VET > Students > Add Remove VET Students 

VET Students are added to the system by moving them from the ‘Non VET Students’ list to the 
‘VET Students’ list.  To do this: 
 

 Highlight the required students in the ‘Non VET Students’ list to select them.  
OR 

 Use Student Find  to locate the students you wish to add and then highlight them.   

 Ensure that you have selected the correct Enrolling Student and Originating School options. 
 

 
 

 Click.   
 
The selected students will be moved from the ‘Non VET Students’ list to the VET Students list.  
Repeat this process as many times as required. 
 

 Click OK to save the list of VET Students.   
OR 

 Click Cancel to ignore all the changes made and put the data back to the way it was before 
editing was begun. 

 
Students moved to the VET Students list are tagged with the Originating School Code and the 
Enrolling status as selected at the time. 
 

Removing VET Students 

 Highlight the students you wish to remove from the VET Students list 
OR 

 Use VET Student Find  on the VET Students side of the window to locate the students you 
wish to remove, and then highlight their names in the list.   

 Click.  

 Click OK. 

 Click Close to close the VET – Add Students window.   
 
The Close button is only visible when there are no changes to be saved. 
 

Note: The user cannot remove students on the VET list if they have enrolments attached to 
them. 
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Toggle Active Status 

Another method for changing the active status of students is to toggle (change) it by right clicking 
on their names. 
 

 Highlight the names of students whose status you wish to change. 

 Right click. 

 Click on ‘Toggle Active Flag’. 
 

 
 
If a student’s status cannot be changed, a message will be displayed: 
 

 
 

 Click OK to close the message. 
 
When the list of VET Students is changed (by clicking either of the arrow buttons or by right 
clicking), the OK and Cancel buttons replace the Close button at the bottom right of the window.  
None of the changes made is saved until the OK button is pressed. Clicking Cancel will discard 
the changes and refresh the window to display the data as it was at the last save operation 
 
The ‘Originating School’ and ‘Enrolling Student’ fields remain active throughout the edit process.  
This allows you to bring across students with one set of parameters, then change the parameters 
and bring across another set of students.  All the changes can be saved in the one operation by 
clicking the OK button. 
 

The ‘Non VET Student’ list can be filtered using the standard Integris Student Find tool. .  The 
Find tool enables you to define a query and store that query for future use.  All the saved queries 
are displayed in the drop-down list alongside the ‘Display’ label as shown below.   
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Selecting a query from the dropdown list will activate that query and retrieve the appropriate 
records. 
 
If the Find tool is used and the query is not saved the drop-down list will show a message similar to 
this.   
 

   
 
There is no restriction on who can be classed as a VET student.  For example, it is possible to 
select students on the External roll and class them as VET students. 
 

7.1.3 Viewing VET Student Details 

VET > Students > View VET Student Details 

 Select one or more students in the list. 

 Click the VET Student Details  button on the toolbar.   
 
This will open the VET Student Details window.  If one student record was selected, then that 
student’s details will be displayed.  If more than one student was selected, the first record will be 
displayed, and all other students will appear in the window browse set.  Clicking on the ‘Next’ and 
‘Previous’ buttons on the Student Details window will scroll through the students in the browse bet.  
 
Similarly, double clicking a student in the list will open the Student Details window with the details 
for that student. 
 
 

7.1.4 Viewing Standard Student Details 

VET > Students > View Main Student Details 

With a student’s name selected, clicking the Student Details button  on the toolbar will open a 
‘browse only’ version of the main Integris Student window for that student, as shown below.   
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This window remains open as a floating window and allows you to click on another name in the 
Student List window.  The details of the newly selected student will then appear in the main browse 
window. 
 
The ‘V’ icon on the status bar at the bottom right of the Student window shows the student is a VET 
student.  A red icon indicates they have an ‘active’ VET status.  A grey icon indicates they have an 
‘inactive’ status.  
 

7.1.5 VET Student Speed Edit 

VET > Students > Speed Edit 

Clicking the Speed Edit button  on the VET – Student List toolbar opens the VET - Speed Edit 
window.  The VET - Speed Edit window enables you to edit five major VET fields for a group of 
students simultaneously.  These fields are: 
 

 Active Status 

 School Code 

 FTE 

 Enrolling Status 

 Vocation Types 1 and 2 
 

 
 
The window displays a list of selected students from the VET Student List window, as shown 
above.  
 

Alternatively, the user could use the VET Student Find tool  in the VET – Speed Edit window to 
select a group of VET students. 
 
Clicking one of the four radio buttons in the Field area of the Speed Edit window will populate the 
Value field with the appropriate values related to that field.  These are 
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 Active Status: Active/Inactive. 

Note: a VET student cannot be made inactive if he or she has a current competency 
enrolment  

 School Code: The list of schools as defined in the Previous/Destination School parameter. 

 Enrolling: YES/NO. 

 FTE: blank field for the entry of a 2 digit numeric value between 0.00 and 1.00. 

 Vocation 1 and Vocation 2: the list of Vocation/Job Types as they appear in the Vocation/Job 
Type parameter. 

 
The columns displayed in the list are as follows 
 

 Ref.:  the Student Reference number. 

 Surname:  the student’s surname. 

 First name:  the student’s first name. 

 Value:  the value of the selected field for each student. 

 Status:  an ‘M’ in the Status column signifies that the value has been modified and has not 
been saved.  

 

Selecting a new value and clicking Apply Changes  modifies the value for all selected students 
in the list.  This only changes the values in the list.  The values in the database are not saved at 
this time.  The Status column contains the letter ‘M’ to indicate that the value has been modified 
but not saved, as shown below.   
 

 
 
The OK and Cancel buttons will replace the Close button.  The Field area will be disabled.  This 
prevents the user from selecting a different field to speed edit while there is modified data in the 
list.  The VET Student Find tool is disabled. 
 
At this point, the user has the option of selecting a new group of students in the list and a new 
value to apply, or clicking the OK/Cancel buttons as appropriate. 
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Clicking the OK button will: 

 save all the changes to records with an ‘M’ status 

 clear the ‘M’ status for all records in the list 

 enable all fields in the window 

 replace the OK and Cancel buttons with the Close button 
 

 Clicking the Cancel button will: 

 clear all the changes to records with an ‘M’ status 

 clear the ‘M’ status for all records in the list 

 enable all fields in the window 

 replace the OK and Cancel buttons with the Close button 
 

Speed Editing Students’ FTE 

VET > Students > Speed Edit 

In the VET – Student List window, select students whose FTE you wish to view/edit. 
 

 
 

 Click Speed Edit   

 Click the FTE radio button.   
 

   
 
Students’ FTE values are displayed in the Value column. 
 

 Highlight the students whose FTE values are to be edited.  Use <Ctrl> while selecting them. 
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 In the New Value field enter the new FTE value.   

 <Tab> out of the field. 

 Click the Apply Changes.   
 
The Status column displays ‘M’ for the students whose records have been modified. 
 

 
 

 Continue selecting students, entering a new value and clicking Apply Changes  as 
required. 

 Click OK to save the changes.   
 
Having saved or cancelled the entry for one field, other fields can be selected and values edited. 
 

 Click Apply Changes.  

 Click OK to save changes. 

 When editing is completed, click Close to close the window. 
 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 7-14 

© 2013 Civica Pty Ltd 
 

 

7.2 VET Student Details 

VET > Students > VET Student Details 

 The VET - Student Details window is launched by clicking the View VET Student Details 
toolbar button in the VET - Student List window.  

Note: the VET Student Details window can be opened from the sidebar by clicking the 
Student icon if the ‘Open Student/Employer window in details rather than list’ option is 
selected in the VET System Preferences. 

 

 
 
Browsing and navigating in this window is similar to the standard Integris Student window.  
 

 The camera button will display a picture of the student in the same manner as the standard 
Integris student window.  
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7.2.1 VET Student Details Toolbar 

VET > Students > VET Student Details 

 If grey, the browse set is empty; if red it’s active. 

 Roll status.  

 View Previous Student.  

 View Next Student. 

 VET Student Find.  This Find tool searches through the list of VET Students. 

 Open the standard Integris Student window that displays student demographic and medical 
data. 

 Enable editing of the data in Miscellaneous view.  Data in other panes can be modified by 
clicking the add, edit and delete buttons in the toolbars to the right of those windows 

 View the student’s qualification and competency enrolment details as well as competency 
results. 

 View student work placement information. 

 View student miscellaneous information including AVETMISS student data 

 Print the data in the selected view. 
 
The standard Student Search field at the bottom of the window enables you to enter a student 
reference number or partial surname, and the system will find the matching records.  It works in the 
same manner as the Student Search field in the main Integris Student window, except that it 
searches just the list of VET students.  
 

 
 
For example, to find a student whose surname is ‘Guthrie’, enter all or part of the surname and 
press <Tab> or <Enter>.  If more than one VET student matches the search criterion, a list of 
students is displayed.  Use the arrow keys on the keyboard to scroll to the desired name and click 
the Select. 
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7.2.2 Enrolments View 

VET > Students > VET Student Details > Enrolments 

The window will open in the Enrolments View, displaying the qualification enrolments and 
competency enrolments for the student. 
 
Clicking a qualification row in the list will display all the student competency enrolments for that 
qualification in the area below.   
 

 
 
The Qualification pane contains a system-generated entry: “...n/s..”, “Unspecified”.  In the 
Northern Territory, this line is for the entry of competency enrolments not linked to a qualification. 
 
When a student is enrolled in a qualification, you need to specify a start date.  The completion date 
is the date the student completed all requirements for the course, and should be entered after the 
event.  This date is used in AVETMISS reporting to determine if the qualification completion is to 
be reported for the current year.  So this date must be accurate.  Having entered a qualification 
completed date; you can enter a certificate number associated with the granting of the certificate to 
the student. 
 

7.2.3 Enrolling in a Qualification 

VET > Students > VET Student Details > Enrolments 

A student can have many qualification enrolments, and which can have a number of competencies 
associated with it.  The same competency enrolment can be associated with many qualification 
enrolments for the same student at the same time.  It is also possible, in the Northern Territory, to 
enrol a student in a competency that is not associated with any qualification.  
 
The system allows you to enter each qualification individually and then enter each competency for 
each qualification individually.  
 

To enrol a student in a qualification 

 Click the Add Qualification button  alongside the qualification list.  This will open the VET - 
Qualification Enrolment window.  The student name and reference number will appear at the 
top of the window.  
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WA Display 

 
 

NT Display 

 
 

 Enter the Start Date  
 
This represents the date the student began study in this qualification, and defaults to today’s date. 
It is used to display a student’s enrolment history in chronological order, and to determine the 
enrolment data extracted for most reports so it must be accurate.  The Start Date is not used to 
determine if a student is active or inactive and can be any date (past or future), but the completion 
date must be after the start date.   
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It is recommended that the Completion Date field be left blank and only updated when the student 
completes the enrolment, withdraws or leaves the school.  The Completion Date is used in some 
AVETMISS reports to determine which qualification enrolments are to be reported for each yearly 
data collection, so the date must be accurate. 

Note: If a Completion Date is entered and the Qualification Achieved field is left blank, the 
Completion Date field will be saved as blank. No error or warning message is displayed (WA 
ONLY) 

 Click Qualification Find  
 

 
 

 If required enter some search parameters 

 Click Find 
 

 
 

 Highlight the required Qualification and click Select 
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WA Display 

 
 

NT Display 

 
 

Qualification RTO  

A school may register themself as an RTO (refer to section 6.2.3), but this does not mean that they 
are the RTO for every student qualification enrolment which they record in VET.  Competency 
Enrolments may also have different RTOs; however there must be one RTO responsible for 
issuing the certificate.   

Note: The qualification RTO is the RTO issuing the certificate for that particular student 
qualification enrolment (i.e. Certifying RTO).  

The default RTO value is blank. 
 

 Select the Qualification RTO.   
 
If the school is not an active RTO, then they will not appear in the Qualification RTO dropdown list. 
 

WA Display 
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NT Display 

 
 
RTO is a required field.  The following error message will display if the user clicks OK without 
having selected an RTO. 
 

 
 
The Enrolments pane displays the Qualification RTO Code. 
 

 
 

Qualification Achieved – WA Only 

The decision that a student has achieved the qualification is a manual process that can be 
undertaken by the user at any time.  This is a human check to ensure that packaging rules are 
complied with before the issuing of a certificate.  The Qualification Achieved field must be ticked 
for the user to be able to print a certificate for this qualification enrolment via VET > Reports. The 
default is unticked. 
 

 
 

 Check  Qualification Achieved box 
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A qualification cannot be set to ‘Achieved’ if no Completion Date has been entered.  An 
error will display message when the user clicks the OK button. 

 
 

Certificate Issued – WA only 

 
 
The School Curriculum and Standards Authority requires a mandatory Y/N indicator (titled 
Certificate Issued) in the Qualification Achieved export file (RSQUAL).  
 
A certificate is deemed issued if printed by the RTO (at which point it is assumed it has been sent 
to the student).  Schools that have recorded qualification enrolments for whom they are not the 
RTO, are still required to record whether the certificate has been issued, and export this to the 
School Curriculum and Standards Authority.  These schools may not always be informed of the 
Certificate Identifier.  The user will usually record whether the certificate has been issued at the 
end of the year when they have been printed and sent to students. 
 
The field is only enabled when the following rules are met: 

 The school is not the Certifying RTO for this qualification enrolment. 

 The Qualification Achieved box is ticked. 
 

Full Qualification Enrolment  

A student could be enrolled in a qualification but may not be working towards the qualification 
certificate.  To distinguish these students from the ones who actually are working towards 
completing the certificate, there is a field in the form of a tick box which can be used to record full 
qualification enrolments.  
 
This data is used for statistical purposes to report on how many students enrolled in qualifications 
actually achieved those qualifications. This field has also been added to the Bulk Qualification 
window.  

Note: In WA a student competency enrolment must be tied to a qualification enrolment 
whereas in the NT students can be enrolled in competencies without being linked to a 
qualification. 
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Date Issued – WA only 

The Date Issued field contains the date on which the qualification certificate was printed. 
 
For schools registered as RTOs, the Date Issued field is populated with the date the certificate 
was printed and the field is disabled. 
 
The Certificate Issued field is ticked and disabled. 
 

 
 

Certificate Identifier  

If the school is the Certifying RTO, then this field is disabled and the field is auto populated when 
the certificate is printed. 
 

 
 
In the Northern Territory, if the school is not the Certifying RTO, then the field is enabled only when 
the Completion Date is entered. 
 

Auto-enrol student into all linked competencies 

If the  option is ticked, the Qualification 
Enrolment window will be expanded to show all the competencies linked to the selected 
qualification. All the competencies appearing in this list will be added to a student’s enrolment, as 
shown below 
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WA Display 

 
 

NT Display 

 
 
Selecting and deselecting the Auto enrol option will expand and contract the window to show and 
hide the competency list. 
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Note: the default value for the auto-enrol option can be set as a System Preference. 

 Click OK to save the enrolment.   
 

If the  option is selected, the Competency 
Enrolment window will be displayed. The competencies appearing in the qualification auto enrol list 
will be transferred to this window.  
 

 
 

If necessary, select the competencies not required and click Delete  to remove.  
 

 Enter mandatory Start Date and End Date 

 Click on the Delivery tab to enter the required details. 
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WA Display 

 

Note:  In WA, the RTO for a competency enrolment may not be edited after the enrolment 
cut-off date has passed.  

NT Display 

 
 

 Click on the AVETMISS tab and enter the required details. 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 7-26 

© 2013 Civica Pty Ltd 
 

 

WA Display 

 

Note: In WA Study Reason is a mandatory field. 

NT Display 
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Note:  The Specific Program Identifier field was added to ensure compliance with 
AVETMISS 6.1 which came into effect on 1 January 2012.  It is a free-text field that can 
accommodate a 10 character alphanumeric code. 

 Click OK or Cancel.   
 
Clicking Cancel at this stage will only abort the recording of the competency enrolments.  The 
qualification will be saved and will appear in the Student Details window without any associated 
competency enrolments. 
 

7.2.4 Editing a Qualification Enrolment 

VET > Students > VET Student Details > Enrolments 

The qualification enrolment Start Date, Completion Date and Certificate Identifier fields can be 
modified using the Edit Qualification function.  
 

To edit a qualification enrolment (Northern Territory) 

 Select the desired qualification enrolment in the list. 

 Click the Edit Qualification button on the right of the Qualifications list pane.   
 
This will open the Student Qualification window. This is the same window used to add a 
qualification, but is now in edit mode and has some restrictions. The qualification code cannot be 
edited but the user can change the Start Date, Completion Date and Full Qualification Enrolment. 
 

 
 

 Make required changes. 

 Click OK to save the changes, or Cancel to return to the VET Student Details window without 
changing the record. 

 

To edit a qualification enrolment (Western Australia) 

 Select the desired qualification enrolment in the list. 

 Click the Edit Qualification button  on the right of the Qualification pane  
 
This will open the Student Qualification window.  This is the same window used to add a 
qualification, but is now in edit mode and has some restrictions.  The qualification code cannot be 
edited but the user can change the Start Date, Completion Date, RTO, Qualification Achieved and 
the Full Qualification Enrolment fields. 
 

 Make required changes. 
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 Click OK to save the changes, or Cancel to return to the VET Student Details window without 
changing the record. 

 

 
 

Qualification Achieved (WA only) 

 Enter a Completion Date.  

 Check Qualification Achieved.  
 
If the qualification enrolment has competencies with results other than 20, 50 or 60 then the 
following message will display: 
 

 
 

 Click Yes or No as required. 
 
If a Completion Date is entered, then Qualification Achieved should also be checked.  If the 
Qualification Achieved check box is left blank, upon clicking OK the following error message 
displays: 
 

 
 
If the Qualification Achieved has been checked, then a Completion Date should also be 
entered. If the Completion Date has been left blank, upon clicking OK the following error message 
displays: 
 

 
 
Upon clicking OK on the Qualification Achieved error message, the message box closes and the 
Edit Qualification window displays.  In this window either the Completion date must be removed or 
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the Qualification Achieved must be ticked. Clicking on the Cancel button closes the Edit 
Qualification window without saving any changes. 
 

Western Australia –RTOs 

Certificate IDs are generated automatically by the system for RTOs once Certificates have been 
printed.  
 

WA – For non RTOs 

For non RTOs Certificate IDs are entered manually by the user. Initially the Certificate Identifier 
field and the Certificate Issued checkbox are unavailable. 
 
Check Qualification Achieved’. The Certificate Identifier field is enabled and the Certificate 
Issued field becomes available. 
 

 
 

 Enter a Certificate Identifier number if known. 

 Check the Certificate Issued box. 

 Click OK to save the changes, or Cancel to return to the VET Student Details window without 
changing the record. 

 

7.2.5 Deleting a Qualification Enrolment 

To delete a qualification enrolment 

VET > Students > VET Student Details > Enrolments 

The Delete button alongside the qualification enrolment list will be activated if this is a qualification 
enrolment that can be deleted.   
 

The Delete button  will not be activated if there are competency enrolments associated with the 
selected qualification enrolment. You must first delete all the associated competency enrolments 
before deleting the qualification enrolment. 
 

 Select the desired qualification in the list.   

Note: Deleting a qualification is also subject to the cut-off date rule described later in this 
section. 

 Click Delete.  
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 Confirm the deletion, by clicking Yes.  
 
If the Qualification has a completion date assigned the following message displays: 
 

 
 
If the Qualification has a certificate ID assigned the following message displays: 
 

 
 

 Click Yes to continue or No to cancel. 
 
The qualification enrolment will be deleted and the enrolment window updated to reflect this 
change. 
 

7.2.6 Enrolling in a Competency 

VET > Students > VET Student Details > Enrolments 

The Add, Edit and Delete buttons to the right of the Competencies pane enables changes to the 
competency enrolment details for a student.  
 
A competency enrolment can be linked to one or many qualifications or, in the Northern Territory, 
undertaken in stand-alone mode where it does not form part of any qualification. 
 
To enrol a stand-alone unit of competency highlight the ‘Unspecified’ entry in the Qualification list, 
then follow the instructions below. 
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Note: In Western Australia, all competency enrolments must be part of a qualification.  
Thus, the Unspecified Qualification option cannot be selected in the individual competency 
enrolment window. When the Unspecified qualification has been selected, the Add 
Competency button is disabled. 

 Click on the appropriate qualification or the Unspecified entry in the qualification pane.  

 Click the Add button  alongside the competency enrolment list. The VET – Competency 
Enrolment window opens, enabling you to enter the details for the competency enrolment. 

 

 
 
Above is an example of the Competency Enrolment window, which will display the qualification 
description selected in the Student Details window. If you’re entering a competency enrolment not 
linked to a Qualification, the text ‘Unspecified’ will be displayed in place of the qualification 
description.  
 
This window allows enrolment in multiple competencies at the same time by building up a list of 
competencies in the bottom half of the window.  All the data entered in this window will be applied 
to all the competencies in the list. 
 

 Enter Start and Completion Dates by typing a date into the field, or clicking date selector  
to select a date.  

 Enter a single competency code or competency group code in the Competency Code/Group 
field.  If a group code is entered, the competency list will be updated to show all the 
competencies in that group.   

 
OR 

 Use the Find Competencies on Offer button  to select one or more competencies.  

 Double click the required competencies.  The window will close and selected competencies will 
be transferred to the Competency Enrolment window.   
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NT only 

When selecting a Competency or competencies not linked to a particular qualification, you will get 
a warning message, as in the example below.  
 

 
  

 Click Yes or No as appropriate. 
 

WA only 

Users are prevented from enrolling in competencies that are not linked to a qualification. 
 

 
 

 Click OK to continue. 
 

 Repeat this process using any combination of the above strategies until all the required 
competencies appear in the competency list at the bottom of the window.  This list represents 
all the competencies the student will be enrolled in for the selected qualification. 

 Click OK. 

 Click on the Delivery tab. 
 

WA Display 
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NT Display 

 
 
The Industry Area – (From Qualification) field is automatically populated via the selected 
qualification enrolment. It is provided for information and cannot be edited or deleted in this 
window.  
 
If the enrolment is for a ‘n/s’ qualification (NT only) or the qualification is not attached to a valid 
industry code the Industry Area group box will be displayed as follows: 
 

 
 

 Select an RTO from the drop-down menu, as in the example below.  
 

 
 
In the NT, a location linked to that RTO appears in the Location field.  A different location may be 
selected if more than one location was entered for that RTO in Delivery Planning > Set up External 
RTOs. 
 

 
 

 Select the Mode from the drop-down menu.  
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The drop-down values for RTO mode of delivery are AVETMISS compliant and default to the 
AVETMISS 6 standard, these being: 
 
10 Classroom-based 
20 Electronic based 
30 Employment based 
40 Other delivery (eg correspondence) 
90 Not applicable – recognition of prior learning 
 

 Select the RTO arrangement from the drop down menu.  
 
The drop-down values for RTO arrangement are:  
 
0 Outsourced – Profile Hours 
1 School Auspicing with a Registered Training Organisation 
2 School as Registered Training Organisation 
3 Outsourced – Fee for Service 
4 Network School Arrangement 
 

 In the NT, if the student is a school-based trainee, enter the type of traineeship, as shown in 
the example below.  

 

 
 

 Check Retention and Transition Program as appropriate.  

Note: In WA, Traineeship information is entered on the AVETMISS tab where there is no 
Retention and Transition Program checkbox. 

 

Competency Status 

The Competency Status area captures information about the subject associated with an integrated 
competency enrolment. 
 

 
 
If the competency enrolment is integrated with an accredited subject,  

 Check Integrated check box  

Note: In Western Australia, if a student has no subject preferences defined, then the 
Competency Status group box is disabled during the process of adding a competency. 

The Code field is mandatory in the case of an integrated enrolment, and failure to enter a subject 
code into this field will result a prompt displaying the student’s subject preferences 
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 Select the required subject and click OK 

 Click on the AVETMISS tab. 
 

WA Display 

 
 

 Select an RTO from the drop-down menu, as in the example below.  
 

 
 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 7-37 

© 2013 Civica Pty Ltd 
 

 Select the arrangement as in the example below 
 

 
 
Select a Delivery Site Type as in the example below. If School or External RTO is selected, the 
Trade Training Centre and Trade Training Centre Site remains greyed out and the user may 
proceed to the AVETMISS details. 
 
 

 
 
 
If the Delivery Site Type selected is a Trade Training Centre, then the Trade Training Centre 
and the Trade Training Centre Site are mandatory fields and must be completed before the user 
 is able to continue to the AVETMISS details. 
 
 
Delivery Site Type 
 
The Delivery Type Site determines where the VET course is being delivered. It is a mandatory  
field for new and edited competencies and has the values of: 

 External RTO 

 School 

 Trade Training Centre 
 

 
 
 
Trade Training Centre  
 
The Trade Training Centre will be greyed out unless ‘Trade Training Centre’ has been selected as 
the Delivery Site Type and won’t be mandatory unless selected. The Trade Training Centre refers 
to the organisation delivering the VET course. 
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Trade Training Centre Site 
 
The Trade Training Centre Site will be disabled and greyed out until a line is chosen from the 
Trade Training Centre list.  Only when this is done will the Site list be enabled and the list of Sites 
will only include those linked to the selected Trade Training Centre.  A value must be set for it to be 
saved. It will be possible to save a competency where both the Trade Training Centre and Trade 
Training Centre Site details are not set. 
 
 

 
 

 

Note: In WA, Study Reason is a mandatory field for all students.  Trainee Details only apply 
to trainees or apprentices.   
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NT Display 

 

Note:  The Specific Program Identifier field was added to ensure compliance with 
AVETMISS 6.1 which came into effect on 1 January 2012.  It is a free-text field that can 
accommodate a 10 character alphanumeric code. 

 Enter the required information and click OK to save the data.  You will be prompted to 
complete any mandatory fields that have been left blank. 

 

Duplicate Enrolments 

A student will normally have just one record for a competency enrolment in an academic year.  
However, there will be situations where a student has not yet achieved a competency and is given 
the opportunity to repeat it.  The module allows for the entry of a duplicate competency record 
linked to the same qualification in the same academic year provided the first record has a result 
entered.  An error message is displayed if you attempt to enter a second identical competency 
enrolment record linked to the same qualification in the same academic year when the existing 
record does not have a result. 
 
It is possible to enter a duplicate competency enrolment for the same student in the same year to 
another qualification.  In this instance the software recognises two independent competency 
records.   
It is also possible to enter a duplicate competency enrolment at a different RTO provided the Allow 
concurrent enrolment at different RTO option is selected in the System Preferences.  See 
Section 5.5 for a description of this option. 
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7.2.7 Adding a Temporary Competency Enrolment (NT Only) 

VET > Students > VET Student Details > Enrolments 

There may be instances when a school wishes to offer a unit of competency that is not currently on 
the master competency file provided by the Curriculum Council.  While approval to offer this 
competency is being sought, a temporary competency enrolment may be entered provided this 
option has been checked in Control>System Preferences. 

Note: For DET WA Users, the “Allow temporary competency enrolments” option has been 
disabled as shown below: 

 
 
Temporary units of competency may be added to VET School Offerings when enrolling a single 
student in a temporary unit of competency or when enrolling a group of students in a temporary 
unit of competency in Bulk Enrolment. 
 

To add a temporary competency enrolment for a single student: 

 Click Add  to the right of the Competency pane in VET>Student Details. 

 Enter a school-based competency code in the Code field and <Tab>. 
 

 
 

 Click Yes to add a temporary competency 

 Enter the name of the temporary competency and click OK 
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 Click Yes and OK. 

 Enter the Delivery and AVETMISS details 

 Click OK.  
 
A temporary competency enrolment will then be entered for the student concerned. 
 

 
 

7.2.8 Editing a Competency Enrolment 

VET > Students > VET Student Details > Enrolments or Competencies 

A competency enrolment can be edited from either the Enrolments tab pane or the Competencies 
tab pane in the VET - Student Details window.  Both options open the same edit window and have 
the same result.   

To edit a Competency Enrolment 

 Select the desired competency in the list.   

 Click Edit  to the right of the Competencies pane.  
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WA Display 

 

Note:  In WA, the RTO for a competency enrolment may not be edited after the enrolment 
cut-off date has passed.  
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NT Display 

 

Note: In the NT, if the Enrolment cut-off date has passed, the edit and delete 
competency icons are disabled and a message is displayed in the Student Details 
window: 

 

 
This window works the same way as the VET – Competency Enrolment window. 
 

 Make the required changes. 

 Click OK to save the changes. 
 
Once a student has been enrolled in a competency the start date cannot be changed to a value 
outside the offering academic year. The following message will be displayed: 
 

 
 
Once the Enrolment cut-off date has passed the Integrated and Subj Code field are disabled. 
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7.2.9 Deleting a Competency  

VET > Students > VET Student Details > Enrolments or Competencies 

Note: A competency enrolment cannot be deleted if it has a result recorded. 

 Select the desired competency in the list. 

 Click the Delete button alongside the competency list.   
 

 
 

 Click Yes.   
 

WA  

If the Enrolment cut-off date has passed, the delete competency icon  is disabled and a 
message is displayed in the Student Details window: 
 

 
 

NT 

If the Enrolment cut-off date has passed, the edit and delete competency icons are disabled 
and a message is displayed in the Student Details window: 
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7.2.10 Competencies Tab  

VET > Students > VET Student Details > Competencies 

The Competencies tab shows all the student’s competency enrolments without their links to 
qualifications.  
 

 
 

Editing a Competency Enrolment 

VET > Students > VET Student Details > Competencies 

Clicking Edit  alongside the Competencies list enables editing of one competency enrolment at 
a time. 
 

Deleting a Competency Enrolment 

VET > Students > VET Student Details > Competencies 

Note: A competency enrolment cannot be deleted if it has a result recorded. 

Clicking Delete  alongside the Competencies list will delete the selected competency 
enrolment from the linked qualification. 
 

The following message will be displayed when you click the Delete  button: 
 

 
 

 Click Yes to delete the competency enrolment or No to cancel the deletion. 
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7.2.11 Student Preferences 

VET > Students > VET Student Details > Preferences 

 
 
The data displayed here is for information only and there is no functionality to add, edit or remove 
items from the list.  The Timetabling Year and Grid will need to be selected to show the student’s 
preferences for the given period of time.  The information here reflects what has been specified 
within the Timetabling module. 
 
This tab is only active if the Timetabling module has been installed.  The entire tab will be greyed 
out if the Timetabling module is not installed. 
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7.2.12 Placement History 

VET > Students > VET Student Details > Placement History 

A Student’s placement history can be viewed in the VET Student Details window by clicking the 

Placements icon  in the toolbar. 
 

 
 
A work placement record is comprised of two parts.  The first is the details of the employer and the 
second is the attendance dates associated with the placement with that employer.  The above 
window shows summary information about the placement with a complete list of attendance dates.  
If there is more than one placement history record, clicking on a specific record in the list will 
refresh the attendance list to show the attendance dates for that placement. 
 

Note: From VET 1.87.00 onwards, Attendance Days as well as Dates are displayed. 
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Adding a Work Placement  

VET > Students > VET Student Details > Placement History 

A work placement record consists of the placement details and the attendance dates associated 
with the placement.   

Click on Add  within the Placement History box. This will open the VET Placement Details 
window where all the details for to a new work placement can be added as shown below. 
 

 
  
The fields in this window are: 
 
Employer Enter the full employer name in the employer field, or click on the 

Employer Find to locate the required employer.   

Workplace Category The workplace category dropdown list is populated with the workplace 
categories assigned to the selected employer.  Select from the entries in the 
list. 

Job Type The Job Type drop-down list is populated with the job types assigned to the 
selected employer.  If there are no job types assigned to the employer, the 
list will contain all the active job types appearing in the parameter list.  Select 
the desired job type. 

Supervisor This will default to the contact name associated with the employer job type 
selected.  It is a free text entry field that can be modified at will. 

Attendance Each work placement will have a number of student attendance dates 
associated with it.  This area of the window allows you to enter a pattern of 
attendance and the system will calculate the actual dates of attendance 
based on the pattern entered.  A ‘From’ and ‘To’ date must be entered and 
the days of the week the student will attend. When the OK button is clicked, 
you must also select one of the three attendance modes: AM, PM or All Day. 
Attendance dates are calculated based on this data and listed in the work 
placement record.   
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Qualification Select from one of the students enrolled qualifications if you wish to link the 
work placement to a qualification.  This is an optional field. 

 

Required Hours and 
Total Hours Actually 
Completed 

The VET module does not calculate the hours associated with a placement.  
This data must be entered manually into these two fields. 

Notes A free text field to record any notes pertaining to the work placement. 

Address This represents the address for the work placement, as opposed to the 
address for the employer.  The two will in many cases be the same, and the 
default is the employer address. 

Release Mode The three options available are Day Release, Block Release, and Neither. 

 

 Click OK to save the work placement data.  
 

Editing a Work Placement Record 

VET > Students > VET Student Details > Placement History 

The two work placement components (placement details and attendance dates) can be edited 
independently of each other.  This section deals with the editing of the placement details.   
 

To edit work placement details: 

 Select the appropriate placement record in the list and click Edit.  
 
The VET Placement Details window described in the previous section will open.  All the placement 
details except the attendance information may be edited as required.  
 

 Click OK to save the changes. 
 
Once created, the work placement record will have a number of attendance dates.  You can add, 
edit and delete items in this list as required.  
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Adding Attendance Dates 

VET > Students > VET Student Details > Placement History 

Click Add  alongside the Attendance list. This will open the VET Workplace Visit window, as 
shown below. 
 

 
 

 Enter a From date and a To date and check the days of the week the student will be attending 
the work placement.   

 
When OK button is clicked, actual attendance dates are calculated and added to the work 
placement record.  All the date records created will inherit the details of all other fields in the 
window. 
 

 Attendance mode: Select AM, PM or All Day. 

 Student attended on this day indicates whether the student actually attended the work 
placement on this date.  The default is for this option to be ticked, which will indicate that the 
student attended. 

 Staff member attended on this date indicates whether or not a staff member visited the work 
placement on this date.  The default is for this checkbox not to be ticked.  Ticking the checkbox 
will enable the Staff Member drop-down list from where you can select one of the staff in the 
list. 

 Staff Notes may be entered by the staff member responsible for supervising the work 
placement or the staff member who visited the work placement. 

 

 Click OK.  
 
This will create a series of attendance dates based on the criteria entered and return to the Student 
Details window. 
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Editing an Attendance Record 

VET > Students > VET Student Details > Placement History 

 Select the required attendance record in the list. 

 Click Edit  alongside the attendance list.  
 

 
 

 The window will open with the visit details as they appear in the list.   

 Modify the data as required and click the OK button. 
 

Deleting an Attendance Record 

VET > Students > VET Student Details > Placement History 

Deleting one or more attendance records is done by selecting one or more attendance 
records in the list and clicking Delete.   

 
There are a couple of different warning messages that will appear depending on the status of the 
record/s to be deleted. 
 
If deleting one or more records that have the student attendance marked as No, clicking the delete 
button will prompt the user with the following message:  
 

 
 

 Click Yes to delete the selected date(s), or No to cancel the delete operation. 
 
If deleting one or more records, and some of these records indicate that the student actually 
attended the work placement, the following confirmation message will be displayed:  
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 Click Yes to delete the selected date(s) or No to cancel the delete operation. 

Note: If all of the attendance records for a work placement are deleted, then the Attendance 
information in Placement Details may be edited. 

 

Deleting a Work Placement Record 

VET > Students > VET Student Details > Placement History 

Deleting a work placement record refers to the deletion of the placement details and all the 
associated attendance dates.  
 
Deleting a work placement record that has not begun (that is, the start date for the placement is 
after today’s date) is a simple case of selecting the placement record in the list and clicking the 
Delete button.  The following confirmation message will then appear: 
 

 
  
Click Yes to delete the entire placement record or No to cancel the delete operation. 
 
The following message will be displayed if you attempt to delete a work placement record that has 
already begun (that is, the start date for the placement is on or before today’s date): 
 

 
 
To delete this record, you must first delete all the attendance records associated with the 
placement, and then delete the placement record itself. 
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7.2.13 VET Student Groups 

VET > Students > VET Student Details > Groups 

This function enables the school to set up student groups, to facilitate selection of students. 
Student Groups is one of the search fields in the VET Student Find. 
 

 Click on Student Groups  on the Student List window toolbar. 
 
The VET – Student Groups window opens, listing any VET groups the school has set up.  Select a 
group from the list and any students in that group will be displayed in the Students area of the 
window. A count of the number of students in each group is included on the Student Groups 
window. In the following screen shot, the ‘Hospitality’ group has not had any students added. 
 

  
 

Add a VET Student Group 

 Click Add Group  left of centre. 

 Enter a description (name) for the new group. 
 

 
 

 Click OK.  
 
The group is added to the list of groups. 
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Edit a VET Student Group description 

 Click Edit Group.  

 Change the description. 

 Click OK. 
 

Delete a VET Student Group description 

 Click Delete Group.  

 Read the prompt.  

 If you are sure you wish to delete the group, click OK. 
 

Add VET students to a group 

 Select the name of the group to which students are to be added. 
 

 
 

 Click Add Members  on the right-hand side of the window. 

 Use the VET Student Find tool to select students to add to the group.  
 
The student’s names will be displayed in the corresponding Students list. 
 

Remove VET students from a group 

 Select the name of the group from which students are to be removed. 

 Select (highlight) the names of the students to be removed from the group. 

 Click Delete Members  on the right-hand side of the window. 
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Student Group Report 

 Click either Print Selected   or Print All   
 

 
 
 

7.2.14 VET Student Details – Miscellaneous 

VET > Students > VET Student Details > Miscellaneous 

Miscellaneous Student Details are accessed by clicking the View VET Miscellaneous Details 

button  in the VET Student Details window.  The Miscellaneous window contains three tabs: 
General, AVETMISS and Correspondence. 
 

 
 

The data in all three categories can be edited by clicking Edit.   This will place the window into 
edit mode and the Close button at the bottom right of the window will be replaced OK and Cancel   
Edit the data as required, and then click OK to save the changes. 

Note: Completion of the first two tabs is mandatory for ALL students and schools in 
Western Australia. 
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Miscellaneous Student Details – General 

VET > Students > VET Student Details > Miscellaneous 

 
 
The fields in this window are: 
 

Active Represents the VET student active/inactive status.  Tick this box if the 
student is an active VET student. 

A VET  student cannot be made inactive if any of the following applies - 
he or she: 

Has a competency start date year that matches the year of the current 
system date; or 

Has a competency enrolment that has no competency end date; or 

Has a competency enrolment that has an end date greater than or equal 
to the year of the current system date.  

At Educational Risk Tick this box the student is at educational risk. 

Undertaking Full 
Certificate Study 

Tick this box if the student is studying a full certificate course. 

General Notes A large free text entry field for any notes regarding this student. 

Preferred Vocation There is provision to enter up to two preferred job types for each student.  
This data can then be used to assist in selecting a suitable work 
placement for the student.   

Employer Details This does not refer to the workplace employer.  It is intended to store the 
student’s employer if the student is a school-based trainee. 

Safety Certification This list contains a record of all the work safety certificates held by the 
student.  To add a safety certification record, click the Add button 
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alongside the list.  This will open the VET Work Safety Certificates list 
window where the appropriate certificate can be selected.  To delete a 
safety certification record, select the record in the list and click the 
Delete button.  (The VET Work Safety Certificates list is populated by 
items entered into VET > Parameters > WorkSafe Certificates.) 

Training Agreement This area stores the student’s registered training agreement details. 

Note:  The employer in VET- Student Details>Miscellaneous>General refers to School-based 
Traineeships.  Agreement # refers to the number of the agreement regarding the 
Traineeship. 

 

Miscellaneous – AVETMISS 

VET > Students > VET Student Details > Miscellaneous 

 
 
The AVETMISS tab stores student information required for AVETMISS reporting.  
 
The bulk of the data entry is via pre-defined values in dropdown lists.  The options in each case are 
compliant with the current AVETMISS standard for the field.   
The fields in this window are: 
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Student Attends School Normally set to ‘Yes’ (ticked). 

Highest School Level 
Completed  

The highest secondary school level achieved by the student 

Year Highest School 
Level: 

The calendar year in which the student achieved their highest school 
level 

Employment Category The student’s employment status 

Proficiency in Spoken 
English 

If the Mainly Speak English at Home is checked in General >Student 
Details this is used to default here, otherwise a value needs to be 
selected from the drop-down menu. 

Disability A checklist of AVETMISS disability categories.  Select one or more 
categories as appropriate. 

Prior Educational 
Achievement 

A checklist of AVETMISS educational achievement categories.  Select 
one or more categories as appropriate 

Note: All fields on this tab are mandatory for State and Commonwealth reporting and must 
be completed, except Mobile Phone Number, Disability and Prior Educational Achievement 
which should also be completed whenever applicable. 

 

Proficiency in Spoken English 

Data in the field Proficiency in Spoken English defaults to English Spoken at Home if the 
Mainly Speak English at Home is checked in General > Student Details. 
 
The VET module does not automatically default the Proficiency in Spoken English field. In order to 
activate the default, the user will need to perform the following: 
 

 Click on VET > Students. 

 Highlight required student on the VET - Student list. 
 

 
 

 Click on View VET Student Details  

 Click on View VET Miscellaneous Details   
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 Click on the AVETMISS tab.  

 Click on Edit Student Details.  
 
The Proficiency in Spoken English field changes from n/s to English Spoken at Home. 
 

 Edit further fields as required. 
 

 
 

 Click OK. 

Miscellaneous Student Details – Correspondence 

VET > Students > VET Student Details > Miscellaneous > Correspondence 

The VET module allows for the maintenance of a correspondence log for each student.  The log 
contains the date and description of correspondence sent to the student. You can add, edit and 
delete from the log any manually added notes.  

Note:  All system generated entries cannot be edited or deleted. 
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Add a student correspondence record: 

 Click Edit  in the top toolbar. 

 Click Add.  
 
The date will default to today’s date.  This can be changed by typing an alternative date in the field. 
 

 Enter the relevant details and click OK.   
 

 
 
You will be returned to the Student Details window and the correspondence log entry will appear in 
the list. 

Edit a student correspondence record: 

VET > Students > VET Student Details > Miscellaneous > Correspondence 

Note: all system generated entries cannot be edited. The  icon will be disabled when a 
system generated correspondence entry is highlighted. 

 Highlight the record you wish to edit. 

 Click Edit. . 

 Make the desired changes and click OK. 
 

Delete a student correspondence record 

VET > Students > VET Student Details > Miscellaneous > Correspondence 

Note:  All system generated entries cannot be deleted. The  icon will be disabled when a 
system generated correspondence entry is highlighted.  

 Highlight the record you wish to delete. 

 Click Delete.  
 

 
 

 Confirm the deletion by clicking Yes.  
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Print a student’s correspondence log: 

VET > Students > VET Student Details > Miscellaneous > Correspondence 

 Click Print.  

 Select the desired report destination. 
 

7.3 Bulk Enrolments  

VET > Students Bulk Qualification and Competency Enrolments 

This window provides an easy mechanism for enrolling multiple students into a qualification with 
linked competencies or multiple competencies simultaneously.  It also enables removal of students 
from competencies. Access this window by clicking the Bulk Qualification and Competency 

Enrolments icon.  
 

 
 

  All actions in this window relate to an academic year.  Selecting a new academic 
year in the drop-down list will refresh the qualification offerings list to show the qualification 
offerings, groups and students for the selected year, and clear the selected students and the 
selected qualification lists. 
 

 
 
The roll filter field, by default, displays only Active VET students on the Current, Admissions, 
Former and External rolls.  
 
This option can be changed in VET > System Preferences, to also display both Active and 
Inactive VET students on selected rolls: 
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Students can be selected from the Students Groups and Students tabs.  The Student Groups tab 
displays the VET student groups that have been created.  Click on the Students tab to see a list of 
students on the selected roll. 
 

 
 

The Find VET Student tool  can also be used to select students to display in the Students tab. 
 
The window works by moving selected students and qualifications from the left hand lists 
into the right hand lists.   
 
Clicking Cancel will close the window without making any changes. 
 

You can select multiple students and/or student groups and move them across.    
 

If a group is selected and  is clicked, all the students belonging to that group will be moved into 
the selected students list.   
 
Students and qualifications can be removed from their respective selected lists by 
highlighting the appropriate records and clicking move left. 
 

Adding Qualification/Competency Details in Bulk 

VET > Students > VET Student Detail > Bulk Qualification and Competency Enrolments 

 Highlight required group(s), if any, from the Student Groups pane. 

 Click on the  button to add the students from that group. 
 
The students’ names will be displayed in the selected students list on the right. 
 

 Click on the Students tab. 

 Select (highlight) any other students to be enrolled in the qualification.  
 

(The Find VET student tool can be used to locate specific students.) 

 Click on the  button to add the students. 

 Click on the  button to remove the students. 
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 Click on the qualification or competency group in which the students are to be enrolled. Only 
one qualification or competency group can be added at a time.  

 Use the  button to select the qualification or competency group.  

 Use the  button if you wish to remove the selected qualification or competency group and 
add a different one. 

Note:  In the NT only, it is possible to select Unspecified. 

 
 

 Click  at the bottom right of the window  
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WA Display 

 
 

NT Display 

  
 
The qualification details and attached competencies (if there are any) are automatically populated 
in this window. 
 

 Clicking Back will enable you to reselect students and a qualification or competency group.  

 Clicking Cancel will abort the bulk enrolment process. 
 



 
Integris VET Manual.docx  17-Jul-13 

Page 7-65 

© 2013 Civica Pty Ltd 
 

The enrolment data entered in this window will be recorded against the selected qualification and 
all competencies for all the selected students.  

Qualification Details 

 Enter a start date for the qualification (if any).  
 
The qualification code is displayed for information purposes only and cannot be edited in this 
window. 
 

 
 

 Check Full Qualification Enrolment if required. 

 In Western Australian schools only, select the RTO for the qualification, using the drop-down 
list.  

 

 
 

Competency Details 

 Enter the Competency Start and Completion Dates 

 In the NT only, select the appropriate month for Result Due. 
 

 
 

Industry Area 

Industry Area displays the Industry associated with the Qualification. This is for information 
purposes and cannot be changed. 
 

 
 
If the enrolment is for a Not Specified qualification (NT only) or the qualification is not attached to a 
valid industry code (applies to both NT and WA), the Industry Area group box will appear as 
follows: 
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Competency Status 

This area enables the selection of integrated subjects for the enrolment. To record an integrated 
subject: 
 

 Check Integrated.  

 Click in the Code field and enter a subject code. 

 Alternatively, enter part of the code and <Tab> out.  
 
A list of core subjects matching the partial code will be displayed.  
 

 Select the appropriate subject. 
 

 

Note:  Take care; this indicates that all competencies selected are integrated into this one 
subject. 

If the subject code entered is not a subject preference for some of the selected students, their 
enrolments will be invalid and will be listed as such in the Bulk Student Competency Enrolment 
Status Log when the enrolments are processed. 
 

RTO Delivery 

 Select an RTO from the drop-down list.  
 

 
 
In the NT only, a location linked to that RTO is displayed in the Location field. You can choose a 
different location at this point. 
 

  
 

 Select the Mode from the drop-down menu.  
 

 
 
The drop-down values for RTO mode of delivery are AVETMISS compliant. 
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WA Only 
 

 Select the RTO Arrangement from the drop down menu.  
 

 
 

 Select a Delivery Site Type 
 
The Delivery Type Site determines where the VET course is being delivered. It is a mandatory  
field for new and edited competencies and has the values of: 

 External RTO 

 School 

 Trade Training Centre 
 

 
 
If the Delivery Site Type selected is a Trade Training Centre, then the completed Trade 
Training Centre and the Trade Training Centre Site are mandatory fields and must be selected 
before the user is able to continue to the AVETMISS details. 
 

 Select a Trade Training Centre 
 
The Trade Training Centre field will be greyed out unless ‘Trade Training Centre’ has been 
selected as the Delivery Site Type and won’t be mandatory unless selected. The Trade Training 
Centre refers to the organisation delivering the VET course. 
 

 
 

 Select a Trade Training Centre Site 
 
The Trade Training Centre Site will be disabled and greyed out until a line is chosen from the 
Trade Training Centre list.  Only when this is done will the Site list be enabled and the list of Sites 
will only include those linked to the selected Trade Training Centre.  A value must be set for it to be 
saved. It will be possible to save a competency where both the Trade Training Centre and Trade 
Training Centre Site details are not set. 
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Adding Units of Competency 

 Click Add  to the right of the Selected competencies pane 
 

 
 

 Find the competencies required and click Select 
 
In WA only if the selected competency is not linked to the selected qualification then an error 
message like the one below will be displayed. 
 

 
 

 Click OK 
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Removing Units of Competency  

 Highlight the competencies to be removed 

 Click Delete Competency  
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When all required units of competency for the current enrolment are displayed, 
 

 Click Add 
 

WA Only 

 
 

 Enter Study Reason and, if appropriate, Traineeship Details 

Note:  If enrolling more than one student, do not enter Contract ID here as each student will 
have their own, unique Contract ID. 

 Click Add 
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NT Only 

 
 

 Enter Qualification Commencement ID and National Funding Source 

 Enter any other required information 

Note:  If enrolling more than one student, do not enter Contract ID here as each student will 
have their own, unique Contract ID. 

 Click Add  
 
The Bulk Qualification window will never create a duplicate qualification enrolment.  If a student is 
currently enrolled in the selected qualification, a prompt displays this information and gives the 
user the option to link the selected competencies to that enrolment.   
 

 
 

 Click Yes to proceed or No to cancel the specified competency enrolments for the student.  
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If a student has already completed the qualification, a message is displayed: 
 

 
 

 Click OK. 
 
A status log is generated, advising on the status of each enrolment.  The message displayed in the 
status log can vary from student to student depending on whether the new competency enrolment 
has been processed. 
 

 
 
If a student has no subject preference for the integrated subject selected, the competency 
enrolment will not be made and an error message will be recorded in the status log.  This applies 
to subject preferences either recorded in the Timetable module or to the student’s teaching sets. 
See an example below: 
 

 
 

Note:  There is the option to print the log for future reference.  

 
The bulk enrolment function will not overwrite any existing enrolment information.  For example, if 
one of the selected students already has an enrolment in a unit of competency, this enrolment 
record will remain unchanged.  A new duplicate enrolment record will be added if the new 
enrolment is linked to a different qualification or with a different RTO and the system preferences 
allow for concurrent enrolment in the same competency with a different RTO. 
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Removing Competency Enrolments in Bulk 

VET > Students > VET Student Detail > Bulk Qualification and Competency Enrolments 

By default, this window is in Add mode to enable enrolment in qualification/competencies 
enrolments. The window can also be used to remove (delete) competency enrolments. 
 

 Click Switch to removal mode   at the top of the window.  
 
The Student VET groups and the competency groups and competencies on offer are displayed. 

WA Display 

 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 7-74 

© 2013 Civica Pty Ltd 
 

 

NT Display 

 
 
In Removal mode, it is possible to remove selected competencies from selected students provided 
that their competency enrolments have not been resulted and their competency enrolments do not 
belong to a completed qualification.  If either of these conditions applies then this would be 
displayed in the Status Log.   

Note: Competency enrolments should only be removed if added in error.  If students 
withdraw from units of competencies this should be noted in the Results field of the 
competency enrolment window. 

 

Remove multiple competencies from multiple students: 

 Select the appropriate groups or students and competencies from the left hand lists. 

 Move them into the right  

 Click Remove. 
 
A prompt will ask you to confirm that the competency enrolments are to be deleted, as shown 
below. 
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 Click Yes. 
 
The status log window will then be displayed with details of any action taken: 
 

 
 
In Western Australia, a check-box in the Bulk Qualification and Competency Enrolment window 
enables you to bulk remove any qualification enrolments that have no competency enrolments.   
 

 

Note: The check-box defaults to being un-ticked. 

(In the Northern Territory, removing competencies does not remove the qualifications they are 
linked to – these would have to be deleted in VET > Students > Enrolments.) 
 
If the check-box in is ticked, qualification enrolments that have no competencies linked to them are 
removed when the competencies are removed. 
 
When the removal process is complete a Bulk Student competency Deletion Status Log will be 
displayed, as in the example below. 
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The log may be printed for future reference.  

Removing Competency Enrolments in Bulk and Cut-off Dates (WA only) 

See section 5.4 Enrolment Cut-off Date Active for details on cut-off dates. 

If both cut-off dates are in effect, then a red message is displayed at the top of the Bulk 
Qualification & Competency Enrolment window as illustrated in the example below.  The Bin icon is 
also disabled and so no enrolment can be removed. 

 

Alternatively, if one cut-off date only is in effect, then the Bulk Qualification & Competency 
Enrolment window permits you to enter Removal Mode, however, enrolments cannot be removed 
for students in the relevant year group. 

For example, the Cut-off date settings are as per the figure below, and the current date is 7 June 
2012. 

 

As the ‘Year 12 Enrolment cut-off date active’ box is ticked and the current date (7 June 2012) is 
later than the ‘Cut-Off Date’ (3 June 2012), the year 12 cut-off date (only) is in effect. 
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The Bulk Enrolment window Add Mode operates as normal.  However, if you click the Bin icon, a 
message is displayed as follows: 

 

Upon clicking the OK button, the system displays the Bulk Qualification & Competency Enrolment 
window in Delete Mode.  If you then click the Students tab, you will see that Year 12 students have 
been removed from the list. 

 

Note:  In this scenario, all Student Groups will be displayed in the Student Groups list, but 
upon clicking the red arrows only appropriate students will be displayed in the ‘Selected 
students’ list. 

Adding Temporary Competency Enrolments in Bulk (NT only) 

VET > Students > VET Student Detail > Bulk Qualification and Competency Enrolments 

There may be instances when a school wishes to offer a unit of competency that is not currently on 
the Master Competency file.  While approval to offer this competency is being sought, a temporary 
competency enrolment may be entered provided this option has been checked in VET > Control > 
System Preferences.  (See Section 5.7 for details.) 
 
Temporary units of competency may be added to VET School Offerings when enrolling a single 
student in a temporary unit of competency or when enrolling a group of students in a temporary 
unit of competency in Bulk Enrolment. 
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To add temporary competency enrolments in bulk: 

 Click on Bulk Qualification and Competency Enrolments  in VET Student List toolbar. 

 Select the students you wish to enrol in the temporary competency and move them to the right-

hand pane by clicking  
 

 Select the qualification to which the competencies are to be linked.  
 
In the Northern Territory, there is the option to select ‘Unspecified’ in the qualification offerings list. 
This can be used in instances where temporary competencies are not to be linked to a 
qualification. 
 

 Click Add. 

 Click the Add Temporary Competency button.  

 Enter a code and name for the temporary competency and click OK. 
 

 
 

 Click Yes and OK. 

 Enter the Delivery and AVETMISS details 

 Click Add. Continue with the enrolment process. 
 

 
 
The enrolment status log above will confirm the bulk enrolment.  
 

Results Entry 

Results can be entered individually or in bulk. 
 

Entering Results for Unit of Competency 

VET > Students > VET Student Detail>Enrolments 

 
Results for individual students may be entered in the VET Student Details window, shown below 
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 Highlight the competency for which you wish to enter a result and click the Edit button to the 
right of the Competency pane.  The VET – Competency Enrolment window will open. 

  



 
Integris VET Manual.docx  17-Jul-13 

Page 7-80 

© 2013 Civica Pty Ltd 
 

WA Display 

 
 

NT Display 

 
 

 Enter a result from the drop-down menu  

 Select a teacher’s name  
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The options within the results drop-down list are AVETMISS compliant and can be added as 
parameters to the system.  The values within this list comply with the AVETMISS standard, these 
being: 
 
20 Competency achieved/pass 
30 Competency not achieved/fail 
40 Withdrawn 
51 Recognition of Prior Learning – granted 
52 Recognition of Prior Learning – not granted 
60 Credit Transfer 
70 Continuing enrolment 
90 Not yet available 
99 Has is not expected to start this UoC 

Also available in the NT  

53 Recognition of Current competency – granted 
54 Recognition of Current competency – not granted 
81 Non-assessable enrolment - Satisfactorily completed 
82 Non-assessable enrolment - Withdrawn or not satisfactorily completed 
 
The system enforces a competency completion date; this may be edited if required.  
 

 
 

 Click OK to save. 
 

Entering Results for a Qualification 

VET > Students > VET Student Detail > Enrolments 

 
Results for individual students are entered in the VET Student Details window. A qualification may 
be given a completion date and a certificate number. 
 

 Highlight the qualification you wish to edit.  

 Click the Edit button  to the right of the Qualification pane. 
 
The following window will be displayed. 
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WA Display 

 
 

NT Display 

 
 

 Enter a Completion Date.  

 (WA 0nly) Check Qualification Achieved 
 

Note:  In WA the record will not be saved unless both a Completion Date is entered and 
Qualification Achieved is checked. 

Unless the school is an RTO, the Certificate Identifier field will become available.  
 

 Enter the certificate number and click OK to save. 
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7.4 VET Competency Enrolment Speed Edit 

VET > Students > Speed Edit 

This function is accessed by clicking VET Competency Enrolment Speed Edit  in the VET- 
Student List toolbar. 
 
The following is speed edit window for WA. 
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The following is speed edit window for NT. 
 

 
 

  Academic Year drop-down list.  All actions in this window relate to an academic 
year.  Selecting a new academic year in the drop-down list will clear the window and the 
competencies list will be refreshed to show the competency offerings and competency groups for 
the selected year.  The student lists will be cleared. 
 

The Competency Find Tool can be used to select a subset of competency offerings for the 
year.  Clicking on a competency in the list will display the students enrolled in that competency for 
the year according to the filter selected.   
 

In WA, the following may be edited in bulk. 
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Note:  RTO may not be edited after the enrolment cut-off date. 

 

In the NT, the following may be edited in bulk. 

 
 

Bulk Student Results Entry 

VET > Students > VET Competency Enrolment Speed Edit 

The VET Competency Enrolment Speed Edit window allows for results against a competency or 
student to be entered for multiple students or competencies, respectively, simultaneously.  

The Competency Find tool  can be used to select a subset of competency offerings for the 
year. 
 
Clicking on a competency in the list will display the students enrolled in that competency for the 
year according to the filter selected.   
 

  Show students with no result will only display those students who do 
not have a result entered for the selected competency.  Show All will show all the students 
enrolled in the competency for the year.  Any students with a result will have the result displayed in 
the Results column. 
 

 Highlight the required competency.  
 
The students enrolled in that competency will be displayed. 
 

 Use the horizontal scroll bar to view all fields of information stored for each enrolment. 

 Click Edit.  

 Highlight the names of the students to be assigned a result.  

 Select a result from the Outcome Assessment dropdown list. 

 Select a Moderating Teacher from the drop down list. 

 Enter a Completion Date. 

 Click the Apply Changes button.   
 
The result and any other data changes will be displayed next to the selected enrolments in the 
appropriate columns. 
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Note: The result data is not saved at this stage; it is simply added to the list for reference. 

 Click the OK button to save the result data, or click Cancel to abort all the changes made. 
 

 Repeat the above, adding the appropriate results to each of the competencies. 
 
You will be presented with this message when results are updated. 
 

 
 

Vet Competency Enrolment Speed Edit  

VET > Students > VET Student Detail >Vet Competency Enrolment Speed Edit 

The remaining fields will only need editing if the existing data stored for the selected students and 
competencies is blank or incorrect. 

Note:  In WA, the RTO for a competency enrolment may not be edited after the enrolment 
cut-off date has passed.  

 Highlight the required competencies and students.  

 Use the horizontal scroll bar to view all fields of information stored for each enrolment. 
 

 Click on Edit.   
 
Fields not required may be left blank.  The only exception to this rule is the Sent to SSABSA flag 
and VET in Schools flag.  Enrolment records for these fields can only be flagged as ‘Y’ or ‘N’.  
There is no ability to set to a blank value.  The Sent to SSABSA Flag applies only to the Northern 
Territory 
 
The Competency Enrolment – Speed Edit window provides access to the Student Competency 
Results Report that lists students enrolled in competencies. This report prints the selected 
competency for a specific year and all the students enrolled in it. 
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To print the report 

 Select the year.  

 Click Print Results.  

 Select the report destination 
 

 
 
The report is also available in VET > Reports > Competency Reporting > Student Results. 
 

Student Results Report by Competency – All Competencies 

VET > Students > VET Student Detail >Vet Competency Enrolment Speed Edit 

The Competency Enrolment – Speed Edit window provides access to the Student Competency 
Results Report - All Competencies that lists students enrolled in competencies for the selected 
year. This is similar to the Student Results Report but lists all competencies with enrolments for the 
selected year where there is no result and/or competency end date. Each competency is printed on 
a separate page. 
 

To print the report 

 Select the year.  

 Click the Print All button  on the toolbar. 

 Select the report destination. 
 

 
 
This report is also available in VET > Reports > Competency Reporting > Student Results. 
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8 Employer Maintenance 

 

VET > Employers 

Employer maintenance is undertaken using two employer windows: a list window displaying all 
employers on the system, and a details window with specific detail about an employer. 
 
The VET module is set-up so that clicking the Employer icon in the sidebar will open the Employer 
List window.  Double-clicking a specific employer record in the list window will open the Employer 
Details window with the employer’s information.  This process can be changed by selecting the 
‘Open student/employer windows in detail mode rather than list’ in Control>System Preferences.  
Setting this option will bypass the Employer List window and open the Employer Details window 
when the Employer icon is clicked in the sidebar.  This option will affect the student list/detail 
window behaviour in exactly the same way.  
 

8.1 Employer List Window 

VET > Employers 

The Employer List window provides an efficient method of viewing all the employers on the system. 
 

 
 
The information displayed with respect to each employer is 
 

 Employer Name: the full employer name 

 Contact Person: the designated contact person for the employer 

 Suburb: the address suburb for the employer 

 Intake: the maximum number of students the employer is willing to take on work placement 

 Active: ‘Yes’ indicates the employer is active, and a ‘No’ indicates the employer is inactive  
 
The employer list can be sorted by clicking on any list column header.  For example, to find all the 
employers in a specific suburb click on the ‘Suburb’ header.  The list will be sorted and all 
employers with like suburbs grouped together. 
 

 Opens Employer Details for the selected employer(s).  Double clicking on a single employer 
record will also open the Employer Details window. 

 Deletes the selected Employer/s.  Employers can only be deleted if they do not have any 
student placements. 

 Toggle the employer active/inactive status. 

 Prints the details of the selected employers, including the employer’s mobile number. 

 Prints the details of all the employers in the list, including their mobile numbers. 
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8.1.1 Filtering the List of Employers 

VET > Employers 

 
The Employer list can be filtered to show Active, In-Active or All Employers. 
This is done by selecting the appropriate option in the toolbar.   

Alternatively, the Employer Find tool button  can be used to select 
employers meeting a range of criteria.  
 

8.1.2 Viewing  

VET > Employers > Employer Details 

The details for a specific employer can be viewed by selecting the appropriate employer in the list 
and clicking the ‘Open Details’ button on the toolbar.  This will open the Employer Details 
window and display the employer selected.  Alternatively, you can double click the employer 
record in the list to view that employer’s details.  If more than one employer is selected and the 
Open Details button is clicked, the list of selected employers will become the browse set for the 
Employer Details window.  
 
Once the Employer Details window is open, you can move it to one side so that the Employer list 
window is not completely obscured.  Click on any employer in the Employer List window, and that 
employer’s details will appear in the Details window.  Also, select more than one employer record 
in the list window and all the selected employers will be transferred to the Details window as the 
new browse set.  You can then click on the Next and Previous buttons in the Details window to 
view each employer’s details. 
 

8.1.3 Deleting Employers 

VET > Employers 

Employers can be deleted by selecting them in the list and clicking the Delete button  on the 
toolbar.   
 
An employer can only be deleted if they have no student placements.  An alternative to deleting an 
employer is to make the employer inactive, by selecting the employer(s) and clicking Toggle Active 

Status  on the toolbar.   This makes all selected active employers inactive and all selected 
inactive employers active.  
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8.2 Employer Details 

VET > Employers > Employer Details 

The Employer Details window contains three tabs: Employer Details, Student Placements and 
Correspondence. 
 

8.2.1 Employer Details  

The Employer Details tab pane contains the employer demographic information and the 
Vocation/Job Types for the employer.   
 
‘Employer Details’ window for WA will have the Address Pane 
 

 
 
‘Employer Details’ window for NT will not have the Address Pane 
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8.2.2 Employer Details Toolbar 

 A grey button indicates that the browse set is empty.  A red button indicates the browse set 
contains data. 

 View previous employer.  

 View next employer. 

 Search for a specific employer or group of employers.  Selecting a group of employers will 
enable the window browse set. 

 Add a new employer to the database. 

 Edit the employer details. 

 Print the data, which, depends on the tab pane being viewed at the time. 
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8.2.3 Adding, Editing and Deleting Employer Details 

Adding employers 

VET > Employers 

Click the Add  button in the top toolbar.  The following window will open. 
 

‘VET – Employer Details’ window for WA 
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‘VET – Employer Details’ window for NT 

 
 

 Enter the required data for the employer details tab pane and click OK.  The following message 
will then appear asking if you wish to enter any vocation/job types at this time: 

 

 
 

 Click No, and the employer details will be saved without any vocation/job type details.   

 Click Yes, and the following window will open for the input of vocation/job type data: 
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 Enter the required details. 

 Click the OK button to save the Vocation/Job Type. 

 Click OK again to save the employer’s details. 
 
The employer details will be saved and the Employer Details window placed into browse mode.  It 
is now possible to add student placement data and correspondence data for the new record by 

clicking the Edit button  in the toolbar. 

Editing an employer’s details 

VET > Employers > Employer Details 

 Click Edit  in the toolbar to modify the employer’s details.  This will place the window into 
Edit mode, and all the employer details can be modified, including those in the Student 
Placements tab pane and the Correspondence tab pane.  

Employer keywords 

VET > Employers > Employer Details 

The employer keywords are used to search for employers that your defined criteria.  For example, 
a common requirement when allocating work placements is to ensure that there is public transport 
to the employer’s location.  Entering a keyword phrase something like ‘public transport’ or ‘train’, 
will allow for a search of employers against these keywords.  There is also the provision to allocate 
students keywords.  Taking the above example a step further, the keyword can be allocated to the 
student, and then this can be used to locate employers with a matching keyword.   
 

Adding, editing and deleting employer vocation/job types 

VET > Employers > Employer Details 

The first vocation/job type can be entered when first adding a new employer to the system.  
Additional vocation/job types can be added by: 
 

 Click Edit  in the toolbar. 

 Click Add  alongside the vocation/job type list.  This will open the VET Add/Edit 
Vocation/Job Type window shown below. 

 

 
 

 Enter the appropriate details and click the OK button. 
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Follow the same procedure to edit an existing vocation/job type, but this time select the record to 
be edited and click the Edit button instead of the Add button.  The VET Add/Edit Vocation/Job Type 
window will open with the selected record’s data.  Modify the data as required, and click OK.  
 

To delete a vocation/job type record 

 Select the record in the list. 

 Click the Delete button.  You will be prompted to confirm the delete. 

 Click OK.  The record will be deleted from the employer.  
 

8.2.4 Student Placements 

VET > Employers > Employer Details > Student Placements 

 
 
The Student Placements tab pane shows the work placement history for the employer.  The list will 
include a complete history unless the View Current/Future Only option is selected.  Clicking this 
option will remove completed work placement records. 
 
The work placement history list shows summary placement information only.  The full details can 
be viewed in the Student Details window.  (See Section 7.2.12) 
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8.2.5 Adding, Editing and Deleting Student Placement Details 

VET > Employers > Employer Details > Student Placements 

Student placements details are shown in the Student Placements tab.  The tab pane will initially 
show all student placement records for the employer.  To restrict this to those students currently on 
placement or due for placement in the future, click the Current/Future Only checkbox. 
 

 
 
It is also possible to add, edit and delete student placements from within the Employer Details 
window.   

Adding a student placement record 

VET > Employers > Employer Details > Student Placements 

 

 Locate the required employer, and bring up the details in the Employer Details window. 

 Click on the Student Placements tab. 

 Click the Edit button in the toolbar. 

 Click the Add button alongside the student placements list.  This will open the VET – 
Placement Details window.   
 

 
 

 Enter the required details and click OK.  The work placement record will be created, and you 
will be returned to the Employer Details window. 
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 Save the new placement data by clicking the OK button, or discarding the changes by clicking 
the Cancel button. 

Editing a work placement record 

VET > Employers > Employer Details > Student Placements 

 Locate the required employer, and bring up the details in the Employer Details window. 

 Click on the Student Placements tab. 

 Click Edit  in the toolbar. 

 Click on the placement record to be edited. 

 Click Edit  alongside the student placements list.  This will open the VET Placement Details 
window shown above.  Modify the placement details as required, and click the OK button. 

 Save the new placement data by clicking OK, or discard the changes by clicking Cancel.  

Note: The attendance details cannot be edited from within this window.  

 Attendance details for an existing placement record can only be edited from the Student Details 
window from within the Attendance list.  Please see Section 7.2.12 for details on how to add, edit 
and delete placement attendance dates 

Deleting a work placement record 

VET > Employers > Employer Details > Student Placements 

 
Work placement records that have not begun (that is, the placement start date is after today’s date) 
can be deleted from this window.  The following message will be displayed if you attempt to delete 
a placement record that has begun: 
 

 
 
Placement records that have begun can only be deleted from the Student Details window.   

Deleting a Placement Record that has not begun 

VET > Employers > Employer Details > Student Placements 

 

 Locate the required employer, and bring up their details in the Employer Details window. 

 Click on the Student Placements tab pane. 

 Click on Edit  in the toolbar.  

 Click on the placement record to be deleted. 

 Click Delete  alongside the student placements list.  The placement record will be removed 
from the list.   

 Confirm the deletion by clicking OK, or discard the changes by clicking Cancel. 
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8.2.6 Employer Correspondence 

VET > Employers > Employer Details > Correspondence 

 
 
The Correspondence pane contains a log of correspondence sent to the employer.  Many of the 
standard employer letters generated by the system will automatically put an entry into the log.  You 
can also manually add, edit and delete a log entry by clicking the appropriate button alongside the 
list.  
 

 Click on Edit Employer  in the top toolbar to activate these options. 

 Adding employer correspondence 
 

VET > Employers > Employer Details > Correspondence 

 Click on Add Correspondence.  

 Enter the appropriate date and note in the prompt shown below. 
 

 
 

 Click OK to save.  

 Editing employer correspondence 

 VET > Employers > Employer Details > Correspondence 

 Select the record you wish to edit. 

 Click on Edit Correspondence.  

 Change details as required in the prompt below.  
 

 
 

 Click OK to save  
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Deleting employer correspondence 

VET > Employers > Employer Details > Correspondence 

 

 Select the record you wish to delete. 

 Click on Delete Correspondence . 

 Confirm that you wish to delete the correspondence. 
 

 
 

 Click OK 
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9 Placement 

 

VET > Placement 

 
Clicking the Placement icon on the sidebar will open the VET – Student Placements window.  This 
window serves two purposes: 
 

 Provides the ability to allocate multiple students on placement with the same employer at the 
same time. 

 Brings together the student and employer information on the same window so that the details 
of one can be compared to the other and an informed decision made about allocating a work 
placement to a student. 

 

‘VET – Student Placement’ window for WA 
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‘VET – Student Placement’ window for NT 

 
 
 
Above is a screenshot of the VET – Student Placements window. The left side contains information 
about students, and the right contains information about employers.  At the top are lists, and at the 
bottom a range of detailed information.  Clicking on an item in the list shows the information for that 
item in the details area.  This information is provided in a range of tab panes and is read only.   
The window will initially display all active VET students on the Current Roll and all active 
employers.   
 

However, these lists can be filtered by using the Find Tool button  alongside each list.  
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9.1 Adding a work placement record 

VET > Placement 

Select one or more students in the student list.  If more than one student is selected, an identical 
work placement record will be created for each student. 
Select the desired employer in the list. 
 
Click the Add button to open the VET Student Placement Detail window, shown below, where the 
placement data can be entered.  The banner at the top of this window indicates the number of 
placements records to be created (for example, ‘Bulk placement for 5 student(s).   
 

 
 
The VET Student Placement Details window can link a qualification to a work placement.  This can 
be problematic when creating placement records for multiple students because the students might 
not have a common qualification that can be tagged to each placement record.  If this is the case, 
the following message will be displayed before the VET Student Placement Details window is 
opened: 
 

 
 
This message indicates that the qualification drop-down list field in the window will not be 
populated.  This is an optional field and does not impact the processing of the placement record.  If 
a qualification must be tagged to each placement, this will have to be done from the Student 
Details window after the bulk placement allocation is completed. 
 

 Enter the details as required in the VET Student Placement Details window and click the OK 
button.  The placement records will be created and control returned to the VET – Student 
Placement window. 
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9.2 Sending Letters to Students and Employers (WA only) 

9.2.1 Sending Letters Using KST Templates 

Sending Letters to a Single Student  

 Select a student  

 Click Send letter  

 Entered the required date range 

 Select Send letter/s to “Word” using a “.kst” template 

 Enter a Correspondence note if required (this note will be displayed in the student 
correspondence log) 

 

 
 

 Click OK 

 Browse to …\KEYS\INTEGRIS\MMTPL\LETTERS\VET directory and locate the KST template 
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Integris will create a word document from the selected KST template 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 9-7 

© 2013 Civica Pty Ltd 
 

 

Mr and Mrs Angus 
16 Camargue Green 
LEEDERVILLE 6010 

 
 

Dear Mr and Mrs Angus 

 
 
WORKPLACE LEARNING (UNPAID) – INSURANCE COVER for: Sally Angus 
Placement with: Hungry Jacks 
Placement Dates: 6 FEB 2013 to 17 FEB 2013 
 
The Department of Education (the Department) provides personal accident insurance and public 
liability insurance through RiskCover for students engaged in unpaid work placements allocated or 
arranged by the Department. 
 
The insurance covers, subject to certain conditions, the ‘gap’ costs over and above what is paid by 
Medicare or the student’s private health insurance for a student’s medical expenses, including 
dental, ambulance charges and surgical appliances. The insurance also covers direct travel 
between home and the workplace learning placement site.  
 
The Department of Education’s insurance does not cover accidental damage caused by the 
student unless negligence on the part of the student can be demonstrated. 
 
In the event of a workplace learning accident, the student will be asked to complete a workplace 
learning personal accident insurance claim form – available from: 
www.icwa.wa.gov.au/rc/forms/personalaccidentclaimform.pdf.  This form must be completed and 
forwarded to the school principal. 
 
In the first instance when making a workplace learning accident insurance claim, medical bills 
should be claimed through Medicare or your private health insurance.  In the event that 
reimbursement is required Medicare statements, private health insurer remittance and doctor’s and 
chemist’s receipts, where applicable, are to be forwarded to:  
 
Specialist Claims Team 
RiskCover 
GPO Box K 837  
PERTH WA 6842 
 
On approving the claim, RiskCover will send a cheque covering the difference between the 
Medicare/private health insurance cover and the total cost of the bills. 
 
Yours sincerely 
 
 
 
Lainey Abbott 
Workplace Learning Coordinator 
 
17 July 2013 
 
Attachments 
Workplace details, Consent Form 

 

http://www.icwa.wa.gov.au/rc/forms/personalaccidentclaimform.pdf
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Sending Letters to a Single Employer 

 Select an employer 

 Click Send letter  

 Entered the required date range 

 Select Send letter/s to “Word” using a “.kst” template 

 Enter a Correspondence note if required (this note will be displayed in the employer 
correspondence log) 

 

 
 

 Click OK 

 Browse to …\KEYS\INTEGRIS\MMTPL\LETTERS\VET directory and locate the KST template 
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Integris will create a word document from the selected KST template 
 

 
Hungry Jacks 
Hay St 
Perth Western Australia 6000 

INSURANCE LETTER FOR WORKPLACE SUPERVISOR 

Dear Mr Mack 

Re: Work Placement for: Sally Angus 

The Department of Education provides insurance cover for the duration of the student workplace learning 
placement.  This insurance cover applies to students who are on unpaid work placement, when arranged or 
allocated by the school only.  It covers, subject to certain conditions, the student’s medical expenses, 
including dental, ambulance charges and surgical appliances over and above what may be payable by 
Medicare or the student’s private medical health insurance. 

Employers (and self-employed persons) have a legal responsibility to ensure that their work and the work of 
their employees do not adversely affect the safety and health of non-employees, including any students 
undertaking work placement.  The employer must take the necessary action to protect the safety and health 
of these students.  This may include showing them how to work safely, ensuring the workplace is safe, 
ensuring reasonable care is taken not to expose students to hazardous situations, and providing appropriate 
supervision. 

Accident Procedure 

If an accident occurs involving a student on work placement, then: 

1. normal arrangements for medical assistance must be made immediately.  It is preferable to have the 
student attend a public hospital.  NB: Students are not workers’ compensation patients and should not be 
treated as such by the doctor; 

2. employers should notify parents and the school immediately; and 

3. a medical certificate must be issued by the doctor attending the student. 

Public Liability insurance arrangements 

The Department of Education is a State Government agency and as such is subject to the policies and 
directives of the Western Australian Government. 

The Department’s insurance coverage is placed with the Western Australian Government’s self-insurance 
managed Fund – RiskCover. The Department of Education provides both personal accident insurance and 
public liability insurance for students engaged in unpaid work placements allocated or arranged by the 
Department’s schools. 

It is a requirement of the Department of Education that a business accepting students on workplace learning 
has in place its own Public Liability insurance to a minimum of $5 000 000 for any one occurrence. 

RiskCover will manage claims on behalf of the Department, as required, in accordance with agreed 
arrangements. 

The Department of Education’s insurance policy does NOT cover accidental damage caused by the student 
unless negligence on the part of the student can be demonstrated. 

Should you have any further queries please do not hesitate to contact me.   

Yours faithfully 

__________________________ 

Workplace learning coordinator 

Date_____________________ 

 

cc: Parent/guardian   Encl.: Insurance acknowledgment form 
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Sending Letters to Multiple Students  

 Highlight some or all of students in the list and click Select 
OR 

 Click Find  

 Enter the required search criteria and click Find 

 Highlight some or all of students in the list and click Select 
 

 Click Send letter  

 Select Create letters for all selected 

 Enter the required date range 

 Select Send letter/s to “Word” using a “.kst” template  

 Enter a Correspondence note if required (this note will be displayed in the student 
correspondence logs) 

 

 
 

 Browse to …\KEYS\INTEGRIS\MMTPL\LETTERS\VET directory and locate the KST template 
 
Integris will create a word document from the selected KST template.   
 

Sending Letters to Multiple Employers  

 Click Find  

 Enter the required search criteria and click Find 

 Highlight some or all of students in the list and click Select 
 

 Click Send letter  

 Select Create letters for all selections in the browse set 

 Enter the required date range 

 Select Send letter/s to “Word” using a “.kst” template  

 Enter a Correspondence note if required (this note will be displayed in the student 
correspondence logs) 
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 Browse to …\KEYS\INTEGRIS\MMTPL\LETTERS\VET directory and locate the KST template 
 
Integris will create a word document from the selected KST template.   
 

9.2.2 Sending Letters Using CSV Files 

Sending Letters to a Single Student  

 Select a student  

 Click Send letter  

 Enter the required date range 

 Select Produce a CSV file for use in a subsequent mail-merge 

 Enter a Correspondence note if required (this will be displayed in the student correspondence 
log) 

 

 
 

 Enter a name and select a location for the file 
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 Click Save 
 

 
 

 Click OK 
 
The CSV file will contain placement information for the selected student. 
 

 
 

Sending Letters to a Single Employer  

 Select an employer  

 Click Send letter  

 Enter the required date range 

 Select Produce a CSV file for use in a subsequent mail-merge 

 Enter a Correspondence note if required (this will be displayed in the employer 
correspondence log) 
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 Enter a name and select a location for the file 
 

 
 

 Click Save 
 

 
 

 Click OK 
 
The CSV file will contain placement information for the selected employer. 
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Sending Letters to Multiple Students  

 Highlight some or all of students in the list and click Select 
OR 

 Click Find  

 Enter the required search criteria and click Find 

 Highlight some or all of students or employers in the list and click Select 
 

 Click Send letter  

 Select Create letters for all selections in the browse set 

 Enter the required date range 

 Select Produce a CSV file for use in a subsequent mail-merge 

 Enter a Correspondence note if required (this note will be displayed in the student 
correspondence logs) 

 

   
 

 Click OK 
 

 Enter a name and select a location for the file 
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 Click Save 
 

  
 

 Click OK 
 
The CSV file will contain placement information for the selected students. 
 
 
 

Sending Letters to Employers 

 Click Find  

 Enter the required search criteria and click Find 

 Highlight some or all employers in the list and click Select 

 Click Send letter  

 Select Create letters for all selections in the browse set 

 Enter the required date range 

 Select Produce a CSV file for use in a subsequent mail-merge  

 Enter a Correspondence note if required (this note will be displayed in the employer 
correspondence logs) 
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 Click OK 
 

 Enter a name and select a location for the file 
 

 
 

 Click Save 
 

 
 

 Click OK 
 
The CSV file will contain placement information for the selected employers. 
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10 Miscellaneous Windows 

10.1 VET Student Find 

The Find VET Student tool  operates in a similar manner as the standard Integris Student Find 
tool, but is restricted to searching for VET students.  You can enter a range of search criteria and 
then click the Find button to retrieve all the records that match the criteria.  If there is just one 
matching record, that record is automatically selected, the window closed and you’re returned to 
the window with the matching student details.  If there is more than one matching record, the list of 
matching records is displayed.  The user can then select one or more of the displayed records to 
become the browse set. 
 

 
 
The VET - Student Find window contains two tab panes that work independently of each other.  
The General tab pane locates students that meet a range of general student parameters.  The 
Teaching Set tab pane locates students in teaching sets.  It is not possible to search for students 
matching the criteria across two tab panes. 
 
The search fields in the General tab pane are: 
 
Surname/Ref 
No 

This field can be used to enter a student surname or a student reference number.  
Every student has a unique reference number, so, if you enter a reference 
number, the student matching this reference number is located and all other 
criteria are ignored.  You can enter the first few letters of the surname, and the 
Find tool will locate the students that match this partial surname.    For example, 
entering the letters ‘BA’ will locate students with the surname ‘Barnes’ and 
‘Barrow’, but it will ignore ‘Cabano’ or ‘Dunbar’. 

First Name This field works in the same manner as the Surname field.  For example, entering 
the letter ‘S’ in this field will locate ‘Susan’, ‘Sean’ and ‘Sharon’, but not ‘Cassy’ or 
‘Kris’. 

 
Preferred 
Name 

This field works in the same manner as the First Name field. For example, entering 
the letter ‘S’ in this field will locate students with the preferred name of ‘Susan’, 
‘Sean’ and ‘Sharon’, but not ‘Cassy’ or ‘Kris’. 

Legal 
Surname 

Locates students with a legal surname matching the criteria entered.   

Roll Status A drop-down list of the various Integris roll status options. The window will default 
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to the ‘Current’ roll.  Select the desired roll status, or select ‘n/s’ (Not Specified) to 
ignore roll status in the search. 

Context The options available are ‘Enrolling’, ‘Non Enrolling’ and ‘--n/s--’ (Not Specified). 
Year Group The Year Group drop-down list contains all the defined year groups for the school.  

Select the desired year group or select the ‘--n/s--’ (not specified) for the search to 
ignore year group. 

Student 
Group 

The Student Group drop-down list will contain a list of all the VET student groups 
(not to be confused with the general student groups within other areas of Integris).  
Select the desired Student Group in the list, or select the ‘--n/s--’ (Not Specified) 
option for the search to ignore student groups. 

Vocation Displays the list of Vocation/Job Types.  Select an entry in the list or the ‘--n/s--’ 
(Not Specified) option for the search to ignore vocation. 

Offerings This field allow for the search of students enrolled in qualifications and 
competencies.  Select a school year from the dropdown list.  The Qualification and 
Competencies lists will then be populated with the respective offerings for that 
year.  Select the desired qualification and/or competency, or the ‘--n/s--’ option to 
ignore these parameters. 

 
If multiple parameters are entered, for example, Surname of ‘A’ and Year Group of ‘11’, the find 
tool will locate those students that meet all the criteria - that is students with a surname beginning 
with ‘A’ who are in Year 11.  
 
The search fields in the T sets tab pane differ slightly depending on whether the Timetabling 
module is installed, and are shown below. 
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Without the Timetabling module loaded 
 

 
 
With the Timetabling module loaded 
 

 
 
To retrieve a list of students matching the criteria entered, start at the top of the window and work 
your way down selecting each option in turn.  Selecting an option will populate the option below it 
with the appropriate options.  For example, selecting Year 2005 will populate the Grid option with 
all the year 2005 Grids.  Selecting a Grid will populate the Schedule option with all the valid 
Schedules for the Grid, and so on. 
 
Having selected all the required options, click the Go button to retrieve a list of all the teaching sets 
matching the criteria entered.  Highlight the required teaching sets and click the Find button.  This 
will retrieve all the VET students in all the selected teaching sets. 
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10.1.1 Saving and Retrieving Student Find Queries 

The VET Student Find tool  enables you to save a particular query.  Saved queries can be 
recalled instead of having to re-enter the search parameters.  In addition, saved queries appear in 
other parts of the system and can be selected directly without having to use the VET Student Find 
tool. 

Saving a query 

 Enter the required search criteria. 

 Click the Save button  in the toolbar. 

 The following window will appear asking a new query name. Enter a unique name and click the 
OK button.  
 

 
 
The query will be saved and control returned to the Find window.  If you click the Save button a 
second time the message below will be displayed. 
 

 
 

 Click Yes to update the existing query, No to save a new query, or Cancel to return to the 
Student Find tool. 

 
All queries saved are tagged against the user who created them.  It is then possible to retrieve the 
queries created by you, or by everyone on the system. 

To retrieve a saved query 

 Click on Find VET Student.  

 Click on View the Query List.  This will open the Student Search Query List, as shown 
below. At the top of the window is the option to view the queries saved by you (the ADMIN user 
in the example above), or to view the queries saved by everyone. 
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 Select the required query in the list and click the Load button.  The find tool window will switch 
back to parameter entry view and all the fields will be populated with values from the query. 
Clicking the Back button will return to the parameter entry view without retrieving the query. 
Clicking Close will close the find tool window. 

 

Deleting a saved query 

 Open the VET Student Find tool. 

 Click the Retrieve button  in the toolbar. This will open the Student Search Query List, as 
below. At the top of the window is the option to view the queries saved by you (the ADMIN user 
in the example above), or to view the queries saved by everyone. 

 

 
 

 Click on the required query in the list and click the Delete button.  The query will be deleted and 
removed from the list.  Click the Back button to return to the parameter entry view. 
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10.2 Competency Find 

The VET Competency Find window locates competencies on offer in a specified year and operates 
in the same manner as other Integris find tools.  The year displayed in the field is determined by 
the start date of the competency enrolment. A range of parameters can be entered, and the Find 
tool will identify all the competencies that match these parameters.  If only one matching record is 
found, the window is closed down and the matching record returned.  If there is more than one 
matching record, the list of matching records is displayed, and you’re given the option to select one 
or all of the items in the list.  
 

 
 
The search fields for the Competency find tool are: 
Code Enter the completion code or part of the code to retrieve matching records.  

This matches the text entered against the beginning of the competency code.  
For example, entering ‘10’ will match against competency code 1087, 1001 
and 10987, but not 91034 or A108BCD. 

Name Enter the Competency name to search for, and the Find tool will locate any 
competency with the entered text anywhere in the name.  For example, if you 
enter the text ‘SYS’, the search will locate any competency with the letters 
‘SYS’ anywhere in the title. 

Field of 
Education 

A drop-down list of all the defined fields of education.  Select an item in the list, 
or select the ‘--n/s--’ option to ignore this parameter. 

Competency 
Group 

A drop-down list of all the competency groups defined.  Select an item in the 
list, or select the ‘--n/s--’option to ignore this parameter. 

Qualification Use this search field if you want to quickly find competencies on offer linked to 
a particular qualification on offer.  Enter the Qualification Code, or click the 
Qualification Find button to display the Qualification Find window.    

 
Enter the search criteria required and click the Find button to retrieve all the competencies that 
match the criteria.  The following message will appear if no matching competencies can be found: 
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If there is one matching record, the Find window will close, and the matching record returned.  If 
there are multiple matching records, the Find tool window will switch into list view mode, shown 
below. 
 

 
 

 Highlight the required records in the list and click the Select button.  If you require all the 
records in the list, click the Select button without first selecting any records.  The message 
below will appear informing you that all the records will be selected. 

 

 
 

 Click Yes to retrieve all rows, or click No to return to the Find tool window. 
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10.3 Qualification Find 

The VET Qualification Find window locates qualification on offer in a specific year and it operates 
in the same manner as other Integris find tools.  A range of parameters can be entered, and the 
find tool will identify all the qualifications that match the criteria.  If only one matching record is 
found, the window is closed down and the matching record returned.  If there is more than one 
matching record, the list of matching items is displayed, and you’re given the option to select one 
or all of the items in the list.  
 

 
 
The search fields for the Qualification find tool are: 
Year Contains all the school years entered in the School Diary. 

Code Enter the Qualification code or part of the code to retrieve matching records.  
This matches the text entered against the beginning of the qualification code.  
For example, entering ‘10’ will match against qualification code 1087, 1001 
and 10987, but not 91034 or A108BCD. 

Name Enter the Qualification name to search against, and the Find tool will located 
any qualification with the entered text anywhere in the name.  For example, if 
you enter the text ‘SYS’, the search will locate any qualification with the letters 
‘SYS’ anywhere in the title. 

Field of 
Education 

A drop-down list of all the defined fields of education.  Select an item in the list, 
or select the ‘--n/s--’ option to ignore this parameter. 

ANZSCO A drop-down list of all Australian and New Zealand Standard Classification of 
Occupation (ANZSCO) entries on the system.  Select an item in the list, or 
select the ‘--n/s--’ option to ignore this parameter. 

Industry A drop-down list of all Industry definitions on the system.  Select an item in the 
list, or select the ‘--n/s--’ option to ignore this parameter. 

Recognition 
Status 

A dropdown list of all Recognition Status entries on the system.  Select an item 
in the list, or select the ‘--n/s--’ option to ignore this parameter. 

Expiry Date The two expiry dates can be entered by typing directly into the fields, or by 
clicking the date selector icons alongside each field.   

VET Distinguishes whether the qualification is a VET qualification or not. 

 

 Enter the search criteria required and click the Find button to retrieve all the competencies that 
match the criteria.  The message, as shown below, will appear if no matching qualifications can 
be found. 
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If there is one matching record, the Find window will be closed, and the matching record returned.  
If there are multiple matching records, the Find tool window will switch into list view mode, shown 
below. 
 

 
 

 Highlight the required records in the list and click the Select button.  If you require all the 
records in the list, click the Select button without first selecting any records.  A message 
informing you that all the records will be selected will appear, as shown below. 

 

 
 

 Click Yes to retrieve all rows, or click No to return to the Find tool window. 
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10.4 Employer Find 

The Employer Find window operates in the same manner as the Integris Student Find tool.  You 
can enter a range of search criteria and then click the Find button to retrieve all the records that 
match the criteria.  If there is just one matching record, that record is automatically selected, the 
window closed and the user returned to the window with the matching employer details.  If there is 
more than one matching record, the list of matching records is displayed.  You can then select one 
or more of the displayed records to become the browse set. 
 

‘VET – Employer Find’ window for WA 
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‘VET – Employer Find’ window for NT 

 
 
The search fields for the Employer Find tool are: 
Name The Find tool will attempt a partial match on any text entered in this field.  For 

example, entering the text ‘info’ in this field will locate all employers with this text in 
their name, such as ‘Harmon Information Technology’ and ‘Information Industries’. 

Suburb The suburb field will locate a partial match on the text entered.  For example, 
entering ‘PE’ will find all employers with the letters ‘pe’ in the suburb (for example, 
‘Perth’, ‘East Perth’ and ‘West Perth’). 

Postcode The address postcode for the employer.  The postcode field will locate a partial 
match on the text entered.  For example, entering ‘60’ will locate all employers with 
the numerals ‘60’ in the postcode.  This would include the following postcodes: 
6005, 5160 and 3601. 

Vocation 
Job/Type 

This is a drop-down list.  Select one of the values in the list, and the Find tool will 
locate all the employers with that vocation/job type. 

First Name 
(WA only) 

Searches for the employer according to the first name of the Contact Person 

Surname 
(WA only) 

Searches for the employer according to the second name of the Contact Person 

Keywords It’s also possible to locate employers that have been assigned certain predefined 
keywords.  For example, an employer can be assigned the keyword ‘train’ to 
indicate the employer is located near a train station.  The Find tool can then be 
used to identify all employers that have this keyword assigned. 

Contact 
Person (NT 
only) 

Searches for the employer according to the Contact Person 

 
If multiple parameters are entered, for example postcode is ‘6006’ and Vocation/Job Type is 
‘Automotive’, the find tool will locate those employers that meet all the criteria - locate employers in 
Postcode 6006 who have the ‘Automotive’ Vocation/Job Type assigned. 
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Address Pane (WA only) 

 
The address pane has been added to: 

 VET > Delivery Planning > Setup External RTO 

 VET > Delivery Planning > Register School as a Training Provider 

 VET > Employers > Employer List 
 
 
The new address details are to include the existing address fields which are used as Physical 
Address and a second set of address fields will be used as Postal Address. 
Interface Design and Functionality of the Address Tab 
Interface design; The Address Pane consists of two (2) tabs: 
Physical Address 
Postal Address 
 
The existing address fields and their associated values are incorporated in the Physical Address as 
well as the Postal Address tab. 
 
The Postal Address tab has a check-box titled “Postal address differs from physical address” which 
allows the user to edit the pre-populated address fields in the Postal Address tab. 
 
Functionality: 
 

 By default, all values added to the field in the Physical Address tab are copied over to Postal 
Address tab (System should consider that the physical address is same as postal address) 

 In the Postal Address tab;  

 When the check-box is un-checked, the address fields display the same value as that in the 
Physical Address tab and the address fields in the Postal Address tab is disabled (greyed-out) 

 When the check-box is checked, the address fields are enabled and populated with the pre-
existing data to be edited. 

 Changes are confirmed by clicking the OK / Submit button in the window in which the Address 
Pane has been incorporated, the system should check whether changes have been made to 
either the Physical or Postal addresses. 
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11 VET Reports 

 

VET > Reports 

Integris VET module provides schools with a range of VET reporting options. 
 

11.1 Introducing VET Reports 

VET Reports are accessed via the Reports icon in the VET sidebar.  

NT Display 
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WA Display 

 
 

Note: WA has two additional folders in VET Reports:  School Curriculum and Standards 
Authority Reports and RTO Certification.  The latter are only available to WA schools that 
have an active RTO status.  

VET Reports in this window are sorted by functional areas. 
 

Curriculum Council 

Reporting 

View WACE (West Australian Certificate of Education) reports 
for submission to the Curriculum Council of Western Australia.  . 

Qualification 
Reporting 

View VET data by Qualification, and print the reports if desired. 

Competency 
Reporting 

View VET data by unit of Competency and print the reports if 
desired. 

Student Reporting View VET data by student and print the reports if desired. 

Employer Reporting View VET data by employer and print the reports if desired. 

Standard Letters – 
Mail Merge 

Produce export files into Microsoft Word. 

RTO Reporting 
View VET data for a given RTO and undertake AVETMISS 
reporting. 

VET Reports Export VET data for statistical analysis in other tool sets. 

Submitting Authority 
Reporting 

Print out the information on Submitting Authority Details 
previously captured within Delivery Planning. 

Industry Area 
Reporting 

List qualification offerings by industry area. 
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11.1.1 Using VET reports 

VET > Reports 

To access the individual reports in VET Reports 

 Click on the relevant folder holding a group of reports 

 Click on the name of the required report, as shown below. 
 

 
 
All reports can include a default report header and/or footer on each page.  The header can 
comprise the school name and school logo.  The footer can comprise any user-defined footer text, 
the page number and the date of production for the current report.  The school name, logo and 
default report footer can be defined by the user in General>Control>Preferences>Reports. 
Further information on Administration Preferences is available in the Integris Administration 
Manager Software Manual. 
 
Where default Main Title and Footer fields appear in the report set-up window, you can edit the title 
and/or footer. 
 
Default titles: 
 

 

Edited titles: 

 

 
The dividers on lists with columns of data can be dragged to increase/decrease the column widths. 
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 Hover the cursor over the column header divider until a ↔ icon is visible.   

 Click on the column header divider and drag to the left or right. 
 
A number of reports have drop-down lists of criteria from which to select.  
 

 Click on the arrow to the right of the field and select an option in the list. 
 

 
 
A number of reports use the Find tool in selecting settings.    

 Click on the Find tool icon and enter search criteria.  

 Click Find. 

 If more than one value matches your criteria, a list of results will be displayed.  Select one or 
more items.  Use <Ctrl> to select several items from the list. 

 Click Select. 
 

Some reports display the number of selections made for a criterion, e.g.   

 Click on the Select Date button  to select the appropriate date from the school calendar. 
The current date is shaded blue. 

 

 
 

 Use the red arrows to scroll to different months (single arrows) or years (double arrows). 

 Use the Today’s Date button  to select the current day’s date. 

 Use the Reset date button  to reset the calendar to the previously selected date.  

 Click on the date you wish to use.  

 Click OK. 
 
In the following pages, the report options and a sample report are shown for each report. 
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Note: Section 11.2 Refers to WA Only 

11.2  School Curriculum and Standards Authority Reporting (WA only) 

The WACE (West Australian Certificate of Education) reports are produced electronically and are 
for submission to the School Curriculum and Standards Authority of Western Australia.  Each 
report has a unique Export File Name. 
 

11.2.1 VET Enrolment  

VET > Reports > School Curriculum and Standards Authority > VET Enrolment 

This report creates an export file as well as a hard copy of data on students enrolled in VET 
courses. 
 

 
 

 Select the Year and Year Group(s). 

 Click Print. The following is displayed: 
 

 
 
On completion the Report Destination screen is displayed.  If Screen is selected a report similar 
to the following is displayed for the first applicable year level in the selected period: 
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Close the report. The following is displayed: 
 

 
 

 Click OK. 
 

Creating an Export for a Previous Year 

If a previous year to the current year is selected the Correct student academic year checkbox will 
be displayed to allow correction of the student academic year level: 
 

 
 
The checkbox will be checked by default. 
 
If the Year-end process has been run for the year selected and the students rolled over to their 
new academic year levels the checkbox should be left on. 
 
If the Year-end process has not been run for the year selected and the students not rolled over to 
their new academic year levels the checkbox should be taken off. 
 
The export can then be generated by following the steps above. 
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11.2.2 VET UOC Results 

VET > Reports > School Curriculum and Standards Authority > VET UOC Results 

This export includes students enrolled in the school on the current roll with a UOC enrolment 
where: 
 
The UOC start date is in the current year and the end date is blank; 
The UOC start date is in the current year and the end date is in the current year 
The UOC start date is one year prior to the current year and the end date is blank; 
The UOC start date is one year prior to the current year and the end date is in the current year. 
 
The export includes students on the Former Roll with a UOC enrolment, in each of the scenarios 
outlined above, but only where the students have been placed on the Former Roll in the Current 
Year. 
 
Only results where UOCs are integrated with subjects with course type of COS, VETCOS, or 
UOCs not integrated (that is standalone), are produced by this report. 
 

  
 

 Select the Year. 

 Select the Year Groups to report on by deselecting those not to include (by default all are 
ticked). 

 Click Print. The following message is displayed: 
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 Click No to return to the previous window or Yes to continue 
 
If any errors are found in the reports and error log will be displayed as shown below: 
 

 
 
The report can be printed by selecting the Print Log button.  Any errors will need to be rectified 
before the export file is generated. 
 

 If Yes is selected the Report Destination screen is displayed.  

 If Screen is selected a report similar to the following is displayed: 
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 Close the report. The following message is displayed: 
 

 
 

 Click OK. 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 11-11 

© 2013 Civica Pty Ltd 
 

 

Creating an Export for a Previous Year 

If a previous year to the current year is selected the Correct student academic year checkbox will 
be displayed to allow correction of the student academic year level: 
 

 
 
The checkbox will be checked by default. 
 
If the Year-end process has been run for the year selected and the students rolled over to their 
new academic year levels the checkbox should be left on. 
 
If the Year-end process has not been run for the year selected and the students not rolled over to 
their new academic year levels the checkbox should be taken off. 
 
The export can then be generated by following the steps above 
 

11.2.3 VET Qualification Achieved 

VET > Reports > School Curriculum and Standards Authority > VET – Qualification 
Achieved 

This report will extract, for each year group 8 to 12, those qualifications that have a completion 
date in the selected report parameter year. F or example, if the year 2011 was selected in the 
report parameter window, then only those qualifications with a completion date in 2011 will be 
extracted. 
 
The data for these reports is extracted from Student Details and the VET module and conforms to 
the School Curriculum and Standards Authority requirements. The export files produced is in 
accordance with School Curriculum and Standards Authority. 
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 Select the appropriate Year. 

 Click Print. While processing, a message similar to the following is displayed: 
 

 
 
The Report Destination screen is displayed: 
 

 
 

 Click OK.  
 
A report similar to the following is displayed: 
 

 
 

 Close the report. The following is displayed: 
 

 
 

 Click OK. 
 

Creating an Export for a Previous Year 
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If a previous year to the current year is selected the Correct student academic year checkbox will 
be displayed to allow correction of the student academic year level: 
 

 
 
The checkbox will be checked by default. 
 
If the Year-end process has been run for the year selected and the students rolled over to their 
new academic year levels the checkbox should be left on. 
 
If the Year-end process has not been run for the year selected and the students not rolled over to 
their new academic year levels the checkbox should be taken off. 
 
The export can then be generated by following the steps above 
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11.3 Qualification Reporting 

VET > Reports > Qualification Reporting 

These reports enable the school to view VET data by qualification and can be printed. 
 

11.3.1 School Offerings 

VET > Reports > Qualification Reporting > School Offerings 

 
 
The report has the selection criterion: Year. 
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11.3.2 Linked Competencies 

VET > Reports > Qualification Reporting > Linked Competencies 

The report offers the following selection criteria: 

 Find Qualifications– find selected qualifications on offer at the school.  

 Show all Qualifications.  
 

 
 
Linked competencies are displayed at the bottom of the window.  If there are no linked 
competencies, the report will not print. 
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11.3.3 Enrolment Numbers 

VET > Reports > Qualification Reporting > Enrolment Numbers 

The report has the following selection criteria, shown below 

 Year. 

 Qualifications on offer for which there are student enrolments.  

 All Qualifications on offer. 
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11.3.4 Student Enrolments 

VET > Reports > Qualification Reporting > Student Enrolments 

The report has the selection criterion: Find Qualifications on Offer.  
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VET > Reports > Qualification Reporting > Full Qualification Achieved 

 
The report has the following selection criteria, shown below 

 All Years Qualification Offered 

 Find Qualification  

 From and To date selector 
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11.4 Competency Reporting 

VET > Reports > Competency Reporting 

These reports enable the school to view VET data by unit of competency, and can be printed. 
 

11.4.1 School Offerings 

VET > Reports > Competency Reporting > School Offerings 

The report has the following selection criterion: Year. 
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11.4.2 School Temporary Offerings (NT only)  

VET > Reports > Competency Reporting > School Temporary Offerings 

The report has the following selection criteria 

 Year 

 Temporary Competencies to be printed.  
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11.4.3 Competency Groups 

VET > Reports > Competency Reporting>Competency Groups 

 Select the required Year 

 Check the required Competency Group/s  
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11.4.4 Student Enrolments 

VET > Reports > Competency Reporting>Student Enrolments 

The report has the following selection criteria: 

 Year. 

 Find Competency . 
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11.4.5 Student Results 

VET > Reports > Competency Reporting > Student Results 

 
 
The report has the following selection criteria: 

 Year. 

 Find Competency. 

 Result type. The options are 
o Students with no result / no end date 
o Students with no result 
o 20 Competency achieved/pass 
o 30 Competency not achieved/fail. 
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11.4.6 Temporary Enrolments (NT only) 

VET > Reports > Competency Reporting>Temporary Enrolments 
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11.5 Student Reporting 

VET > Reports > Student Reporting 

These reports enable the school to view VET data by student, and can be printed. 
 

11.5.1 Student List 

VET > Reports > Student Reporting > Student List 

The report has the following selection criterion:  
 

 Find Student. 
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11.5.2 Qualification Enrolments 

VET > Reports > Student Reporting > Qualification Enrolments 

The report has the following selection criterion:  
 

 Find Student.  
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11.5.3 Competency Enrolments 

VET > Reports > Student Reporting > Competency Enrolments 

The report has the following selection criterion:  
 

 Find Student.  
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11.5.4 Placement Summary 

VET > Reports > Student Reporting > Placement Summary 

 Select a Query (from the drop down list or using Find Student ) 

 Select or enter From and To Dates  

 Click Find  
 
The Selected Students list is then populated with all students who have one or more placements 
which are in progress during the given date range. 
 

 
 

 Click Print 
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11.5.5 Placement Details 

VET > Reports > Student Reporting > Placement Details 

 Select a Query (from the drop down list or using Find Student  ) 

 Select or enter From and To Dates  

 Click Find  
 
The Selected Students list is then populated with all students who have one or more placements 
which are in progress during the given date range. 
 

 
 
 

  



 
Integris VET Manual.docx  17-Jul-13 

Page 11-31 

© 2013 Civica Pty Ltd 
 

11.5.6 Correspondence 

VET > Reports > Student Reporting > Correspondence 

The report has the following selection criterion:  
 

 Find Student.  
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11.5.7 Correspondence by Date 

VET > Reports > Student Reporting > Correspondence by Date 

This report lists ALL student correspondence for a given date range found in VET>Student 
Details>Miscellaneous>Correspondence. RTOs will also be able to monitor the printing of 
Statements of Attainment, Records of Achievement and Certificates through this report. 
 

 
 
The From and To dates in the window default to the current date.  Any students who have 
correspondence on that date will also be listed by default. 

 Change the dates if required. 

 Click Print. 
 
 

 
 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 11-33 

© 2013 Civica Pty Ltd 
 

VET > Reports > Student Reporting > Full Qualification Achieved by Student 
 
This report will display students who have achieved a Full Qualification within a specific date 
range. 
 

 Select a Query (from the drop down list or using Find Student  ) 

 Select or enter From and To Dates  

 Click Find  
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11.6 Employer Reporting 

VET > Reports > Employer Reporting 

These reports enable the school to view VET data by employer, and can be printed. 
 

11.6.1 Employer List 

VET > Reports > Employer Reporting > Employer List 

 Click Find Employer.  

 Enter required search criteria  

 Click Find and select employer(s). 

 Click Print. 
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11.6.2 Vocation/Job Type Details 

VET > Reports > Employer Reporting > Vocation/Job Type Details 

Instructions for this report are printed at the bottom of the window. 
 

 Click Find Employer.  

 Enter required search criteria 

 Click Find and select employer(s). 

 Click Print. 
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11.6.3 Placement Summary 

VET > Reports > Employer Reporting > Placement Summary 

 Select a Query (from the drop down list or using Find Employer) 

 Select or enter From and To Dates  

 Click Find  
 
The Selected Employers list is then populated with all employers who have one or more 
placements which are in progress during the given date range. 
 

 
 

 Click Print 
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11.6.4 Placement Details 

VET > Reports > Employer Reporting > Placement Details 

 Select a Query (from the drop down list or using Find Employer) 

 Select or enter From and To Dates  

 Click Find  
 
The Selected Employers list is then populated with all employers who have one or more 
placements which are in progress during the given date range. 
 

 
 

 Click Print 
 



 
Integris VET Manual.docx  17-Jul-13 

Page 11-38 

© 2013 Civica Pty Ltd 
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11.6.5 Employer Correspondence 

VET > Reports > Employer Reporting > Correspondence 

The report has the following selection criterion:  

 Click Find Employer.  

 Enter required search criteria 

 Click Find and select employer(s). 

 Click Print. 
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11.6.6 Scheduled Placements 

VET > Report > Employer Reporting > Scheduled Placements 

 Click Find Employer.  

 Enter required search criteria 

 Click Find and select employer(s). 

 Select a Report Type.   

 If Active Placements is selected, select a date.  (An active placement is one where the date 
selected falls on or between the begin date and the end date of the placement.  The Future 
only option will select those placements where the placement start date is after today’s date. 

 Click Print. 
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11.7 Standard Letters – Mail Merge 

VET > Reports > Standard Letters – Mail Merge 

Note: This folder consists of two reports in Western Australia and four in the Northern 
Territory.  

These reports enable the school to produce export files for MS Word. 
 

WA Display 

 
 

NT Display 
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11.7.1 Students and Placements 

VET > Reports > Standard Letters – Mail Merge > Students and Placements 

Note: This functionality can only be used if placement for selected students has been 
completed. 

 
 

 Use the Find Student tool to select student(s) whose data you will use in mail merging.  Their 
names and the number selected will be displayed in the Students tab pane at the bottom of the 
window. 

 Click the Students tab to view the list of students, as shown below. 
 

 
 

 Click the spyglass on the right of the Merge Data File Folder field.  

 Locate and select a folder in which to save the file of student data to be used in mail merging, 
shown below.   
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 Click Select.  The folder path is displayed in the Merge Data File Folder field. 

 In the Correspondence Type field, select a correspondence type or leave it ‘unspecified’.  If a 
type is specified, default mail merge fields will be selected.  You will be able to add/remove 
fields in the default list and save the selection for the correspondence type.  The next time you 
create a mail merge file with the same correspondence type, the fields will be selected by 
default.  

 A default merge file name is displayed.  Edit the file name if required. 

 Tick Record Correspondence if you wish to record today’s date and the Correspondence 
Note in each of the selected students’ correspondence logs.  To make a different 
correspondence note in students’ records, edit the text.  Up to 100 characters can be entered. 

 Enter the dates between which the placements occurred.  The report will select all the 
placement records that fall on or between the dates entered.   

 In the Fields tab pane at the bottom of the window, tick the checkboxes against all fields to be 
included in the mail merge file 

 Click Print, and you will see a message similar to that below.  
 

 
 

 Click OK.  The file is created in CSV (comma separated values) format and saved in the Merge 
Data File Folder.  The first record in the file will be a description of each field extracted.  This 
file can form the data source for a Word mail merge document. 
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11.7.2 Employers and Placements 

VET > Reports > Standard Letters – Mail Merge > Employers and Placements 

 

 

 Use the Find Employer tool  to select employer(s) whose data you will use in mail merging.  
Their names and the number selected will be displayed in the Employers tab pane at the 
bottom of the window. 

 Click the Employers tab to view the list of employers, as shown below. 
 

 
 

 Click the spyglass on the right of the Merge Data File Folder field.  

 Locate and select a folder in which to save the file of employer data to be used in mail merging, 
like below. 

 

 
 

 Click Select.  The folder path is displayed in the Merge Data File Folder field. 
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 In the Correspondence Type field, select a correspondence type or leave it ‘unspecified’.  If a 
type is specified, default mail merge fields will be selected.  You will be able to add/remove 
fields in the default list and save the selection for the correspondence type.  The next time you 
create a mail merge file with the same correspondence type, the fields will be selected by 
default. 

  A default merge file name is displayed.   

 Edit the file name if required. 

 Tick Record Correspondence if you wish to record today’s date and the correspondence note 
in each of the selected employers’ Correspondence Log.  To make a different correspondence 
note in employers’ records, edit the text.  Up to 100 characters can be entered. 

 Enter the date range for the data to be selected for mail merging.  The report will select all 
placement records where the placement dates fall on or between the dates entered. 

 In the Fields tab pane at the bottom of the window, tick the checkboxes against all fields to be 
included in the mail merge file.  

 If you have selected a correspondence type and you wish to save the selected fields for that 
type, click the Save Fields checkbox.  If you have not selected a correspondence type, the 
Save Fields checkbox will not be active. 

 Click Print, and you will see a message similar to that below.  
 

 
 

 Click OK.  The file is created in CSV (comma separated values) format and saved in the folder 
selected in the Merge Data File Folder. The first record in the file will be a description of each 
field extracted.  This file can form the data source for a Word mail merge document. 
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11.7.3 Completed Certificates (NT only) 

VET > Reports > Standard Letters – Mail Merge > Completed Certificates  

 
 
A default merge file name is displayed, which you can edit if desired.  

 Click the spyglass on the right of the Merge Data File Folder field.  

 Locate and select a folder in which to save the file of certificate data to be used in mail 
merging, like below. 

 

 
 

 Click Select.  The folder path is displayed in the Merge Data File Folder field. 

 Enter the date range for the data to be selected for mail merging.  The report will select all the 
qualifications between the dates entered. 

 Tick Add to the Correspondence Log if you wish to record today’s date and the 
correspondence note in each of the selected students’ correspondence logs. 

 Click Preview Print List  to list the qualification records to be extracted.  These may be 
viewed on the Certificates tab. 
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 In the Fields tab pane at the bottom of the window, tick the checkboxes against all fields to be 
included in the mail merge file. 

 If you have selected a correspondence type and you wish to save the selected fields for that 
type, click the Save Fields checkbox.  If you have not selected a correspondence type, the 
Save Fields checkbox will not be active. 

 Click Print, and you will see a message similar to that shown below.  
 

 
 

 Click OK.  The file is created in CSV (comma separated values) format and saved in the folder 
selected in the Merge Data File Folder. The first record in the file will be a description of each 
field extracted.  This file can form the data source for a Word mail merge document. 
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11.7.4 Statement of Attainment (NT only) 

VET > Reports > Standard Letters – Mail Merge > Statement of Attainment  

 
 

 Use the Find Student tool  to select student(s) whose data you will use in mail merging.  
Their names and the number selected will be displayed in the Students tab pane at the bottom 
of the window. 

 Click the Students tab to view the list of students. 
 

 
 
A default merge file name is displayed, which can be edited if desired.  

 Click the spyglass on the right of the Merge Data File Folder field.  

 Locate and select a folder in which to save the file of certificate data to be used in mail 
merging, like below. 
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 Click Select.  The folder path is displayed in the Merge Data File Folder field. 

 Select All Competency Enrolments or Only Completed Competencies, shown below. 
 

 
 

 Tick Add to the Correspondence Log if you wish to record today’s date and the 
Correspondence Note in each of the selected students’ correspondence logs.  

 In the Fields tab pane at the bottom of the window, tick the checkboxes against all fields to be 
included in the mail merge file.  

 If you have selected a correspondence type and you wish to save the selected fields for that 
type, click the Save Fields checkbox.  If you have not selected a correspondence type, the 
Save Fields checkbox will not be active. 

 Click Print, and you will see a message similar to that below. 
 

 
 

 Click OK.  The file is created in CSV (comma separated values) format and saved in the folder 
selected in the Merge Data File Folder. The first record in the file will be a description of each 
field extracted.  This file can form the data source for a Word mail merge document. 
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11.7.5 Completed Qualifications CSV Export (NT only) 

 
 
This report exports information, in CSV format, on student(s) who have completed qualification(s) 
provided that the qualifications: 

 were attached to school that has been registered as an RTO in the VET – Register School as 
a Training Organisation; 

 were completed within the specified date range; 

 have at least one linked competency that is marked either ROA or SOA and has a result of 20, 
51, 52, 53, 54 or 60. 

 

 Click  and navigate to the Merge Data File Folder 

 Select the desired date range 

 Check Add to Correspondence Log if required 

 Check the fields to be included in the export file 

 Check Save Fields so that the selected fields are retained 

 Click Print and select the required Report Destination 
 

 
 

 Click OK 
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The resulting CSV file will be formatted as follows: 
 

“1”,“Certificate Name”,”Certificate Code”,”Certificate ID”,”Legal 

Surname”,”Surname”,”First Name”,”Preferred Name”,”UPN”,”Competency 

Code1”, “Competency Name1”,”Competency Code2”,”Competency 

Name2”,”Competency Code3”,”Competency Name3”,…,”Competency 

CodeN”,”Competency NameN” 

“2”,“Certificate Name”,”Certificate Code”,”Certificate ID”,”Legal 

Surname”,”Surname”,”First Name”,”Preferred Name”,”UPN”,”Competency 

Code1”, “Competency Name1”,”Competency Code2”,”Competency 

Name2”,”Competency Code3”, ”Competency Name3”,…,”Competency 

CodeN”,”Competency NameN” 

 
If the conditions described above are not met, then an error log will be displayed.  This may be 
printed if required. 
 

11.7.6 Statement of Attainment CSV Export (NT only) 

 
 
This report exports information, in CSV format, on student(s) enrolled in qualification(s) without 
completion dates, provided that the qualifications  

 were attached to school that has been registered as an RTO in the VET – Register School as 
a Training Organisation; 

 have at least one linked competency that is marked either ROA or SOA and has a result of 20, 
51, 52 or 53. 

 

 Find  the students whose records are to be exported 
 

 Click  and navigate to the Merge Data File Folder 

 Select the desired date range 
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 Check Add to Correspondence Log if required 

 Check the fields to be included in the export file 

 Check Save Fields so that the selected fields are retained 

 Click Print and select the required Report Destination 
 

 
 

 Click OK 
 
The resulting CSV file will be formatted as follows: 
 

“Certificate Name”,”Certificate Code”,”Certificate ID”,”Legal 

Surname”,”Surname”,”First Name”,Preferred Name”,”UPN”,”Competency Code1”, 

“Competency Name1”,”Competency Code2”,”Competency Name2”,”Competency 

Code3”,”Competency Name3”,…,”Competency CodeN”,”Competency NameN” 

 
If the conditions described above are not met, then an error log will be displayed.  This may be 
printed if required. 
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11.8 RTO Reporting 

VET > Reports > RTO Reporting 

These reports are designed to provide the school with the functionality to view VET data for a given 
RTO. AVETMISS reporting is undertaken here. 
 

11.8.1 AVETMISS Reports 

VET > Reports > RTO Reporting > AVETMISS Reports 

The reports create a file of AVETMISS data for selected options. 
 

 
 
The Australian Vocational Education and Training Management Information Statistical Standard 
(AVETMISS) offers a nationally consistent standard for the collection and analysis of Vocational 
Education and Training (VET) information throughout Australia. 
 
The AVETMIS Standard for VET providers includes the eleven files displayed above. 
 

To run the AVETMISS reports 

 Select a Year. 

 If you wish to change the location of the export file, click the spyglass on the right of 
the Export File Location field. 

 Locate and select a folder in which to save the file(s) of data, like below. 
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 Click Select.  The folder path is displayed.   
 

 
 
There is an optional field to Include State Data. If the location is the Northern Territory this 
option is ticked automatically. 
 

 
 
There is a checkbox to include details of enrolments at external RTO’s. This checkbox defaults to 
unchecked when the window opens. 
 

 
 

 Select a Report Type to run reports separately, like the example below, or choose All to run all 
reports.  

 

 
 
The name of the export file is displayed in the Export File Name field.  
 

 

Note: These reports have been designed to export to text files.  

If selected individually the information is also displayed in a standard Integris report preview 
window from which a hardcopy can be obtained. 
 

 Click Print. The data will be saved in file(s) named after the report(s) for example, 
NAT00010.txt, NAT00020.txt in the specified export file location, as below. 
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If an export file already exists in the specified location the following message will display: 
 

 
 

 Click Cancel to exit the report screen. 
  



 
Integris VET Manual.docx  17-Jul-13 

Page 11-56 

© 2013 Civica Pty Ltd 
 

11.8.2 RTO Details 

VET > Reports > RTO Reporting > RTO Details 

 
 

 Select the RTO(s) for which details are to be printed. 

 Print to desired report destination. 
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11.8.3 Student Enrolments 

VET > Reports > RTO Reporting > Student Enrolments 

 
 

 Select the Year and the RTO for which student enrolments will be printed by competency. 

 Click Print. 

 Print to desired report destination. 
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11.9 RTO Certification (WA only) 

VET > Reports > RTO Certification 

These reports are designed to provide the school with the functionality to print certificates. The 
reports in this folder are only available for schools that have an active RTO status.  

Note: the RTO Certification folder is available for WA only. 

If the school is not an active RTO and a user selects any of the reports in this folder the following 
message will appear: 
 

 
 

Note: for all the WA RTO Certification reports the end date defaults to the current system 
date and the user is prevented from running the reports with a future end date. 

If a future end date is selected the following message is displayed. 
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11.9.1 Record of Achievement 

VET > Reports > RTO Certification > Record of Achievement 

This report enables RTOs to print an official record of achievement for students who have 
completed qualifications in the date range selected, as well as an associated certificate ID. 
 
This is an official document printed on pre-printed stationery. 
 

 
 

 Select the From and To dates, which will be used to filter for the completion dates of the 
qualification. Users are able to select dates which span more than one school year. 

 Click on Preview Qualifications.   
 
The certificate list is populated with qualifications where the following rules are met:  Only the 
qualifications where the Qualification RTO is the School (registered as the RTO) AND the 
Completion Date is between the selected from and to date. AND the Completion Date is after 1 
JAN 2006 AND the Certificate ID is populated (that is, the Certificate has been printed) will be 
listed. 
 
Only competencies which have a result of 20, 51 or 60 will be listed on the report.  
 
The Principal and Date fields cannot be edited. 
 

 Click Print. 

 Print to desired report destination. The report destination has fewer options than when printing 
other reports.  
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The Record of Achievement is printed: 
 

 
 
An entry indicating the date and description of report will automatically be added to the VET 
Correspondence log in VET>Student Details>Miscellaneous>Correspondence for each student 
each time this report is printed. 
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11.9.2 Qualification Certificate 

VET > Reports > RTO Certification > Qualification Certificate 

This report enables RTOs to print official certificates, records of achievement and an audit log of 
certificates printed.  Certificates can only be printed for students who have completed qualifications 
in the date range selected as well as an associated certificate ID. 
 
This is an official document printed on pre-printed stationery.  
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 Click on Preview Qualifications.   
 
The list will be populated according to the following rules: only the qualifications where the 
Qualification RTO is the School (registered as the RTO) AND the Completion Date is between the 
selected from and to date. AND the Completion Date is after 1 JAN 2013 AND the Qualification 
Achieved checkbox is ticked will be listed. 
 
The Principal and Date fields cannot be edited. 
 
The Record of Achievement and Certificate Audit checkboxes are ticked by default as the 
window opens.  You have the option to deselect one or both. 
 

 Click Print. 

 Print to desired report destination. The report destination has fewer options than when printing 
other reports.  

 
The following message is displayed: 
 

 
 

 Click Yes to print the Qualification Certificate. 
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If the Record of Achievement checkbox is ticked then the following message appears: 
 

 
 

 Click Yes to print and continue and No to skip printing and continue. 
 
If the Certificate Audit log checkbox is ticked then the following message appears: 
 

 
 
Click Yes to print and No to finish the process. 
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Note:  Once a Certificate has been generated, the Certificate Identifier, Certificate Issued 
and Date issued fields are populated and these, and the Qualification code and the RTO, are 
greyed out for all users except for EDWA login. 
 

 
 

 
An entry indicating the date and description of report will automatically be added to the VET 
Correspondence log in VET>Student Details>Miscellaneous>Correspondence, for each 
student each time the Qualification Certificate is printed. 
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11.9.3 Statement of Attainment 

VET > Reports > RTO Certification > Statement of Attainment 

In the case where a student achieves fewer units of competency or modules required for a 
qualification, an RTO can issue a Statement of Attainment listing all the units of competency 
achieved for partial completion of a qualification.  Only competencies which have a result of 20, 50 
or 60 will be listed on the report.  
 
This is an official document printed on pre-printed stationery.    
 

 Click on Find Student  to select the required VET students 

 Enter the appropriate date range if required 

 Click Preview  
 
The student list is then populated with the selected student qualifications according to the following 
rules:   

 Only the qualifications where the Qualification RTO is the School (registered as the RTO)  

 Where enrolment is not eligible for a certificate (that is, the Qualification Achieved box is not 
populated)  

 The competencies were achieved during the specified date range, if specified  
 

 
 
The Principal and Date fields cannot be edited 
 

 Print to desired report destination.  
 
The report destination has fewer options than when printing other reports.  
 
Only competencies which have a result of 20, 51 or 60 will be listed on the report.  
 



 
Integris VET Manual.docx  17-Jul-13 

Page 11-67 

© 2013 Civica Pty Ltd 
 

 
 
An entry indicating the date and description of report will automatically be added to the VET 
Correspondence log in VET>Student Details>Miscellaneous>Correspondence for each student 
each time the Statement of Attainment is printed. 
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11.9.4 RTO Qualifications CSV Export Statement of Attainment CSV Export 

VET > Reports > RTO Certification > Statement of Attainment 

The RTO Qualification CSV Export produces student record(s) whose competencies have been 
resulted to 20, 51, 52, 53, 54 or 60; have an RTO Arrangement of School as a Registered RTO 
and when qualifications are completed for the selected academic year. 
 

 
 
When current academic year is selected, the qualification(s) completed in the current year are 
reported upon. 
 
If selecting the previous calendar year, an option will be displayed to Correct the student 
academic year with the default value checked 
 

 
 
When a previous year is selected and the Correct the student academic year checkbox is ticked, 
then Academic Year = Current recorded academic year – (Leaving calendar Year – Selected 
Year).  (Leaving calendar year can be found in General > Student Details > Additional 
Information.)  When there is no date in Leave Date then the year to be reported on is current 
calendar year less selected academic year.  When the student has the Repeating Current Year 
flag set for the current academic year and the student has been selected to be reported on for the 
previous year’s data then the calculation of the academic year for previous years should increase 
the resultant year by one. (Repeating Current Year is located in General > Student Details > 
Miscellaneous.)  As the Repeating Current Year data is not stored historically, a warning 
message will be displayed if a year greater than the previous year has been selected. 
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When the Qualification record is marked as Qualification Achieved and the Qualification 
Completion Date matches the current selected calendar year. The export will include students 
enrolled in the school on the current roll and students on the former roll when these students have 
been placed on the former roll in the current year. 
 
After a successful export, the following is displayed. 
 

 
 
The export file is saved in CSV format with the following sort order: 
 

 Alphanumerically by Year Group 

 Alphabetically by Student Surname 

 Alphabetically by Student First Name 

 Alphanumerically by Qualification Code 
 

Sample RTO Qualification CSV Export 
"Year Group","Legal Surname","Legal First Name","Qualification Code","Qualification Name","Qualification 
Completion Date","UoC Code 1","UoC Name 1","UoC Code 2","UoC Name 2","UoC Code 3","UoC Name 
3","UoC Code 4","UoC Name 4","UoC Code 5","UoC Name 5","UoC Code 6","UoC Name 6","UoC Code 
7","UoC Name 7","UoC Code 8","UoC Name 8" 
"Year 11","Angus","Sally","30625QLD","Certificate I in Work Readiness","27/11/2008","27838","Receive and 
convey messages","27840","Locate and select relevant information","","","","","","","","","","","","" 
"Year 11","Angus","Sally","51731","Certificate I in Leadership 
Development","29/11/2008","BSBCMN102A","Complete daily work activities","BSBCMN103A","Apply basic 
communication skills","BSBCMN106A","Follow workplace safety procedures","BSBCMN107A","Operate a 
personal computer","HLTFA1A","Apply basic First Aid","ICAITU133A","Send and retrieve information over 
the internet using browsers and email","LDWA103","Effective team membership","","" 
"Year 11","Cooper","Hayden","51731","Certificate I in Leadership 
Development","28/11/2008","BSBCMN102A","Complete daily work activities","BSBCMN103A","Apply basic 
communication skills","BSBCMN106A","Follow workplace safety procedures","BSBCMN107A","Operate a 
personal computer","HLTFA1A","Apply basic First Aid","ICAITU133A","Send and retrieve information over 
the internet using browsers and email","LDWA103","Effective team membership","BSBCMN101A","Prepare 
for work" 
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11.9.5 Statement of Attainment CSV Export (WA only) 

The Statement of Attainment CSV Export reports on VET students on any roll with UoCs 
resulted to 20, 51, 53 or 60 and where RTO Arrangement is School Registered as Training 
Organisation. 
 

 
 
Field description for Statement of Attainment CSV Export as follows: 
 

Field Description 

Year Competencies resulted to 20, 51, 53 or 60 for the selected year 

Export File Location Location where the file will be saved after creation 

 
When current academic year is selected, the qualification(s) completed in the current year are 
reported upon. 
 
If selecting the previous calendar year, an option will be displayed to Correct the student 
academic year with the default value checked 
 

 
 
When a previous year is selected and the Correct the student academic year checkbox is ticked, 
then Academic Year = Current recorded academic year – (Leaving calendar Year – Selected 
Year).  (Leaving calendar year can be found in General > Student Details > Additional 
Information.)  When there is no date in Leave Date then the year to be reported on is current 
calendar year less selected academic year.  When the student has the Repeating Current Year 
flag set for the current academic year and the student has been selected to be reported on for the 
previous year’s data then the calculation of the academic year for previous years should increase 
the resultant year by one. (Repeating Current Year is located in General > Student Details > 
Miscellaneous.)  As the Repeating Current Year data is not stored historically, a warning 
message will be displayed if a year greater than the previous year has been selected. 
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When the Qualification record is marked as Qualification Achieved and the Qualification 
Completion Date matches the current selected calendar year. The export will include students 
enrolled in the school on the current roll and students on the former roll when these students have 
been placed on the former roll in the current year. 
 
After a successful export, the following is displayed. 
 

 
 
The export file is saved in CSV format with the following sort order: 

 Alphanumerically by Year Group 

 Alphabetically by Student Surname 

 Alphabetically by Student First Name 

 Alphanumerically by Qualification Code 

 The UoC codes are listed alphanumerically 
 
There is one record per student per qualification. 
 

Sample Statement of Attainment CSV Export 
"Year Group","Legal Surname","Legal First Name","Qualification Code","Qualification Name","UoC Code 
1","UoC Name 1","UoC Start Date 1","UoC End Date 1","UoC Code 2","UoC Name 2","UoC Start Date 
2","UoC End Date 2","UoC Code 3","UoC Name 3","UoC Start Date 3","UoC End Date 3" 
"Year 11","Abdi","Abdalla","51409","Certificate III in Carpentry and Joinery","BCF2001A","Use static 
machines","01/02/2010","16/12/2010","BCF3002A","Use computer controlled 
machinery","01/02/2010","16/12/2010","BCF3003A","Identify stair construction and the factors governing 
stair design","01/02/2010","16/12/2010" 
"Year 11","Abdi","Abdalla","52013","Certificate III in Civil and Structural Engineering","41991","Produce 
Simple Engineering Drawings","01/02/2010","16/12/2010","41992","Use a Personal Computer in 
Engineering","01/02/2010","16/12/2010","","","","" 
"Year 11","Abdi","Abdalla","BSB20107","Certificate II in Business","BSBCMN201A","Work effectively in a 
business environment","06/03/2009","27/11/2010","BSBCMN202A","Organise and complete daily work 
activities","06/03/2009","27/11/2010", "BSBCMN203A","Communicate in the 
workplace","06/03/2009","27/11/2010" 
"Year 11","Angus","Sally"," BSB20107","Certificate II in Business","BSBCMN201A","Work effectively in a 
business environment","06/03/2009","27/11/2010","BSBCMN202A","Organise and complete daily work 
activities","06/03/2009","27/11/2010", "BSBCMN203A","Communicate in the 
workplace","06/03/2009","27/11/2010" 
"Year 12","Freemantle","Alexander","BSB20107","Certificate II in Business","BSBCMN201A","Work 
effectively in a business environment","06/03/2009","27/11/2010","BSBCMN202A","Organise and complete 
daily work activities","06/03/2009","27/11/2010", "BSBCMN203A","Communicate in the 
workplace","06/03/2009","27/11/2010" 
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11.10 VET Exports 

VET > Reports > VET Exports 

These reports provide the school with the functionality to export VET data for statistical analysis in 
other tool sets. 
 

11.10.1 WA VET Export 

VET > Reports > VET Exports > WA VET Export 

 
 
The only parameters to be entered are Year and Export File Location. The Year parameter 
represents the collection period for the report and the Export File Location specifies the directory 
location of the exported file. 
 

 Select a Year. 

 Click the spyglass on the right of the Export File Location field.  

 Locate and select a folder in which to save the file of data.  
 

 
 

 Click Select.  The folder path is displayed, as shown below. 
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The export file name is displayed.  The file name is made up of the school code, the text 
VETEXPORT, the year, and a ‘.txt’ extension.  
 

 
 

 Read the explanation in the lower half of the window. 

 Click Print. 
 
You will get a message like the one below.  
 

 Click OK. The file has been saved to the selected location. 
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11.11 Submitting Authority Reporting 

VET > Reports > Submitting Authority Reporting 

These reports provide the RTO with the data about the authority submitting information to the 
AVETMISS Collection Managing Agency. 
 

11.11.1 Submitting Authority Details 

VET > Reports > Submitting Authority Reporting > Submitting Authority Details 

This report records Submitting Authority details as previously defined in VET > Delivery Planning 
> Submitting Authority.  The only parameters available to this report are a header and footer, as 
shown below. 
 

 
 

 Click Print and select the desired report destination, to print the report. 
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11.12 Industry Area Reporting 

VET > Reports > Industry Area Reporting 

This reports list, by industry areas, the qualifications on offer in the school during any given year.  
 

11.12.1 Qualification Offerings by Industry Area 

VET > Reports > Industry Area Reporting > Qualification Offerings 

 
 

 Edit the Main Title and Page Footer, if desired. 

 Select the appropriate Year. 

 Tick the Page Break on Industry Area box, if desired. 
 
All Industry areas are automatically selected.  If only some industry areas are required in the 
report: 
 

 Uncheck the industry areas that are not to be included. 

 Click and drag the Sort options required into the Sort Field pane. 

 Click Print and print to the required report destination. 
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12 Setting up User Access to the VET Module 

 

General > Control >Users 

Systems Administrators in schools need to set up and maintain details of the staff who are going to 
use VET.  See the Integris Administration Manager manual for information on maintaining user 
access in Integris. 
 
Access to VET is set up in General > Control > Users, as shown below. 
 

 
 
If a user tries to access any item which they do not have access to, the following message will be 
displayed: 
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12.1 Extra VET Reports Access Control - WA Only  

There is access control available for the RTO Certification folder option.  
 

 
 
If the school is an active RTO then a user can be allocated access to RTO Certification folder.  
 
If the school ceases to be an active RTO then the following message will override the user access 
when trying to access reports in the RTO Certification folder in VET > Reports > RTO 
Certification. 
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14 Support  

14.1 WA 

Should you require support please contact the Customer Service Centre (CSC) at the Department 
of Education and Training. 
 
Contact details below: 
 
Phone (CSC) 
Metro: 9264 5555 
Country: 1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 
Fax (CSC) 
9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 
Email (CSC) 
customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 
 
 

14.2 NT 

Should you require support please contact the following: 
 

DEET SAMS Support  
 
Email  sams.deet@nt.gov.au 
Or Call DEET Hotline 8999 3531 
Or Fax SAMS/DEET 89995611 
Or Web Site  http://www.latis.net.au/sams/ 
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